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What’s New in 2008
This version of TurningPoint includes a healthy number 
of improvements and additions that you may enjoy. The 
new features provide simplified device set up, more 
control over how results should be displayed, interesting 
new ways to engage your audience, and a more 
customizable experience.

Internationalization TurningPoint now supports users who speak non-English 
languages including Canadian French, Portuguese, 
Spanish, Dutch, Japanese, Korean and Czech.

Enhanced Response Device
Detection

TurningPoint’s Enhanced Response Device Detection... 

• Provides Plug and Play capabilities for Response 
Innovation’s USB Receivers

• Eliminates the Device Location and need to run 
Response Device Wizard

• Allows you predetermine and set Channels 

vPad 2008 vPad 2008 supports self-paced testing

Web vPad Integration Web vPad eliminates the need to utilize an internal 
network when users have access the internet

User Friendly Settings and
options allow for a more

Personal Experience

With the new settings interface, you can:

• Use the Settings Hierarchy to choose from Response 
Device, Presentation-level, Slide-level or Answer-
level settings

• Use drop-down menus to change many of the 
settings.

• Choose from Common Settings or All Settings

• See a more detailed description of each setting

• Determine receiver channels
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With more customizable settings and options, you can:

• Use an mp3 as Countdown Sound

• Customize where you save your sessions

• Assign negative point values to questions

• Move the Showbar anywhere on the screen

• Set an answer as Correct/Incorrect

• Set a point value for an answer

• Clear the point value for an answer

TestingPoint 2008 Support TestingPoint is a Microsoft Word add-in that allows you 
to:

• Create self-paced paper tests

• Collect responses via the Test Administer

• Run reports in Microsoft Excel

• Upload TestingPoint sessions into VantagePoint to 
view performance of each child, class, building, or 
district level compared to State Standards

• Import your self-paced tests into TurningPoint to 
create interactive presentation.

Built-in Testing Standards With Built-in Testing Standards, you can choose 
standards by: 

• State

• Subject 

• Grade

Smarter Conditional
Branching

Creating a Conditional Branch has been simplified. 
TurningPoint 2008 guides you along the way. 

New Participant List Features With the upgrades to the Participant List, you can:

• Device ID field is automatically added when you 
create a new list

• Merge your sessions based on your Participant Lists 
and show the aggregated results
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• Add/Remove Groups or Fields from the Participant 
Information Screen 

• Allow users not in your Participant List to participate in 
a presentation

Enhanced Reporting provides
more reports and makes

generating reports easier

With five new reports available, you can:

• See the Ratio of correct to incorrect response by 
Participant using the Graded Participant Results 
(ratio)

• See the scoring distribution for the presentation and 
how each participant scored using the Comparative 
Scoring Reports

• See the how teams scored by percentage and points 
using the Team Scoring Reports

• See how participants responses compared to other 
participants using the Percentile Reports

• See the percentage of correct answers and total 
points accumulated by each participant

With the new reports interface, you can:

• Create reports more easily

• Change numeric response to alphabetic responses

The following chapters in this guide demonstrate how to 
implement these new features to make the most of your 
presentation.
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Chapter  : What’s New in 2008
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About 
TurningPoint

Welcome to TurningPoint, the easiest, most powerful, fully interactive group response system 
available. Designed to be used with PowerPoint, TurningPoint enables two-way communication 
between a speaker and a large group by allowing audience feedback. TurningPoint offers the ability to 
collect, evaluate, and record responses from everyone in the audience, transforming a lecture, 
workshop, or meeting into a more effective learning environment for everyone in the room. By 
engaging each participant, TurningPoint creates a unique session every time, recording response 
data that can be used immediately or later for grading, polling, attendance tracking, and demographic 
research.

Whether you want to gauge an audience’s opinion or quickly assess your students’ understanding on 
important points in a lecture, TurningPoint enables you to ask and receive a response at the very 
moment you want to ask most. The audience uses response devices to submit answers to questions 
you have created. Then, TurningPoint gathers responses from each participant and quickly translates 
them into measurable results in the form of test scores, charts, and graphs. 

After a presentation, TurningPoint helps you store the data for later access or for use in reporting or 
grading.

This chapter provides an overview of the product and its capabilities and includes the system 
requirements, the steps for installing TurningPoint on your computer, and some resources available to 
you for customer support.
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Chapter 1: About TurningPoint

Product Introduction

TurningPoint smoothly integrates with PowerPoint to create a more interactive and memorable 
presentation. TurningPoint was designed to run on Office 2003 and Office 2007 with Microsoft XP 
support.  (Find additional information in System Requirements on page 3.) All TurningPoint options 
are accessed through the TurningPoint toolbar.

The TurningPoint toolbar can be found in PowerPoint beneath the standard PowerPoint toolbar 
after TurningPoint is installed. This toolbar offers you all the options you need to create interactive 
slides, set up and run a presentation, and generate reports. Easy-to-use features such as the 
Participant List Wizard help you quickly get started. 

Other TurningPoint features include participant monitoring and reporting tools. TurningPoint also 
provides the ability to connect to an educational institution’s WebCT or Blackboard server or to use 
Turning Technologies’ Enterprise Manager and TestingPoint to streamline the creating of Participant 
Lists and reporting of classroom results and grades.

Additionally, TurningPoint is now available in a range of non-English languages. Customers may 
choose a language when they install TurningPoint.
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System Requirements

System Requirements

TurningPoint is designed for use on computers with typical abilities. You do not need the very latest 
technology or a large amount of hard disk space to use TurningPoint. There are, however, a few 
requirements that you should check for before installation. The requirements for hardware and 
software are detailed in the following sections.

Requirements for Hardware

The following hardware specifications are required before installing TurningPoint:

• Intel or AMD 600 Mhz class processor (1 GHz or higher recommended)

• 256 MB RAM (256MB or more of “available” RAM recommended)

• 60 MB hard disk space (an additional 32 MB is required if you do not have Microsoft .NET 
Framework 2.0 installed).

• 800x600 resolution at 24-bit color (1024x768 resolution at 32-bit color or higher recommended)

• Standard USB 1.1/2.0 port 

• Ethernet or 802.11 compatible wireless network card (for vPad and vPad Presenter use)

Requirements for Software

The following software applications are required to take full advantage of TurningPoint capabilities:

• Microsoft Windows XP or higher

• Microsoft Office XP, 2003, or 2007
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Initial Setup

There are two easy steps that need to be completed before you begin using TurningPoint. This 
section will guide you through those steps.

This section describes how to:

• Install TurningPoint 

• Open TurningPoint with PowerPoint 
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Install TurningPoint

Install TurningPoint

In a few simple steps, TurningPoint can be installed on your computer. The installation process takes 
just a few minutes, and then you will be ready to create a TurningPoint presentation.

Before You Begin

Check the hardware and software specifications outlined in System Requirements on page 3. A 
computer must meet these systems requirements before installation.

Step by Step Instructions To install TurningPoint software on a computer…

1 Install TurningPoint in one of 
two ways:

• Download the latest 
edition of TurningPoint 
from the Turning 
Technologies web site. 

The Turning Technologies web site is located at 
http://www.turningtechnologies.com. Use your web 
browser to download the file to your computer. When the 
download is complete, double-click the setup icon to 
launch the InstallShield Wizard.

• To install from a CD, insert 
the CD on the computer.

After you insert the CD, the InstallShield Wizard launches 
automatically.
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2 If an older version of 
TurningPoint is installed, the 
InstallShield Wizard window 
displays a message 
requesting to uninstall the 
previous version. 

If this is the first time you are installing TurningPoint or have 
already uninstalled a previous version, continue with step 3.

a.Select OK. 

3 Select the Next button to 
continue the installation with 
the InstallShield Wizard.

The next page displays the license agreement. Use the 
scrollbar to read the license agreement on the screen or 
select the Print button to send the text to a printer. 

License Agreement

4 Select the button labeled “I 
accept the terms in the 
license agreement” if you 
accept these terms. 

Accepting the terms of the license agreement permits you to 
continue with the process of installing TurningPoint. 
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5 Select the Next button. The next page displays customer information entry fields. 

Customer Information

6 Type your name and 
company in the fields.

7 Select the Next button. The next page allows you to select a language.

Language Selection
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8 Select a language to install. You may choose English, Czech, Dutch, French, Japanese, 
Korean, Portuguese, or Spanish.

9 Select the Next button. The next page confirms that the computer is ready to install 
TurningPoint.

Install the Program



TurningPoint User Guide 9

Install TurningPoint

10 Select the Install button. The computer installs TurningPoint to the location you specified 
and displays the Finish button on the page when it completes 
the process. 

Installation Wizard Completed

11 Select the Finish button. The final page displays a message that the installation is 
complete. Select the Launch TurningPoint checkbox if you 
would like to immediately open the program.

The TurningPoint shortcut icon displays on your desktop and 
points to the location where you installed TurningPoint on the 
computer. Double-click the icon to open the program.

TurningPoint Shortcut Icon
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Open TurningPoint with PowerPoint

After you install TurningPoint onto your computer, you may want it to open automatically when you 
open PowerPoint. Or, you may want the programs to always open separately. You can change this 
option from the Settings window. 

Step by Step Instructions To toggle the option to automatically load TurningPoint ...

1 Double-click on the 
TurningPoint icon.

2 From the TurningPoint 
toolbar select Tools > 
Settings (Hint: it’s the one 
that looks like a pair of 
eyeglasses).

The Settings window opens.

Settings Window

3 Select the Presentation from 
the Settings Hierarchy.

A specific list of settings options displays in the menu. 
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Open TurningPoint with PowerPoint

4 Scroll down the menu until 
you see the Misc settings.

5 Select the Add-In always 
loaded setting.

A drop-down menu appears.

Settings Window: Add-In always loaded

6 Choose either True or False. Choosing True means that TurningPoint automatically loads 
when PowerPoint is opened.

Choosing False means that TurningPoint does NOT 
automatically load when PowerPoint is opened; you have to 
open TurningPoint manually.

7 Select the Done button. The Settings window disappears and, depending on your 
selection, TurningPoint either does or does not load the next 
time you open PowerPoint.
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Tour of the TurningPoint Toolbar

When you launch TurningPoint, PowerPoint opens and the TurningPoint toolbar is displayed 
beneath the PowerPoint standard and formatting toolbars in the upper region of the window, as the 
following image depicts. 

TurningPoint Toolbar

The following descriptions define the buttons that make up the tools in the TurningPoint toolbar. 

Information Allows you to view information 
about your TurningPoint 
License. It also provides a 
mechanism to supply 
Feedback to 
TurningTechnologies.

Reset Resets the response tallies 
from the audience to zero for 
all slides in the session or only 
the current slide. Find 
information about polling the 
audience in Chapter 6: Tools.

Continue Prior 
Session

Opens a previously saved 
session. A session is a run-
through of a presentation 
where an audience has 
submitted responses to some 
or all of the questions. Find 
information about continuing a 
prior session in Chapter 9: 
Sessions. 

Save Session Stores the current session for 
retrieval later. Find information 
about saving sessions in 
Chapter 9: Sessions.
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Tour of the TurningPoint Toolbar

Insert Slide Displays a menu of 
TurningPoint slides that you 
select to create a presentation. 
Find information about 
TurningPoint slides in Chapter 
3: Creating and Saving 
Slides.

Convert to 
Picture Slide

Use to assign and order 
pictures as answers instead of 
text. Find information about 
picture slides in Chapter 3: 
Creating and Saving Slides.

Insert Object Displays a menu of items that 
you select to enhance a slide. 
Find information about slide 
options in Chapter 3: Creating 
and Saving Slides.

Tools Provides advanced options to 
set up, create a presentation, 
and report data. 

Select Input 
Source

Selects the type of response 
devices to be used with the 
presentation. Find information 
about response devices in 
Chapter 4: TurningPoint 
Device and Settings 
Management.

Participants Provides options to be used 
with Participant Lists. Find 
information about these 
options in Chapter 5: Track 
Participants and Teams.

Select a 
Participant List

Assigns a Participant List to a 
session. Find information 
about participant lists in 
Chapter 5: Track Participants 
and Teams.
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Display 
TurningPoint 

Help

Opens the online help file. 
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Customer Support Resources

Customer Support Resources

This guide defines and demonstrates many of the tools and functions that TurningPoint gives you. If 
you have questions and concerns, additional resources are available to you online or by calling a 
Turning Representative. 

Online Assistance

Turning Technologies offers assistance to customers online through the Turning Technologies Web 
Site. To access the web site, go to http://www.turningtechnologies.com.

Go to the Product Guides and Manuals section of the Turning Technologies Web Site to find valuable 
information about using TurningPoint. The Downloads section provides a link to the Quick Start 
TurningPoint Users Guide. Select the link to download the users guide for viewing or printing. 

Go to the Learning Community section of the Turning Technologies Web Site find training information 
including:

• Tutorials

• Online Training

• Onsite Training 

• Case Studies 

• Best Practices 

• Presentations/Podcasts 

Customer Support

To speak with a Turning Representative call our toll-free phone number: 1-866-746-3015. By E-mail, 
send your inquiry to support@turningtechnologies.com.
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Office Hours:

Monday through Friday, 7:00 AM to 9:00 PM (EST)

Mailing Address:

Turning Technologies, LLC
241 Federal Plaza West
Youngstown, OH 44503

Turning Technologies, LLC offers complete TurningPoint training. Our trainers are ready to hit the 
road to fulfill your training needs at your location. Or if you desire, send your team to our state-of-
the-art training facility in Ohio. 

Typical training sessions last from two to six hours depending on your intended use of TurningPoint 
and skill level with Microsoft Office products. For Training Services, call 1-866-746-3015 for details.
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Where Do I Go From Here?

Where Do I Go From Here?

If you are new to TurningPoint, this manual will help you on your way. Read through Chapter 2: 
Getting Started with TurningPoint to receive a general overview of working with this product. 

Are you a returning user? Details of the new TurningPoint features can be found throughout this 
document. What’s New in 2008 on page 5 outlines these new features, while the Table of Contents or 
Index should help you find them quickly.
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Getting Started 
with 
TurningPoint

The process to create interactive presentations with TurningPoint is very simple. You can successfully 
build, deliver, and save the results of an interactive presentation in five easy steps.

From there, with a little more effort, you can customize the slides and include animation, feedback 
mechanisms, and excitement in your presentation. You can also create reports to view the results of 
your presentation session.

This chapter provides the basics, a tutorial of sorts, for using TurningPoint. Following the five steps to 
success allows you to create very simple interactive presentation slides, set up the devices, create a 
Participant List, and use TurningPoint to present those slides. 

The advanced features of TurningPoint are detailed in the chapters that follow. You can find 
information about the contents of those chapters in Where Do I Go From Here? on page 45.
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Five Steps to Presentation Success

Creating an interactive presentation with TurningPoint can be accomplished in five easy steps. 

Five Steps to Success

As the previous diagram depicts, you start by creating the presentation slides. These slides can be 
as simple or complex as you desire. You can use PowerPoint’s features to apply a background, 
insert graphics, etc. to meet your needs. You will repeat this step many times as you create 
additional TurningPoint interactive slide presentations.

Next, plug the devices into your computer to be used to during the presentation and you are ready 
to gather responses from the audience. You can go to the Polling Test found in Settings to test 
communication or skip the test and go to the next step. 
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Five Steps to Presentation Success

Then, identify your audience. Create a Participant List using the Participant List Wizard. You can 
choose from using standard list templates or creating one of your own to store as much information 
about your audience as is required. (You can also run a presentation without a Participant List if you 
wish.) Create a Participant List for each audience.

When that’s done, you are ready to run the presentation. You’ll use PowerPoint’s Slide Show 
functionality for this purpose. Behind the scenes, TurningPoint is gathering, tallying, and storing the 
responses provided by your audience.

Finally, save the results of your session in a file to be used with TurningPoint’s reports to evaluate the 
audience’s responses. Perform this step for each presentation session.

Instructions to perform these five steps to success are detailed in the following sections. Instructions 
to use the advanced features of TurningPoint are found in the chapters that follow. 

This section describes how to:

• Step One: Create Presentation Slides

• Step Two: Set Up the Response Devices

• Step Three: Create a Participant List

• Step Four: Run a Presentation Session

• Step Five: Save Session Results
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 Step One: Create Presentation Slides

Using TurningPoint to create an interactive presentation requires some basic PowerPoint 
knowledge and your imagination. Your slides can simply contain question and answer text, or you 
can add TurningPoint objects to each slide to allow your participants to interact effectively with your 
presentation. TurningPoint’s objects include answer reminders, timers, and response indicators, to 
name a few.

Before You Begin

Install TurningPoint on the machine to be used to run the presentation. Find installation instructions 
in Install TurningPoint on page 5.

You should be familiar with the basics of creating slides using PowerPoint. This manual discusses 
how to use TurningPoint to create interactive presentation slides.

Step by Step Instructions To create a simple slide…

1 From the TurningPoint 
toolbar, select the Insert Slide 
menu. 

This displays a variet of pre-defined slides. Each slide can be 
used as-is or customized to behave as you desire.
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Step One: Create Presentation Slides

As you move your cursor over the entries in the Insert Slide 
menu, the slide name is highlighted. Find more information on 
slides in Types of Slides on page 56

Insert Slide



24 Turning Technologies

Chapter 2: Getting Started with TurningPoint

2 Highlight and select the 
Vertical Slide option.

TurningPoint inserts a Vertical Slide. The slide contains a 
question region, an answer region, and a vertical bar chart.

Insert Vertical Slide

3 Select the Question region 
and type in a question.

When you select the region, the text is highlighted. The 
highlighted text is replaced with the question text that you 
enter.

4 Select the answer region and 
type in the answers.

This region has the same behavior as the Question region. 
You can enter a maximum of ten answers per slide.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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Step One: Create Presentation Slides

5 Repeat step 1–step 4 to 
insert additional slides.

6 Save your file before exiting 
TurningPoint.

Next Steps

Slides can be customized by adding a variety of animated feedback mechanisms. Find information 
about these different presentation objects and a variety of other slide features in Chapter 3: Creating 
and Saving Slides.
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Step Two: Set Up the Response Devices

Each audience participant uses a device to respond to the questions asked during the presentation.

TurningPoint supports a variety of response devices including infrared and radio frequency keypads 
as well as vPad, Web vPad, laptops, desktops, and Smart Devices.

TurningPoint needs to know what types of response devices will be used before you run the 
presentation. 

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations and must 
have the hardware device receivers and devices available for testing. 

Step by Step Instructions To set up the response devices…

1 Connect the device receiver 
to the presentation computer.

Connect the USB cable to your computer. The device is now 
ready for use. 

If you are using a response device licensed for TurningPoint 
2003 or 2006, contact your Account Executive to receive a 
new license code.
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Step Two: Set Up the Response Devices

2 If required, Upgrade your 
Response Device otherwise, 
go step 3.

a. From the TurningPoint 
toolbar, select Tools > 
Upgrade TurningPoint and 
follow the on screen 
instructions. 

Upgrade Response Device
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3 From the TurningPoint 
toolbar, select Tools > 
Settings. (Hint: it’s the one 
that looks like a pair of 
eyeglasses.) 

The TurningPoint Settings window opens, displaying two 
tabs: Settings and Polling Test. 

Settings Window

4 Select the Settings Tab. The Settings tab displays a Settings Hierarchy in the left pane 
and the available settings in the right pane.
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Step Two: Set Up the Response Devices

5 Select Response Device 
from the Settings Hierarchy. 

Settings for the Response Devices are listed in the right pane of 
the Settings window. Select All Settings to access more 
settings.

Settings Window: Response Devices

6 Enter the number of expected 
devices. 

You are only required to enter the number of expected devices 
when using Simulated Data or a Response Counter or 
Response Table.

TurningPoint limits the number of response devices that will be 
displayed in a Response Counter or on a Response Table 
based upon the number of expected devices entered. 

Find more information on Response Counters in Add a 
Response Counter on page 138 and Response Tables in Add 
a Response Table on page 141.

7 Select the Done button. The response device testing is now complete. 

Note Access the Response Device settings again 
when you need to make changes to the 
number or type of devices being used with your 
presentations.
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Next Steps

Find more information about Response Devices and the Settings available in Chapter 4: 
TurningPoint Device and Settings Management.

If an audience member’s device is not being accepted, check the device’s ability to communicate.

Step by Step Instructions To Check Device Communication...

1 Select the Polling Test Tab. TurningPoint displays the Polling Test screen. Use this screen 
to verify that TurningPoint can receive responses from the 
devices. 

Settings Window: Polling Test

For vPad and USB response devices, go to step 4. For Web 
vPad response devices, skip to step 5.

2 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. You can magnify the responses by placing 
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses
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Step Two: Set Up the Response Devices

3 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel (if applicable), an 
entry for each response device, in the order in which they were 
tested, and the key number pressed on each response device.

Polling Test: Response Device Test

4 Select the End Test button. This action ends the Polling test. If you are using the Web vPad, 
go to step 6. Otherwise, go to step 5.
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5 Select the Test Web vPad 
button.

If the connection was successful, TurningPoint displays Web 
vPad connected Successfully. Go to step 7

Polling Test: Web vPad Test

If connection was not successful, TurningPoint displays an 
error message. You should check your settings. For more 
help on settings see Obtain the Web vPad Response Device 
Settings on page 170

6 Select the Done button. The response device testing is now complete. 
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Step Three: Create a Participant List

 Step Three: Create a Participant List

Participant Lists identify the members of your audience—your students, your trainees, your survey 
respondents—who will use a response device during your presentation. The participant name and 
required information is stored along with information about their assigned device, which is identified 
by number (for example, 1, 2, 3, and so on) and by Device ID.

You may create multiple Participant Lists to be used with one interactive presentation. Doing so 
allows you to use the presentation with multiple audiences and track the session results per audience.

Before You Begin

Your Participant List must not exceed the number of devices licensed for use. If you are not sure of 
the number, perform the following steps on the computer to be used for presentations after you setup 
your response devices. 

Step by Step Instructions To create a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Participant List  Wizard.

The TurningPoint Participant List  Wizard window opens.

Turning Point toolbar: Participants
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2 Select a template to be used 
to create your own 
Participant List.

Participant List Wizard

Participant List template choices include:

• Education—contains standard student information 
used for K–12 and higher education presentations, 
such as name and student ID.

• Corporate—contains entries for the information most 
often used in corporate feedback meetings including 
name, company name, telephone numbers, etc.

• Available Fields—contains all information entries 
defined for use with TurningPoint.

• Custom—allows you to create a personalized 
Participant List and to name the template or it allows 
you to select a previously created template from the list.

3 Select the  Next  button to 
continue.

TurningPoint displays the Participant List information entries 
(called fields). Use this screen to customize a pre-defined 
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Step Three: Create a Participant List

template or to select the fields to be included in your Custom 
template.

Participant List: Add or Remove Fields

4 Optionally, select the right(>) 
and left (<) arrow buttons to 
to add or delete selected 
fields from the template. 
Optionally, drag and drop a 
field from the Available Fields 
to the Selected Fields.

5 Select the Next button to 
continue.

TurningPoint displays the Groups entry box. Use this screen to 
add Groups to your Participant List. Groups provide 

Note Find instructions to customize Participant List 
templates in Chapter 5: Track Participants 
and Teams.
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categorization allowing for team competitions and for greater 
reporting opportunities.

Participant List Wizard: Add Groups

6 Optionally, type in a Group 
name and select the Add 
button.

TurningPoint displays all Groups in the Included Groups list. 
Repeat this step to add additional groups.
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Step Three: Create a Participant List

7 Select the Next button. TurningPoint displays the Participant List summary screen. 

Participant List Wizard: Summary

8 Optionally, edit the 
Participant File composition.

The settings you can change include the Participant List file 
name, number of participants, number of fields, and number of 
groups. For file name select the old file name and type a new 
one in the box provided. For number of fields or number of 
groups select the link next to the setting to be returned to the 
screen and make your edits.

9 Select the Finish button to 
create the Participant List 
and save it to a file. 

TurningPoint opens the Participant Information window where 
you can type, Edit, paste, or import data. 
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10 Optionally, Add names and 
other participant information 
to the new Participant List. 

Participant Information

11 Select Done  to close the 
Participant Information 
window.

Next Steps

Find more information about Participant Lists in Chapter 5: Track Participants and Teams.
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Step Four: Run a Presentation Session

 Step Four: Run a Presentation Session

TurningPoint uses PowerPoint’s Slide Show capabilities to present the interactive slides you have 
created. You test your slides during development and run the presentation for your audience by 
executing the following steps.

Before You Begin

You must either have use an installed Response Device, Keyboard Keys 0-9, or select to use 
Simulated Data before attempting to run the presentation. It is recommended that you use a 
participant list, but you can still run a presentation session by selecting Anonymous or Auto for the 
participant list.

Step by Step Instructions To run a presentation session…

1 From the PowerPoint menu, 
select File > Open and select 
the TurningPoint 
presentation to be used.

2 From the TurningPoint 
toolbar, select the Response 
Device menu and select the 
device to be used.

TurningPoint allows you to select how responses will be 
provided during the presentation. Your choices are:

Select Response Devices

• Response Devices—a response device will be used 
during the presentation. The response devices must have 
been set up in Settings. Find more information on 
response devices in Install Devices on page 157.

• Keyboard Keys 0–9—you will provide input to the 
presentation using the keyboard keypad or number keys.
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• Simulated Data—TurningPoint provides random 
responses to the presentation. TurningPoint 
determines the number of responses to provide based 
on the number of expected devices designated in 
settings. i.e. If you enter expected devices as 100, 
TurningPoint will provide up to 100 responses to each 
question in your presentation. Find more information on 
expected devices in Manage Response Device 
Settings on page 171.

3 From the TurningPoint 
toolbar, select Reset > 
Session.

This command clears any active sessions from memory and 
allows polling to take place.

Reset Session

4 From the TurningPoint 
toolbar, select the Participant 
List Button and select the 
Participant List to be used.

A task pane appears to the right listing the available 
Participant Lists. The default Participant List is shown as 
(Anonymous). TurningPoint shows all Participant Lists 
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available in the Participants folder. Participant lists located on 
the desktop or in other folders are not displayed.

Participant List Selection

5 From the PowerPoint ribbon, 
select the Slide Show tab.

This displays a menu of slide show options. 

6 In the Start Slide Show 
section, select From the 
Beginning.

The first slide of the presentation is shown.
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7 Use the left mouse button to 
control the progress of the 
slide show. For each slide:

Optionally, you can press the Spacebar, Enter, or Right-Click 
and select next on the shortcut menu to control progress.

a Advance the presentation 
to a TurningPoint slide to 
open polling.

Polling opens automatically when a TurningPoint slide 
appears in the slide show. TurningPoint receives 
responses when polling is open.

Polling is the mechanism by which TurningPoint 
accepts and tallies responses. 

b  Click the slide once to 
close polling and display 
the results.

No responses are accepted when polling is closed.

c Click again to advance to 
the next slide.

8 Click at the end of the slides 
to exit from the Slide Show.

Next Steps

Your presentation may have additional features, such as animation, that cause it to behave 
differently at runtime from the default behavior. Find more information in Chapter 7: Run 
Presentations.



TurningPoint User Guide 43

Step Five: Save Session Results

Step Five: Save Session Results

TurningPoint stores the results from your session. These results can be reviewed at a later date and 
used with TurningPoint’s reporting feature in a variety of ways.

When you save a session, a default TurningPoint setting automatically includes the PowerPoint 
presentation with your TurningPoint file. You have the option to exclude the PowerPoint presentation 
from the TurningPoint session file. This function allows you to save only the TurningPoint results data 
without the presentation slides. If you do NOT wish to include the PowerPoint presentation in your 
TurningPoint session file, navigate to the Settings menu and, under the Misc heading, change 
‘Include Presentation’ from True to False. Find more information in Settings on page 189.

The session results are stored temporarily during a session. You can save the session results to a file 
to access them later. This section provides instructions to do just that.

Step by Step Instructions To save the session results…

1 From the TurningPoint 
toolbar, select the Save 
Session button. (Hint: it looks 
like a disk.)

TurningPoint opens the Save Session dialog box.

Save Sessions

2 Type a file name to be used 
to store the session results.

TurningPoint names session files using the current system date 
and time. Providing your own name for the file allows you to 
retrieve the file more easily.
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3 Select the Save button.

4 From the TurningPoint 
toolbar, select the Reset > 
Session command.

This command clears TurningPoint of the existing session 
results and allows you to run the presentation again to capture 
new results. 

Reset Sessions

Next Steps

You are able to run reports to review the responses provided by each participant for your 
presentation. The TurningPoint reports use the saved session file. Find more information on Turning 
Reports in  Chapter 8: Reports.

Note TurningPoint prompts you to save existing 
session results when you reset the session and 
when you exit from TurningPoint without 
previously saving the session. 
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Where Do I Go From Here?

The answer to that question depends upon what you want to do. Following is a listing of the remaining 
chapters in this book along with information about what to find in each chapter.

Chapter Name Description

Creating and Saving Slides This comprehensive, instructional chapter provides 
details of not only how to create a slide, but also how to 
add TurningPoint’s custom features to the slide to meet 
your needs. 

Read this chapter to understand how to add objects such 
as response timers and indicators, how to set slide 
defaults, how to convert existing slides into interactive 
TurningPoint slides, and more.

TurningPoint Device and Settings 
Management

Device setup is easy. However, if you need more help 
than what is included in this Getting Started chapter, 
you’ll find it here.

Read this chapter for a comprehensive guide of the 
available settings and how they can help you create a 
presentation to meet your needs.

Track Participants and Teams Participant Lists can use the default templates or can be 
customized to include information according to your 
needs or requirements.

Read this chapter to understand how to create custom 
Participant Lists, how to create Groups, how to modify or 
delete a Participant List, and how to download participant 
information from other sources.

Tools The tools discussed in this chapter include how to work 
with the Ranking Wizard, how to set up standards for 
your slides, and how to set up advanced features such as 
Comparative Links and Conditional Branching.
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Run Presentations Would you like to establish presentation session default 
behaviors? Have you included animation in your slides? 
Would you like to add slides during your presentation? 

This chapter focuses on the behavior of your slides 
during a Slide Show presentation and identifies how you, 
the presenter, interact with TurningPoint during a “live” 
session.

Reports This chapter focuses on the various reports produced 
from a Slide Show presentation. These reports allow you 
to get a better understanding of the audience and 
presentation results.

Sessions You can stop and save a session, and pick up where you 
left off at a later time. This chapter will teach you how to 
save, resume, and delete a session to give you flexibility 
during your presentation.

Export You may wish to export session data. This chapter will 
teach you how to export data in various ways.

Appendices The appendices include a guide to Frequently Asked 
Questions. 

Chapter Name Description
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Creating and 
Saving Slides

In Chapter 2: Getting Started with TurningPoint, you learned the basic steps for creating 
TurningPoint presentations. This chapter and the remaining chapters of this user guide demonstrate 
the steps in greater detail, allowing you to use all the powerful features TurningPoint offers.
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Recall the five steps to presentation success:

Five Steps to Success

As the previous diagram depicts, the first step is to create the presentation slides. This chapter 
demonstrates how to use TurningPoint to create the slides you will use later in a presentation.

TurningPoint slides are slides in a PowerPoint presentation with the ability to dynamically display 
information based on the responses of an audience. Most TurningPoint slides ask the audience to 
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answer a question, and then tabulate and display the responses. These slides have a question 
region, an answer region, and a chart. 

Composition of a slide

The question region contains the text of the question you are asking the audience. The answer region 
contains an enumerated list of answers that the audience can choose from. (You can even use 
pictures as the answers. Find more information in Create Picture Slides on page 115.) 

The chart shows the results of the audience’s choices, with a bar, slice, or other indicator for each 
answer (depending on the type of chart). There are six  types of charts available. Find more 
information in Chart Slides on page 57.

You start by creating some TurningPoint slides. You have several options:

• Insert a TurningPoint template slide using the Insert Slide menu in the TurningPoint toolbar. 

Find instructions for inserting a slide in Insert a Slide on page 51.

• Convert an existing PowerPoint slide into a TurningPoint slide by inserting a TurningPoint chart 
using the Insert Object menu in the TurningPoint toolbar.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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Find instructions for converting a PowerPoint slide in Make a PowerPoint Slide Interactive by 
Inserting a Chart on page 123.

Once you create the slides, you can modify them in a number of ways. You can add pictures, 
change colors, change the chart, mark correct answers, and perform other operations specific to 
TurningPoint. Find more information in Modify Slides on page 85.

Additionally, TurningPoint allows you to add a number of TurningPoint objects to your slides. These 
include response indicators, countdowns, and even statistics like the average and variance of the 
responses. Find information on adding objects in Add Objects on page 128.

Your TurningPoint slides are saved as part of your PowerPoint presentation in your .ppt file. Find 
information on saving your presentation in Save the Presentation Slides on page 54.
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Creating Slides

Creating Slides

TurningPoint allows you to create and save an interactive presentation. 

This section describes how to:

• Insert a Slide

• Save the Presentation Slides

Insert a Slide

You can insert a TurningPoint slide using the Insert Slide menu.
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Step by Step Instructions To insert a slide into a presentation…

1 In TurningPoint, open a 
presentation or create a new 
presentation.

2 Select Insert Slide from the 
TurningPoint toolbar.

The Insert Slide menu opens. 

Insert Slide menu
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Creating Slides

3 Select the type of slide you 
would like to insert from the 
Insert Slide menu.

TurningPoint inserts the new slide into your presentation.

Depending on what type of slide you selected, the new slide 
may contain question and answer regions and a chart.

Find information about the different slide types in Types of 
Slides on page 56.

Composition of a Slide

Additionally, depending on your TurningPoint settings, the slide 
may contain answer, response, and countdown indicators or 
other objects. Find more information on adding or changing 
these objects in Add Objects on page 128.

Question region - “Enter question text...”

Answer region - “Enter answer text...”

Chart region - This example is a vertical bar 
chart. Charts can be positioned anywhere on the 
slide.
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4 Edit the text in the question 
region to reflect the question 
you would like to ask the 
audience.

5 Edit the text in the answer 
region to reflect the choices 
the audience will have when 
responding to the question.

You may enter up to ten answers in the answer region.

Repeat this procedure as many times as needed to create 
your interactive presentation.

Save the Presentation Slides

Your TurningPoint slides are saved as part of your regular PowerPoint (.ppt) presentation file. You 
can share this file with other TurningPoint users. 

Step by Step Instructions To save your presentation…

6 Select the Office Button > 
Save As from the PowerPoint 
menu.

The Save As window opens.

Note You can safely open the presentation on 
computers without TurningPoint installed, 
but you cannot use the TurningPoint 
features. You should not edit the 
TurningPoint slides on a computer without 
TurningPoint installed.
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7 Select a location to save the 
file and type a filename for 
the file in the space provided.

You should keep the .ppt extension in the filename to ensure 
that PowerPoint opens the presentation file.

8 Select the Save button to 
save your file.

TurningPoint saves all of the presentation level settings that you 
defined in the Settings menu to the presentation itself. When 
you open the presentation on a different computer, the saved 
presentation settings are used instead of the computer’s default 
settings. This function preserves your custom settings so that 
you do not have to reapply them every time you open a 
presentation on a new computer. Find more information on 
settings in Chapter 4: TurningPoint Device and Settings 
Management

Note You can restore the computer’s settings 
when using any presentation. In the Settings 
menu, select the Presentation from the 
Settings Hierarchy. A Restore default 
Presentation Settings box displays in the bar 
below the settings options. Select this 
button and a dialog box appears with this 
statement: ‘This will restore the presentation 
settings back to the default installation 
state.’ Select OK to restore the default 
settings.
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Types of Slides

The Insert Slide menu on the TurningPoint toolbar lists all of the slides you can insert into a 
presentation.

Insert Slide menu

This section describes

• Chart Slides

• Competition Slides

• Template Slides

• Special Slides
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Chart Slides
The first set of six  slides (above the first divider in the menu) insert a template slide with a chart of the 
specified type: vertical, horizontal, 3D pie, distributed pie, offset, or doughnut. The chart shows the 
results of the audience’s choices for each answers.

Chart Slides Menu

The six  chart slides in the Insert Slide menu each contain the following:

• A question area with the text “Enter question text…”

• An answer area with the text “Enter answer text…”

• A chart of the specified type: vertical, horizontal, 3D pie, distributed pie, offset, or doughnut.

Charts are objects on the TurningPoint slide that can be moved and resized just like ordinary objects. 
You can change the type of chart on a TurningPoint slide by following the instructions in Change 
Chart Types on page 86.
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Vertical Slide The vertical slide contains a bar chart with vertical bars for 
each answer.

Vertical Slide

Horizontal Slide The horizontal slide contains a bar chart with horizontal bars 
for each answer. Each bar displays behind the corresponding 
answer in the answer region.

Horizontal Slide
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3D Pie Slide The 3D pie slide contains a three-dimensional pie chart with a 
slice for each answer and a key indicating the color representing 
each answer.

3D Pie Slide

Distributed Pie Slide The distributed pie slide is similar to the 3D pie slide except the 
slices are shown separated from each other.

Distributed Pie Slide
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Offset Slide The offset slide contains a bar chart with horizontal bars for 
each answer. Each bar is shown directly below the 
corresponding answer in the answer region.

Offset Slide

Doughnut Slide The doughnut slide contains a pie chart with a hollow center 
with a slice for each answer and a key indicating the color 
representing each answer.

Doughnut Slide
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Competition Slides
The second set of four slides are the setup and summary slides for competitions these slides allow 
you to assign teams and keep track of the participants or teams with the most points and fastest 
responses. 

Competition Slides Menu

The competition slides include: Team Assignment Slide, Participant Leader Board, Team Leader 
Board, Fastest Responders.

Since the Leader Boards and Fastest Responders slides are updated after each question, you only 
need to include one of each in your presentation. Simply place it at the end of the presentation and 
jump to that slide when you want to know which participants or teams are in the lead.

Team Assignment Slide The Team Assignment slide allows teams to be assigned by 
asking the audience members to choose a team. Simply include 
names for the teams in the answer list and the participants will 
automatically be placed on the teams according to their 
answers. Display this slide early in your presentation so that 
participants can join a team at the beginning.

Team Assignment Slide
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Using the Team Assignment slide is an alternative to 
assigning participants to groups in a Participant List. The 
Team Assignment slide allows teams to be assigned 
dynamically, while assigning groups in the Participant List 
ensures that the same participants are always on the same 
teams. Find more information on setting up a competition in 
Set Up Team Competitions on page 255.

Participant Leader Board
Slide

The Participant Leader Board displays the top individual 
participants ranked by their point totals.The Participant 
Leader Board slide updates dynamically after each question.

Participant Leader Board Slide

You can specify the number of participants to show on the 
slide using the TurningPoint settings. You can also specify 
whether the point totals should be cumulative, or for the most 
recent question only. Find more information on modifying 
settings in TurningPoint Device and Settings Management 
on page 153.

Team Leader Board Slide The Team Leader Board displays the top teams ranked by 
their point totals. (The team’s points are the average of the 
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team’s participant’s points.) The Team Leader Board slide 
updates dynamically after each question. 

Team Leader Board Slide

You can specify the number of teams to show on the slide using 
the TurningPoint settings.You can also specify whether the 
point totals should be cumulative, or for the most recent 
question only. Find more information on modifying settings in 
TurningPoint Device and Settings Management on page 153. 

Fastest Responders The Fastest Responders displays the individual participants 
who responded correctly and the fastest to the most recent 
question. This feature requires a correct response or point 
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value. The Fastest Responders slide is updated dynamically 
after each question. 

Fastest Responders Slide

You can specify the number of participants or teams to show 
on the slides using the TurningPoint settings. Find more 
information on modifying settings in TurningPoint Device 
and Settings Management on page 153. 
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Template Slides
The third  set of slides are templates for commonly used kinds of questions, such as Yes/No, 
True/False, Yes/No/Abstain, Likert Scale,  Generic and Ice Breaker slides.

Template Slides Menu

When you insert any of the template slides, a  chart of the 
default type (specified in the Settings) is inserted onto the slide. 
You can change the chart type on the inserted slide. Find 
information for changing chart types in Chart Slides on 
page 57.

Yes/No Slide A Yes/No slide is used for a question with yes or no 
response.The template slide includes a generically worded 

Note You can change the default chart type to any 
of the six chart types using the Standard 
Chart Type setting, a presentation-level 
setting. Find more information on modifying 
settings in TurningPoint Device and 
Settings Management on page 153.
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question and answers. You may wish to edit the question to 
be more specific.

Yes/No Slide

True/False Slides A True/False slide is used for a question with a true or false 
response. The template slide includes generically worded 
question and answers. You may wish to edit the question to 
be more specific.

True/False Slide

Yes/No/Abstain Slide A Yes/No/Abstain slide is used with a yes or no response with 
option to abstain. The template slide includes generically 
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worded question and answers. You may wish to edit the 
question to be more specific.

Yes/No/Abstain Slide

Likert Scale Slide A Likert scale slide is used for a statement with a response of 
varying levels of agreement or disagreement. There are 4-, 5-, 
and 7-level Likert scale slides. The template slide includes a 
generically worded question and answers. You may wish to edit 
the question to be more specific.

Likert Scale Slide

Generic Slide A Generic 2- to 10-answer slide allows you to insert a a slide 
with up to 10 answers. The template slide includes generically 
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worded question and answers. You may wish to edit the 
question and answers to be more specific.

Generic Slide

Icebreaker Slides An Icebreaker slide is a slide with analogy or word scramble 
questions to get your audience involved in your TurningPoint 
presentation. Analogies are automatically generated, but you 
must supply a word for the word scramble.

The Analogy icebreaker slide creates a slide with an analogy 
question with one missing word. (For example, parking 
brake:car::anchor:?) It includes four choices, one of which is 
marked as the correct choice. (If you include a Correct 
Answer indicator, the correct choice will be revealed after 
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polling. Find more information on adding a Correct Answer 
indicator in Add a Correct Answer Indicator on page 143.)

Analogy Slide

The Word Scramble icebreaker slide asks you to input a word. 
Every other letter from the word is removed. (For example, 
COMPUTER becomes C_M_U_E_.) The removed letters are 
scrambled and appear as one of four choices. The correct 
choice is automatically marked. (If you include a Correct Answer 
indicator, the correct choice will be revealed after polling. Find 
more information on adding a Correct Answer indicator in Add 
a Correct Answer Indicator on page 143.)

Word Scramble Slide
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Special Slides
The final set of slides in the Insert Slides menu are special-purpose slides. There are several 
special-purpose slides: ResponseCard RF Channel Slide, vPad/Web vPad Log-In, Fill in the Blank, 
Essay Slide, Priority Ranking, Demographic Comparison, and Moment to Moment -2 to +2.

Special Slides Menu

ResponseCard RF Channel
Slide

The ResponseCard RF Channel Slide, which displays 
channel setting instructions for the ResponseCard Radio 
Frequency devices used by participants. 

The ResponseCard RF Channel Slide displays instructions 
that show participants how to set the channel code on their 
response devices. If simultaneous presentations are 
occurring in adjacent rooms, channel setting prevents 
frequency disruption between response devices and 
receivers. 

Before you change the channel settings on the 
ResponseCard devices, you will need to change the channel 
on the receiver. There are 82 possible channels for the 
ResponseCard RF and 74 possible channels for 
ResponseCard XR, and the default channel is 41.

Once the channel is set correctly on the receiver, display the 
ResponseCard RF Channel Slide early in your presentation 
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so that participants can update the channel code on their 
devices.

ResponseCard RF Channel Slide

vPad/Web vPad Log-In Slide The vPad/Web vPad Log-In slide displays setup information for 
participants using vPad or Web vPad to send their responses.

The vPad/Web vPad Log-In slide displays the computer’s 
friendly name, IP address, and port number, which are required 
for participants submitting responses using vPad and the 
Session Name and Access Code for Web vPad. If some of the 
participants in your audience will be using vPad or Web vPad, 
you should include this slide early in your presentation so that 
they can successfully connect. Find more information on using 
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vPad or Web vPad in Chapter 4: TurningPoint Device and 
Settings Management. 

vPad/Web vPad Log-In Slide

Fill in the Blank Slide Fill in the Blank slides contain a question region for you to 
pose a question. It does not contain an answer region or a 
chart, since the responses are in the form of text. 
ResponseCard users are limited to numerical responses, but 
vPad and Web vPad users may type in alphanumeric 
responses of varying lengths.

You can specify one or more keywords in the TurningPoint 
settings that the answer should contain to be considered 
correct (for reporting and grading purposes). Find more 
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information in Chapter 4: TurningPoint Device and Settings 
Management

Fill in the Blank Slide

Essay Slide Essay slides (for vPad and Web vPad participants only) contain 
a question region for you to pose a question. They do not 
contain an answer region or a chart, but vPad and Web vPad 
users may type in alphanumeric responses of varying lengths.

Essay Slide

Priority Ranking Slide A Priority Ranking slide weighs participants’ choices and then 
ranks them accordingly.
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Priority Ranking slides allow participants to respond to a 
question or poll multiple times. You select the number of 
responses (maximum of 10) allowed per participant. The 
participants’ responses are then weighted, with points 
assigned to each response. First choices are weighted with 
more points than second choices, second more than third, 
etc. 

By allowing participants to choose more than one option, you 
can see a more diverse range of their preferences. The 
Priority Ranking slide displays the weighted scores assigned 
to the answers based on participant responses. Find more 
information in Insert a Priority Ranking Slide on page 76.

Priority Ranking Slide

Demographic Comparison
Slide

A Demographic Comparison slide shows results based on 
certain demographic information.

The Demographic Comparison slide visually displays the 
results of a question based on certain demographic 
information obtained from the audience. For instance, you can 
insert a comparison slide that calculates how participants’ 
ages relate to the amount of television that they watch. To use 
a Demographic Comparison Slide you must first designate a 
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slide as ‘Demographic.’ Find more information on Designate a 
Demographic Slide on page 80.

Demographic Comparison Slide

Moment to Moment Scoring The Moment to Moment scoring slide can be used to have 
participants rate something on a scale of -2 to +2 at regular 
intervals over a period of time. The Moment to Moment slide 
contains a question region for the question and a chart that 
shows the average response at each polling interval and a 
curve connecting the values. Polling continues until you stop it 
by clicking on the slide.

You can set the polling interval in seconds for a Moment to 
Moment slide in the TurningPoint settings using the Polling 
Cycle setting, a slide-level setting. Find more information about 
modifying settings in TurningPoint Device and Settings 
Management on page 153.

Moment to Moment Scoring Slide
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Insert Special Slides

Inserting some Special Slides differs from inserting Chart, Competition, Template, and Special 
slides as outlined in Insert a Slide on page 51. These slides require additional information or setting 
changes to function properly. 

This section describes how to:

• Insert a Priority Ranking Slide

• Designate a Demographic Slide

• Insert a Demographic Comparison Slide

Insert a Priority Ranking Slide

You can insert a Priority Ranking slide to allow participants to respond multiple times to a question. 
The responses are then weighted and ranked accordingly.

You could use a Priority Ranking slide to find out a what is most important to participants. You insert 
a Priority Ranking slide, select the number of responses you want to allow per participant, and then 
ask participants what is most important. You ask participants to enter their first choice as their first 
response, their second choice second, etc. Choices entered first are weighted more heavily.

For example: You create a slide with five possible answers. You allow three responses (choices) per 
participant where first the choice is worth ten points, the second nine, and the third eight. You have 
six participants providing responses. The first three participants select 5, 4, 3 as answers in that 
order. The second three participants select 1,2,3 as answers in that order. TurningPoint calculates 
the results as depicted in the table below.

Priority Ranking Calculation Sample
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The table shows that despite participants selecting answers 1 and 5 as their first choice 3 times each, 
all six participants selected answer 3. This gives answer 3 a higher priorty for the group as a whole.
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Step by Step Instructions To insert a Priority Ranking slide…

1 Navigate to the slide you 
would like the Priority 
Ranking slide to be inserted 
after.

2 Select Insert Slide from the 
TurningPoint toolbar.

The Insert Slide menu opens. 

Insert Slide Menu
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3 Select Priority Ranking. A dialog box appears asking how many responses you want to 
allow per participant.

Priority Ranking Dialog Box

4 Type the number of 
responses you wish to allow 
per participant.

The default number of responses is set at 3. The maximum 
number of responses cannot be higher than 10.

5 Select OK. A new slide appears prompting you to enter question and 
answer text.

Priority Ranking Slide

6 Enter the desired question 
and responses.

You can now poll participants and ask them to respond the 
selected number of times. Their responses are weighted and 
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ranked: first responses weighted more than second, second 
more than third, etc.

Designate a Demographic Slide

You can designate a slide as demographic to see how a certain group in your audience responds to 
certain questions. Slides designated as Demographic can be used in conjunction with Demographic 
Comparison Slides or Demographic Reports. Find more information on Insert a Demographic 
Comparison Slide on page 81 and on Demographic Reports on page 352.

Step by Step Instructions To designate a slide as ‘Demographic’...

1 From the TurningPoint 
toolbar, select Tools > 
Settings (Hint: It’s the one 
that looks like a pair of 
glasses.)

The Settings window opens.

2 Select the slide you want to 
designate as Demographic 
from the Settings Hierarchy.

This displays the available settings for the slide in the right 
pane of the window.
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3 Under the Misc heading, 
select Demographic.

A Drop-down menu appears.

Settings for Demographic Slide

4 Select True

5 Select Done Your slide is now a Demographic Slide.

Insert a Demographic Comparison Slide

The Demographic Comparison slide can be used to visually display the results of a question slide in 
terms of certain demographic information gathered from the audience. 

For example, you could use this slide to show how participants’ age groups influence the number of 
hours of television they watch per day. To do this, you first create a question slide asking participants 
what age group they fall under and then designate that slide as ‘Demographic.’ Next, poll participants 
by asking ‘How many hours or television they watch a day?’ Finally, you insert a Demographic 
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Comparison slide that provides percentages for how many hours of television each participant’s age 
group watches a day.

Demographic Comparison Slide

It’s important to remember that you must designate a slide as ‘Demographic’ in the Settings menu 
to be able to insert a Demographic Comparison slide. 
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Step by Step Instructions To insert a Demographic Comparison slide…

1 Navigate to the slide you 
would like the Demographic 
Comparison slide to be 
inserted after.

2 Select Insert Slide from the 
TurningPoint toolbar.

The Insert Slide menu opens. 

Insert Slide Menu
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3 Scroll down the list and select 
Demographic Comparison.

The Demographic Comparison dialog box opens.

Demographic Comparison Dialog Box

4 Select a demographic slide 
from the first drop-down 
menu.

Any slides you have designated as ‘Demographic’ are 
included in the menu.

5 Select a question slide to link 
with the demographic slide 
from the second drop-down 
menu.

You must choose both a demographic slide and a question 
slide.

6 Select OK. The Demographic Comparison slide is inserted displaying the 
demographic results in a chart. This slide creates its title 
based on the question slide.
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Modify Slides

TurningPoint slides are simply ordinary PowerPoint slides with extra features, so you can use and 
customize them as you would an ordinary PowerPoint slide. You can reorder slides, move objects, 
add text and pictures, apply fonts and color schemes, and use animation. Find more information in 
your PowerPoint documentation.

You can also modify the features TurningPoint adds to your slides. You can change chart types and 
colors (find more information in Chart Slides on page 57). You can use pictures for answers (find 
more information in Create Picture Slides on page 115). And you can add a correct answer indicator 
(find more information in Add a Correct Answer Indicator on page 143).

This section describes how to: 

• Change Chart Types

• Enable Zero-based Polling

• Identify a Correct Answer from the Settings Window

• Identify a Correct Answer on a TurningPoint Slide

• Use Keywords for Fill in the Blank Slides

• Set Point Values from the Settings Window

• Set Point Values on a TurningPoint Slide

• Clear Answer Values from the Settings Window

• Clear Answer Values on a TurningPoint Slide

• Use Speed Scoring

• Create Picture Slides

• Change Chart Colors

• Make a PowerPoint Slide Interactive by Inserting a Chart

• Disable Auto Scale in Charts

Note Chart settings will retain any modifications 
you make, even after you add or remove 
answers on the modified chart slides.
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Change Chart Types

You can change the type of chart on a TurningPoint slide using the Insert Object menu.

Step by Step Instructions To change a chart’s type…

1 Navigate to the TurningPoint 
slide in your presentation on 
which you would like to 
change the chart.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu
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3 Select Charts to display the 
Charts submenu.

Insert Object: Chart Selection

4 Select the type of chart you 
would like to appear on the 
slide.

When you select the chart type, TurningPoint changes the chart 
on your slide to match the type.

Enable Zero-based Polling

By default, answers are numbered 1-10, but you can change the settings to enable answers to be 
numbered 0-9 for zero-based polling. 
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Step by Step Instructions To enable Zero-Based Polling...

1 In the TurningPoint toolbar, 
select Tools > Settings (Hint: 
It looks like a pair of 
eyeglasses).

2 Select Presentation or a 
specific Slide from the 
Settings Hierarchy.

Settings Window

Selecting Presentation affects all of the slides in the 
presentation. You will need to select the All Settings to reveal 
the Zero-Based Polling Option for the Presentation. Selecting 
a Slide affects the currently selected slide.
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3 Under the Misc heading, 
select Zero-Based Polling.

A drop-down menu appears to the right.

Settings Window: Enable Zero-Based Polling

4 Use the drop-down menu to 
select True.

Your answers are now numbered 0 to 9. To enable Zero-Based 
Polling for the entire presentation, you will need to select “Apply 
All.”

Identify a Correct Answer from the Settings Window

You can specify whether answers in your TurningPoint slides should be considered correct or 
incorrect from the Settings window. By setting answer values, you can show the correct answer after 
polling with a Correct Answer indicator (find more information in Add a Correct Answer Indicator on 
page 143) or by coloring the chart to indicate correct and incorrect answers (find more information in 
Change Chart Colors on page 118).

You can set keywords for fill in the blank questions. If a response contains the keyword, it will be 
considered correct. Find more information in Use Keywords for Fill in the Blank Slides on page 95.

You can identify a correct answer to a question from the Settings window. By default, answers marked 
Correct have a value of 100 points, and answers marked Incorrect have a value of 0 points for the 
purposes of scoring and competition. (Find information about assigning specific point values to 
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answers in Set Point Values from the Settings Window on page 97 or Set Point Values on a 
TurningPoint Slide on page 103.)

Step by Step Instructions To mark an answer correct from the Settings window…

1 In the TurningPoint Toolbar, 
select Tools > Settings (Hint: 
It’s the one that looks like a 
pair of glasses).

This displays the Settings window

Settings Window
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2 From the Settings Hierarchy, 
find the slide on which you 
would like to identify a correct 
answer.

3 Select the Answer you want 
to identify as correct.

This displays the settings for that answer.

Settings Window: Answer Settings

4 Select Correct from the 
Answer Value drop down 
menu.

Settings Window: Select Correct
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TurningPoint sets the selected answer as Correct and 
automatically sets other answers as Incorrect.

You can have more than one correct answer on a slide by 
repeating these steps on another answer.

You can change an answer you marked as Correct to 
Incorrect by repeating these steps and selecting Incorrect 
from drop down menu.

Identify a Correct Answer on a TurningPoint Slide

You can specify whether answers in your TurningPoint slides should be considered correct or 
incorrect. By setting answer values, you can show the correct answer after polling with a Correct 
Answer indicator (find more information in Add a Correct Answer Indicator on page 143) or by 
coloring the chart to indicate correct and incorrect answers (find more information in Change Chart 
Colors on page 118).

You can set keywords for fill in the blank questions. If a response contains the keyword, it will be 
considered correct. Find more information in Use Keywords for Fill in the Blank Slides on 
page 95.

You can identify a correct answer to a question on a TurningPoint slide. By default, answers marked 
Correct have a value of 100 points, and answers marked Incorrect have a value of 0 points for the 
purposes of scoring and competition. (Find information about assigning specific point values to 
answers in Set Point Values from the Settings Window on page 97 or Set Point Values on a 
TurningPoint Slide.)

Note You can also set the Correct or Incorrect 
from the slide. Find more information in 
Identify a Correct Answer on a 
TurningPoint Slide on page 92.
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Step by Step Instructions To mark an answer correct…

1 Navigate to the slide on 
which you want to mark a 
Correct Answer.

2 Place your cursor in the 
Answer region of the slide.

An Answer Values Task Pane appears listing all of the answers 
and current answer values. 

Answer Values Task Pane
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3 Select Correct from the 
Answer Value drop-down 
menu. 

TurningPoint sets the selected answer as Correct and 
automatically sets other answers as Incorrect.

Answer Values Task Pane: Select Correct

You can have more than one correct answer on a slide by 
repeating these steps on another answer.

You can change an answer you marked as Correct to 
Incorrect by repeating these steps and selecting Incorrect 
from the contextual menu instead.

Note You can also set the Correct or Incorrect 
value in the Answer Value setting, a slide-
level setting for each answer. Find more 
information about modifying settings in 
TurningPoint Device and Settings 
Management on page 153.
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Use Keywords for Fill in the Blank Slides

Fill in the Blank slides, by their nature, do not have enumerated answers. You can, however, specify 
that responses to a Fill in the Blank slide be counted as correct if it contains a certain word or words—
a “keyword.”

Step by Step Instructions To use keywords…

1 Open the Settings window 
from the TurningPoint toolbar 
by selecting Tools > Settings. 
(Hint: It’s the one that looks 
like a pair of eyeglasses.)

The Settings window opens.

Settings Window
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2 If it is not already selected, 
select the slide on which you 
would like to assign keywords 
from the Settings Hierarchy. 

3 Under Misc headings, select 
Keywords.

Settings Window: Keywords

4 Type the word(s) to include 
as keywords in the space 
provided.

You can separate multiple keywords with commas. 
Responses containing any of the keywords will be counted as 
correct.

5 Select the Done button in the 
Settings window to save your 
changes.

Note The Keywords setting will only be displayed if 
you select a Fill in the Blank or Essay slide. 
Although you can assign keywords for Essay 
slides, keywords are only considered for Fill 
in the Blank slides for reporting and grading 
purposes.
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Set Point Values from the Settings Window

The answer values are used to compute the scores in the summary slides for competitions. 
Additionally, they are available in TurningPoint Reports. Find more information in Reports on 
page 341.

You can set numerical point value for an answer in the range of negative 10,000 - 10,000. An answer 
set as Correct has a default point value of 100. An incorrect answer has a default value of 0. 

You can assign different point values to different answers (if one answer should be awarded more 
than another, for example).

You can change the default point value settings for both correct and incorrect answers at the 
Presentation or Slide level form the Settings window. For instance, you could enable participants to 
receive positive points even if they answer incorrectly. To do this, you must first change the point 
value at the Presentation or Slide level from the Settings window. Then set the appropriate answers 
as Incorrect directly on the TurningPoint slides or at an Answer level from the Settings window. 
Conversely, you can enable participants to receive negative points for correct answers in the same 
way. Change the point value at the Presentation or Slide level from the Settings window. Then set the 
appropriate answers as Correct directly on the TurningPoint slides or at an Answer level from the 
Settings window.(Find more information about Settings in TurningPoint Device and Settings 
Management on page 153.) 

You can identify a correct or incorrect answer by following the instructions in Identify a Correct 
Answer from the Settings Window on page 89 or Identify a Correct Answer on a TurningPoint 
Slide on page 92. 

If you assign negative points to a correct answer or positive points to an incorrect answer, use the 
Point Value reports. The Percentage Reports will treat the correct answers with negative point values 
as incorrect answers and incorrect answers with positive point values as correct answers. 
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Step by Step Instructions To set a point value for an answer…

1 In the TurningPoint toolbar, 
select Tools > Settings.

This displays the settings window.

Settings Window

To assign the same point values to the whole presentation, go 
to step 2. To assign point values to a specific slide, go to 
step 3.
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2 Assign the same point values 
to the whole presentation.

a Select Presentation from 
the Settings Hierarchy.

This displays the available presentation settings.

Settings Window: Presentation Settings

b Under the Misc heading, 
select Correct Point Value.

This displays a text box to enter the value you want 
correct answers to receive. 

Settings Window: Correct Point Value
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c Enter the correct point 
value.

d Hit the Enter key. TurningPoint sets the point value for the presentation.

To set incorrect point values, go to step f. If you are 
done setting point values go to step 4.

e Under Misc heading, 
select Incorrect Point 
Value.

This displays a text box to enter the value you want 
incorrect answers to receive.

Settings Window: Incorrect Point Value

f Enter the incorrect point 
value.

g Hit the Enter key. TurningPoint sets the point value for the presentation. 

Repeat steps a through d for each slide on which you 
want assign and individual point. Otherwise go to 
step 4.



TurningPoint User Guide 101

Modify Slides

3 Assign individual point values 
to a specific slide.

a Select the slide from the 
Settings Hierarchy.

This displays the available slide settings.

Settings Window: Slide Settings

b Under the Misc heading, 
select Correct Point Value.

This displays a text box to enter the value you want 
correct answers to receive. The value can range from 
negative 10,000 to 10,000

Settings Window: Correct Point Value
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c Enter the correct point 
value.

d Hit the Enter key. The correct point value is set. To set incorrect point 
values, go to step 3. If you are done setting point values 
go to step 4.

e Under Misc heading, 
select Incorrect Point 
Value.

This displays a text box to enter the value you want 
incorrect answers to receive. The value can range from 
negative 10,000 to 10,000.

Settings Window: Incorrect Point Value

f Enter the incorrect point 
value.

g Hit the Enter key. The incorrect point value is set. 

Repeat step 3 for each slide on which you want to 
assign individual point values. If have finished setting 
point values go to step 4.
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You can change the point value you set by repeating 
these steps on the same slide and entering the new point 
value instead.

4 Select Done. You can award points for answers proportionally to how quickly 
participants respond using speed scoring. Find more 
information in Use Speed Scoring on page 113.

You can use speed scoring in competitions to award more 
points to faster responders. Find more information in Use 
Speed Scoring on page 113.

You can clear the point value for a particular answer or for all 
answers on the slide by following the instructions in Clear 
Answer Values from the Settings Window on page 108 or 
Clear Answer Values on a TurningPoint Slide.

Set Point Values on a TurningPoint Slide

The answer values are used to compute the scores in the summary slides for competitions. 
Additionally, they are available in TurningPoint Reports. Find more information in Reports on 
page 341.

You can set numerical point value for an answer in the range of negative 10,000 - 10,000. An answer 
set as Correct has a default point value of 100. An incorrect answer has a default value of 0. 

You can assign different point values to different answers (if one answer should be awarded more 
than another, for example).

Note If you have assigned negative points to a 
correct answer or positive points to an 
incorrect answer, use the Point Value 
reports. The Percentage Reports will treat 
the correct answers with negative points 
values as incorrect answers and incorrect 
answer with positive point values as correct 
answers.
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You can change the default point value for both correct and incorrect answers. Additionally, you 
could enable participants to receive positive points even if they answer incorrectly. Conversely, you 
could enable participants to receive negative points if they answer correctly. Find more information 
in Set Point Values from the Settings Window on page 97.

You can identify a correct or incorrect answer by following the instructions in Identify a Correct 
Answer from the Settings Window on page 89 or Identify a Correct Answer on a TurningPoint 
Slide. 
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Step by Step Instructions To set a point value for an answer…

1 Navigate to the slide on 
which you want to set point 
values.

2 Right-click on the picture (for 
a picture slide) or the number 
of the answer (for all other 
slides).

The answer is highlighted and a contextual menu opens. At the 
bottom of this menu, note the group of items including Set Point 
Value.

Contextual Menu
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3 Place your cursor in the 
Answer region of the slide.

An Answer Values Task Pane appears listing all of the 
answers and current answer values. 

Answer Values Task Pane
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4 Select Set Point Value from 
the Answer Value drop-down 
box.

Answer Values Task Pane: Select Set Points

A dialogue box asking you to enter a point value opens.

Point Value Dialog Box
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5 Enter a point value in the 
space provided and click the 
OK button .

TurningPoint sets the point value for the selected answer.

You can set the point value for another answer by repeating 
these steps on another answer.

You can change the point value you set by repeating these 
steps on the same answer and entering the new point value 
instead.

You can award points for answers proportionally to how 
quickly participants respond using speed scoring. Find more 
information in Use Speed Scoring on page 113.

You can use speed scoring in competitions to award more 
points to faster responders. Find more information in Use 
Speed Scoring on page 113.

You can clear the point value for all answers in a presentation 
by following the instructsions in Clear Answer Values from 
the Settings Window on page 108. You can clear the point 
value for a particular answer or for all answers on the slide by 
following the instructions in Clear Answer Values on a 
TurningPoint Slide on page 111.

Clear Answer Values from the Settings Window

If you wish to reset answer values from the Settings Window, you will reset all presentation settings 
to the default settings. Find more information on resetting individual answers in Clear Answer 
Values on a TurningPoint Slide on page 111.

Note You can also set the point value in the 
Settings menu after selecting a specific slide. 
Under Misc, enter the desired point values 
beside Correct Point Value and Incorrect 
Point Value. Find more information about 
modifying settings in Settings on page 189.
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Step by Step Instructions To clear the values for a presentation…

1 From the TurningPoint 
toolbar select, Tools > 
Settings.

This displays the Settings Window.

Settings Window

2 Select Presentation from the 
Settings Hierarchy.

This displays the available presentation settings and the 
Restore default presentation settings button.

Settings Window: Restore default presentation settings
button



110 Turning Technologies

Chapter 3: Creating and Saving Slides

3 Select the Restore default 
presentation settings button.

This displays a box warning that all settings will be restored 
back to the default state.

Restore default presentation settings Warning

4 Select Yes to clear answer 
values. 

TurningPoint resets all of your answer values to the default 
values. 

Select No if you do not wish to reset all of the settings back to 
the default state.

5 Select the Done

Find information for setting Correct or Incorrect values in 
Identify a Correct Answer from the Settings Window on 
page 89 or Identify a Correct Answer on a TurningPoint 
Slide on page 92.

Find information for setting point values in Set Point Values 
from the Settings Window on page 97 or Set Point Values 
on a TurningPoint Slide on page 103.

Note To clear an answer value, you can also set 
No Value in the Answer Value setting, a 
slide-level setting for each answer. Find more 
information about modifying settings in 
TurningPoint Device and Settings 
Management on page 153.
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Clear Answer Values on a TurningPoint Slide

If you wish to reset answer values, you can clear the value from one or all answers.

Step by Step Instructions To clear the values for an answer…

1 Navigate to the slide on 
which you want to clear 
answer values.

2 Place your cursor in the 
Answer region of the slide.

An Answer Values Task Pane appears listing all of the answers 
and current answer values. 

Answer Values Task Pane



112 Turning Technologies

Chapter 3: Creating and Saving Slides

3 Select the Clear Answer 
Values box. 

Answer Values Task Pane: Clear Answer Values

The answer values for all answers on the slide are set to No 
Value.

Find information for setting Correct or Incorrect values in 
Identify a Correct Answer from the Settings Window on 
page 89 or Identify a Correct Answer on a TurningPoint 
Slide on page 92.

Note To clear an answer value, you can also set 
No Value in the Answer Value setting, a 
slide-level setting for each answer. Find more 
information about modifying settings in 
TurningPoint Device and Settings 
Management on page 153.
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Find information for setting point values in Set Point Values 
from the Settings Window on page 97 or Set Point Values on 
a TurningPoint Slide on page 103.

Use Speed Scoring

Speed scoring awards points proportionally based on how quickly a participant responds. Any slide 
with correct or point-value answers marked can be used for speed scoring.

If you use speed scoring, a participant receives all the points for a answer when responding correctly 
before the countdown begins. When the countdown begins, the points a participant is awarded are 
scaled proportionally by the amount of time remaining. In a 10-second countdown, a response with 5 
seconds remaining is awarded half (5/10) the points. Below are two examples.

Example 1: Answer A is given a point value of 10 points. When polling opens, if the participant selects 
answer A immediately they will receive 10 points. As the countdown timer counts down from 10, the 
point value decreases. If the participant selects answer A with 5 seconds left, they receive 5 points. If 
the participant does not select answer before the timer hits zero they receive no points.

Example 2: Answer B is given a point value of -10 points. When polling opens, if the participant 
selects answer B immediately they will receive -10 points. As the countdown timer counts down from 
10, the point value decreases. If the participant selects answer B with 5 seconds left, they receive -5 
points. If the participant does not answer before the timer hits zero they receive no points.

Before You Begin

To use speed scoring, you should set points for one or more answers on the slide. Find information on 
setting points in Set Point Values from the Settings Window on page 97 or Set Point Values on a 
TurningPoint Slide on page 103.

You must use a Countdown indicator to use speed scoring. Find more information in Add a 
Countdown Indicator on page 132.
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Step by Step Instructions To use speed scoring…

1 Open the Settings window 
from the TurningPoint toolbar 
by selecting Tools > Settings. 
(Hint: It’s the one that looks 
like a pair of eyeglasses.)

The Settings window opens. 

Settings Window

2 If it is not already selected, 
select the slide on which you 
would like to enable speed 
scoring from the Settings 
Hierarchy.
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3 Select Speed Scoring under 
the Misc header. 

A drop-down menu will appear next to the value for the Speed 
Scoring setting,.

 Settings Window: Speed Scoring

4 Select True from the menu to 
enable speed scoring.

Select False to disable speed scoring.

5 Select the Done button in the 
Settings window to save your 
changes.

Create Picture Slides

Instead of using textual answers in the answer region, you can use pictures. This is useful if you pose 
a question with visual responses or where a visual aid will help the audience choose.
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Step by Step Instructions To create a picture slide…

1 Create a TurningPoint slide. It is recommended that you use descriptive words or phrases 
for the answer text in the answer region because this text will 
still be used for the chart labels, even though the text in the 
answer region will be replaced by pictures.

Find more information on creating a slide in Insert a Slide on 
page 51.

2 Insert pictures to use as 
answers using the options in 
PowerPoint’s Insert > Picture 
menu.

Insert one picture for each answer.

Find more information on inserting pictures in PowerPoint’s 
online help.

3 Resize and arrange the 
pictures the way you want 
them to appear on the slide.

Select and drag the picture to reposition it. Select one of the 
side or corner handles and drag to resize the picture. Find 
more information in PowerPoint’s online help.

Note Since you’ll be using pictures as answers, 
the horizontal and offset charts will not align 
correctly with the answers. Use a vertical, 3D 
pie, distributed pie, or doughnut chart. Find 
more information in Types of Slides on 
page 56.
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4 To order the pictures 
correctly with the answers, 
follow these steps:

a First, ensure that no 
objects on the slide are 
selected by clicking 
outside the slide.

b Select the picture that 
corresponds to the first 
answer by clicking on it.

You can tell that the picture is selected when the resize 
handles are shown on its sides and corners.

c Select the picture that 
corresponds to the second 
answer by holding the 
Control key on your 
keyboard and clicking on 
the picture.

Now both the first and second picture are selected.

d Repeat step c for each 
additional picture until you 
have selected one for each 
answer.

5 Select the Convert to Picture 
Slide button from the 
TurningPoint toolbar. (Hint: 
It’s the one that looks like an 
artist’s palette.)

Convert Picture Slide Button

Note You may include pictures on your slide that 
are not associated with one of the answers 
(for decoration or illustration). Do not select 
these pictures.
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When you select the Convert to Picture Slide button, the 
answer region is hidden and the pictures are enumerated with 
a label, according to the answers you assigned them.

Picture Slide

After you convert the answers to pictures, you can still resize 
and arrange the pictures if you need to adjust them.

Additionally, you can identify a correct answer or set point 
values. Find more information in Identify a Correct Answer 
from the Settings Window on page 89 or Identify a Correct 
Answer on a TurningPoint Slide on page 92and Set Point 
Values from the Settings Window on page 97 or Set Point 
Values on a TurningPoint Slide on page 103.

Change Chart Colors

The colors used by charts are defined in the TurningPoint settings. By default, the charts take on 
the colors defined in your PowerPoint presentation’s color scheme. 

Note Chart settings will retain any modifications 
you make, even after you add or remove 
answers on the modified chart slides.
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Step by Step Instructions To change chart colors…

1 Open the Settings window 
from the TurningPoint toolbar 
by selecting Tools > Settings 
(Hint: It’s the one that looks 
like a pair of eyeglasses.)

The Settings window opens.

Settings Window

2 Select the All Settings radio 
button.

This displays all of the Chart Color settings.

Settings Window: All Settings
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3 Select Presentation or a Slide 
from the Settings Hierarchy 
to specify whether you’d like 
to make changes to chart 
colors on the presentation 
level or slide level.

The level at which you change the settings controls which 
slides are affected:

• Making changes at the presentation level affects all 
slides you create in the future and modifies all slides in 
the current presentation.

• Making changes on the slide level affects only the slide 
you select.

If you make changes on the slide level, you must select the 
slide you wish to be affected from the Settings Hierarchy.

4 Locate the Chart Colors 
setting in the Chart Settings 
group and select it.

A downward arrow will appear next to the value for the Chart 
Colors setting, indicating that you can select a value for the 
setting from a drop-down menu.

Chart Colors Setting

5 Select a value for the Chart 
Colors setting.

There are three options:

• Color Scheme, which uses the color scheme of your 
PowerPoint presentation.
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• User Defined, which uses ten user-defined colors.

• Correct Incorrect, which uses two user-defined colors, 
one for correct answers and one for incorrect. (The 
default colors for correct and incorrect are green and red 
respectively.) 

Note When Color Scheme is selected, PowerPoint 
reverses the color order for Horizontal and 
Offset Charts. Example: If your color scheme 
has Light Blue, Blue, Aqua, and Green with 
Light Blue as the first color to be displayed 
and Green as the last, PowerPoint will 
display the colors in reverse for Horizontal 
and Offset Charts. Green is the first color 
displayed and Light Blue is the last.
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6 If you chose to use User 
Defined or Correct Incorrect, 
specify the colors to use by 
completing the following 
steps:

a Select Chart Color 1 
through Chart Color 10 or 
Chart Color Correct/Chart 
Color Incorrect from the 
Settings window.

The Select Chart colors pop-up window opens:

Settings Window Chart Colors

b Select one of the colors 
labeled 1–10 or Correct 
and Incorrect.

A grid of 40 color swatches you can choose from is 
displayed.

Color Swatches

c Select a color from the 
swatches.

The grid of swatches closes and the color is assigned.

To change all colors back to their defaults, select the 
Defaults button.



TurningPoint User Guide 123

Modify Slides

d Repeat steps b–c for all 
colors you would like to 
change.

e Select the Done button to 
save the changes to the 
colors.

7 Select the Done button in the 
Settings window to save your 
changes.

If you made changes to the presentation-level setting, all slides 
in your presentation will reflect the new colors, as will any new 
slides you create. 

If you made changes to the slide-level setting, the slide you 
selected will reflect the new colors.

Make a PowerPoint Slide Interactive by Inserting a Chart

You can make an ordinary PowerPoint slide interactive by adding a chart to a slide that already has a 
question and a list of answers.

Create one or more slides in PowerPoint with a title and a bulleted or numbered list.

When you convert the slide to a TurningPoint slide using the following instructions, the title will 
become the question and the bulleted or numbered list will become the list of answers. You can 
include up to ten answers.
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Step by Step Instructions To convert a PowerPoint slide to an interactive slide…

1 Navigate to the PowerPoint 
slide in your presentation that 
you would like to convert to a 
TurningPoint slide.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu
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3 Select Charts to display the 
Charts submenu.

A list of available charts is displayed.

Insert Object: Chart Selection

4 Select a chart to add to the 
slide.

Find more information on chart types in Chart Slides on 
page 57.

When you select the chart to be added, TurningPoint converts 
the title of your slide to the question, the bulleted or numbered 
list to the answers, and adds the chart to the slide. 

You now have a functioning TurningPoint slide.

Note The bulleted or numbered answer list is re-
numbered according to your TurningPoint 
settings. 
You can modify the numbering scheme for 
answers in the Answer Bullet Type setting, a 
presentation-level setting. Find more 
information about modifying settings in 
TurningPoint Device and Settings 
Management on page 153.
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Disable Auto Scale in Charts

When you insert a slide in TurningPoint, vertical charts are set to auto scale according to their 
percentages. You can make vertical charts appear more realistic by disabling the Auto Scale Charts 
setting.

Step by Step Instructions To disable Auto Scaling...

1 In the TurningPoint toolbar, 
select Tools > Settings (Hint: 
it looks like a pair of 
eyeglasses).

Settings Window
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2 Select the Presentation from 
the Settings Hierarchy.

3 Under the Chart Settings 
heading, select Auto Scale 
Charts.

A drop-down menu appears to the right.

Auto Scale Setting

4 Select False from the drop-
down menu.

Auto Scale has been disabled. 

Charts that you insert from this point will not Auto Scale. 

Next Steps

To enable Auto Scale, repeat steps 1 through 3 and select True from the drop-down menu.
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Add Objects

TurningPoint offers several special objects you can add to your slides: Answer Now Indicator, 
Countdown Indicator, Countdown Sound, Response Counter, Response Table, Correct Answer 
Indicator, Text Messaging, Statistics Indicators. 

Insert Object Menu

TurningPoint visually identifies when an animated indicator has been used. When PowerPoint is in 
Normal view mode, a pane containing both Outline and Slides tabs is visible. If the Slides tab is 
selected, a Play Animations button is displayed adjacent to the thumbnail of the slide containing the 
indicator. Clicking on the Play Animations button causes the indicator to perform its animation on 
the slide.

This section describes how to:

• Add an Answer Now Indicator 

• Add a Countdown Indicator

• Add Countdown Sound to a Countdown Indicator

• Add a Response Counter

• Add a Response Table

• Add a Correct Answer Indicator

• Add Text Messaging

• Add Statistics Indicators
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Add an Answer Now Indicator

An Answer Now indicator gives the audience a visual cue that the slide is a TurningPoint slide to 
which they have the opportunity to respond. An Answer Now indicator appears during a presentation 
when polling opens and disappears when polling is closed. 

Answer Now Indicators are available in 12 styles.

Answer Now Indicators

Note You can specify that an Answer Now 
indicator should appear automatically on 
each TurningPoint slide that you create using 
the Answer Now setting, a presentation-level 
setting. Find more information about 
modifying settings in TurningPoint Device 
and Settings Management on page 153.

 Bevel  Left Explosion

 Right Explosion  Scroll

 Bolt  Prompt

 Moon  Sun

 Banner  Marquis

 Smiley  Twilight
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The Answer Now indicator can be moved and resized like an ordinary PowerPoint object. You can 
change the text “Answer Now” by selecting the text to edit it.

Step by Step Instructions To add an Answer Now indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add 
an Answer Now indicator.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu
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3 Select Answer Now to display 
the submenu of Answer Now 
indicators.

Answer Now Submenu

4 Select the type of Answer 
Now indicator you would like 
to appear on the slide.

When you select the Answer Now indicator, TurningPoint 
places it on your slide.

You can move, resize, or change the text of the Answer Now 
indicator to better fit your slide. You can also delete the Answer 
Now indicator if you no longer want it to appear on the slide.

To replace an existing Answer Now indicator with a different 
type, simply repeat these steps. The current Answer Now 
indicator will be replaced with the new one you select.

Note You can change the default text of Answer 
Now indicators when they are added to a 
page from “Answer Now” to any text of your 
choosing using the Answer Now Text setting, 
a presentation-level setting. Find more 
information about modifying settings in 
TurningPoint Device and Settings 
Management on page 153.
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Add a Countdown Indicator

A Countdown indicator gives the audience a visual cue that polling for a question is about to close. 
The Countdown indicator shows the number of seconds remaining and counts down to zero. A 
countdown can have a maximum length of 999 seconds. The indicator appears during a 
presentation when you advance the slide during polling. When the countdown expires, the 
Countdown indicator disappears and polling is automatically closed.

You can specify that a Countdown indicator should appear automatically on each TurningPoint slide 
that you create using the Countdown setting, a presentation-level setting. Find more information 
about modifying settings in TurningPoint Device and Settings Management on page 153.

Countdown indicators are available in 11 styles.

Countdown Indicators

 Ball Drop  Letter

 Clock  Hourglass

 Timer  Candle

 Sunset  No Vote

 Logo  Second Hand

 Gemstone
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Step by Step Instructions To add a Countdown indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add 
an Countdown indicator.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu



134 Turning Technologies

Chapter 3: Creating and Saving Slides

3 Select Countdown to display 
the submenu of Countdown 
indicators.

Countdown Indicator Submenu

4 Select the type of Countdown 
indicator you would like to 
appear on the slide.

When you select the Countdown indicator, TurningPoint 
places it on your slide.

You can move or resize the Countdown indicator to better fit 
your slide. You can also delete the Countdown indicator if you 
no longer want it to appear on the slide.

Note You can change the length of the countdown 
in seconds for a particular slide or for all 
slides using the Countdown Seconds setting, 
a setting available on both the presentation 
level and the slide level. Find more 
information about modifying settings in 
TurningPoint Device and Settings 
Management on page 153.
You can also change the length of the 
countdown by double-clicking the number on 
the Countdown indicator on the slide. A 
dialog box appears prompting you to ‘enter a 
value 1-999 for the Countdown time limit.’
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To replace an existing Countdown indicator with a different type, 
simply repeat these steps. The current Countdown indicator will 
be replaced with the new one you select.

You can also use Countdown indicators in competition to award 
points based on how quickly a participant responds. Find more 
information in Add a Countdown Indicator on page 132.

Add Countdown Sound to a Countdown Indicator

A Countdown Sound is a TurningPoint setting that allows you to add sound file to your slide. The 
acceptable file extensions include: .aiff, .au, .mid, .midi., .mp3, .wav, and .wma. A Countdown Sound 
gives the audience an audible cue that polling for a question is about to close. The sound begins to 
play when you activate the Countdown Indicator. 

Your slide must have a Countdown Indicator to use a Countdown Sound. To add a Countdown 
Indicator see to Add a Countdown Indicator on page 132 

Step by Step Instructions To add a Countdown Sound…

1 From the TurningPoint 
Toolbar, select Tools > 
Settings (Hint: It’s the one 
that looks like a pair of 
eyeglasses).

TuringPoint displays the Settings window.
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2 Select the Settings Tab.

3 From the Settings Hierarchy, 
select the slide you want to 
add a Countdown Sound to.

Settings Window

All the settings available for that slide are displayed in the right 
pane of the settings window. Find the Response Reminders 
Settings header.

4 Under Countdown Sound, 
click on the word None.

This opens a folder window.

Settings Window: Countdown Sound
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5 Navigate to the folder where 
the sound file you want to use 
is located

Countdown Sound: Windows Dialog Box

6 Select the file name.

7 Select Open. The file path where the wav or mp3 file is located on your 
computer is now listed.

8 Select Done. If your presentation will be used on a computer different from 
the one you created it on, ensure that the Countdown Sound 
(sound file) can be found on the presentation computer and that 
it has the same file path. For example, if the file path for the 
Countdown Sound is c:\Documents and Settings\My 
Documents\Explosion.wav. You must ensure that the 
Countdown Sound is located at the same file path on the 
presenting computer or you must go into settings and change 
the location by strating this procedure at step 1.
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Add a Response Counter

A Response Counter keeps track of how many participants have submitted a response out of the 
total number of participants. A Response Counter appears during a presentation when polling 
opens and disappears when polling is closed.

Response Counters are available in six styles:

Response Counters

 Flag Pole  Meter

 Bubble  Gauge

 Liquid  Tube
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The Response Counter can be moved and resized like an ordinary PowerPoint object. 

Step by Step Instructions To add a Response Counter…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Response Counter.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu

Note You can change whether the Response 
Counter displays the number or percentage 
of participants who have responded (or both) 
using the Response Counter Format setting, 
a presentation-level setting. Find more 
information about modifying settings in 
TurningPoint Device and Settings 
Management on page 153.
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3 Select Response Counter to 
display the submenu of 
Response Counters.

Response Counter Submenu

4 Select the type of Response 
Counter you would like to 
appear on the slide.

When you select the Response Counter, TurningPoint places 
it on your slide.

You can move or resize the Response Counter to better fit 
your slide. You can also delete the Response Counter if you 
no longer want it to appear on the slide.

To replace an existing Response Counter with a different 
type, simply repeat these steps. The current Response 
Counter will be replaced with the new one you select.

Note You can specify that a Response Counter 
should appear automatically on each 
TurningPoint slide that you create using the 
Response Counter setting, a presentation-
level setting. Find more information about 
modifying settings in TurningPoint Device 
and Settings Management on page 153.
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Add a Response Table

A Response Table keeps track of which participants have submitted a response. A Response Table 
appears during a presentation when polling opens and disappears when polling is closed. The 
Response Table shows each participant’s number, and a background color that changes when a 
response from the participant has been successfully received.

The Response Table is available in two types, fixed and rotating. A fixed table shows all the 
participants. A rotating table displays up to 40 participants at a time, and rotates through the list every 
few seconds. It shows participants 1–40, then 41–80, and so on. When it reaches the last participant, 
the next rotation starts again with 1. A rotating table takes up less space on your slide if you have 
more than 40 participants.

Response Table

The Response Table can be moved and the font can be changed like an ordinary PowerPoint object. 

Note You can specify the rotation interval in 
seconds for a rotating Response Table using 
the Rotation Interval setting, a presentation-
level setting. Find more information about 
modifying settings in TurningPoint Device 
and Settings Management on page 153.
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Step by Step Instructions To add a Response Table…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Response Table.

Insert Object Menu

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

3 Select Response Table to 
display the submenu of 
Response Tables.

Response Table Submenu
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4 Select the type of Response 
Table you would like to 
appear on the slide (fixed or 
rotating).

See above for information on the differences between fixed and 
rotating Response Tables.

When you select the Response Table, TurningPoint places it on 
your slide.

You can move the Response Table and change the font it uses 
to better fit your slide. You can also delete the Response Table 
if you no longer want it to appear on the slide.

To replace an existing Response Table with a different type, 
simply repeat these steps. The current Response Table will be 
replaced with the new one you select.

As an alternative to a Response Table, TurningPoint also offers 
the Response Grid, which is overlaid on your slide during a 
presentation and can be shown and hidden at your command. 
The Response Grid shows more information than a Response 
Table and does not take up space on your slide, but you must 
manually choose to display and hide it during your presentation. 
Find more information in View Polling Status on page 328.

Add a Correct Answer Indicator

A Correct Answer indicator gives a visual cue to the audience to indicate the correct answer(s) after 
polling for a question is finished. A Correct Answer indicator appears during a presentation when you 
advance the slide after displaying the chart.

A Correct Answer indicator appears for each answer marked as Correct or for which a point value is 
specified. Find more information in Identify a Correct Answer from the Settings Window on page 89 
or Identify a Correct Answer on a TurningPoint Slide on page 92.

Note You can specify that a Response Table 
should appear automatically on each 
TurningPoint slide that you create using the 
Response Table setting, a presentation-level 
setting. Find more information about 
modifying settings in TurningPoint Device 
and Settings Management on page 153.
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Correct Answer indicators are available in seven styles.

Correct Answer indicators

 Rectangle  Checkmark

 Smiley Face  Star

 Arrow  Blinking Rectangle

 Custom Indicator



TurningPoint User Guide 145

Add Objects

Step by Step Instructions To add a Correct Answer indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Correct Answer indicator.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu
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3 Select Correct Answer 
Indicator to display the 
submenu of Correct Answer 
Indicators.

Correct Answer Submenu

4 Select the type of Correct 
Answer indicator you would 
like to appear on the slide.

When you select the Correct Answer indicator, TurningPoint 
places it on your slide.

You can delete the Correct Answer indicator if you no longer 
want it to appear on the slide.

To replace an existing Correct Answer indicator with a 
different type, simply repeat these steps. The current Correct 
Answer indicator will be replaced with the new one you select.

Add Text Messaging

Text Messaging, which allows you to send messages to vPad users to reinforce the content and 
their participation.

 A Text Message appears as a small object on your slide, but when it is shown, it automatically 
sends a message that can be viewed on vPad.
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You can add more than one text message to a slide. For example, you might add a “Respond Now” 
message to send when polling opens and a “Time Is Up” message to send when polling closes. 

Step by Step Instructions To add a Text Message…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Text Message.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu

Tip Since Text Messages are objects on your slide, 
you can use PowerPoint’s animation features 
to time when they should be displayed. Find 
more information in PowerPoint’s online help.
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3 Select Text Message. A dialog box appears asking you to enter the text of the 
message.

Text Message Dialog Box

4 Type your message in the 
dialog box and select the OK 
button.

A speech balloon displays in the upper left corner of the slide. 
When TurningPoint is running the presentation session, this 
symbol notifies the participants in the audience to check their 
vPads for a text message. 

Slide with Text Message

You may now alter the timing of the message using 
PowerPoint’s animation features. By default, the message is 
sent as soon as the slide is shown.

You can delete the Text Message object from the slide if you 
no longer want it to be sent. To add an additional Text 
Message, simply repeat these steps.
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Add Statistics Indicators

Statistics indicators, which allow you to reveal statistics about the responses after polling is closed.

Statistics indicators show a calculation after polling is closed based on the responses received. You 
can show the mean (average), median, standard deviation, and variance of the responses. The value 
of the statistic is revealed when the chart is displayed.

Statistics Indicators

Statistics are calculated based on the numerical value of the response (the number of the answer on 
the slide). Since the statistics are based on the number of the answer, they are most useful for 
questions with an ordered scale of answers (such as a Likert scale).
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Step by Step Instructions To add a Statistic indicator…

1 Navigate to the TurningPoint 
slide in your presentation to 
which you would like to add a 
Statistic indicator.

2 Select Insert Object from the 
TurningPoint toolbar.

The Insert Object menu opens.

Insert Object Menu
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3 Select Stats to display the 
submenu of Statistic 
indicators.

Statistics Submenu

4 Select the type of Statistic 
indicator you would like to 
appear on the slide.

When you select the Statistic indicator, TurningPoint places it 
on your slide.

You can move or resize the Statistic indicator to make it better 
fit your slide. You can delete the Statistic indicator if you no 
longer want it to appear on the slide.

You can add additional Statistic indicators to the same slide (up 
to all four types). Simply repeat these steps and select the 
additional Statistic indicator you would like to place on the slide.
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Where Do I Go From Here?

This chapter has demonstrated how to create and customize TurningPoint slides for your 
presentation.

The next step in successfully using TurningPoint for an interactive presentation is to set up the 
hardware devices for participants to respond. Chapter 4: TurningPoint Device and Settings 
Management demonstrates this process. You only need to install hardware devices once on the 
computer you will use them with, unless you add or change the hardware devices.

If you have already install hardware devices, the next step is to create a Participant List to keep 
track of the participants for your presentation. Chapter 5: Track Participants and Teams 
demonstrates this process.

If you already have a Participant List for the audience you will be presenting to, you are ready to 
conduct your presentation! Chapter 7: Run Presentations demonstrates this process.
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Device and 
Settings 
Management

This chapter discusses the installation and management of the Response Devices available for use 
by your audience. Additionally, this chapter describes the various settings available for customizing 
your presentation.

Your audience responds to your interactive presentation using a response device. You can license 
response devices from Turning Technologies for use with TurningPoint. These response devices 
include:

Response Device Description

Response Innovations’ 
ResponseCard IR—a compact 
response device that uses infrared 
technology to send audience 
responses.
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Responsive Innovations’ 
ResponseCard XL—a compact 
response device that uses infrared 
technology to send audience 
responses and allows for self-paced 
testing by letting students enter 
responses to many different 
questions on the card’s LCD then 
transmitting all the answers at once.

Responsive Innovations’ 
ResponseCard RF—a compact 
response device that uses radio 
frequency technology to send 
audience responses.

Response Innovations’ 
ResponseCard XR —a compact 
response device that uses radio 
frequency technology to send 
audience responses and allows for 
self-paced testing by letting 
students enter responses to many 
different questions on the card’s 
multi-line LCD then transmitting all 
the answers at once.

Turning Technologies’ vPad group 
response software application—a 
virtual keypad, installed on a 
personal computer, and Smart 
Devices, that takes advantage of a 
classroom network to send 
responses or control presentations. 
vPad also allows for self-paced 
testing by letting students enter 
responses to many different 
questions and then transmitting all 
the answers at once.

Response Device Description
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TurningPoint also offers many settings you can use to customize the way your slides look and 
behave. You may notice that sections throughout this user guide mention settings that can have an 
effect on the tasks you perform with TurningPoint. 

vLinks is a software program that 
allows remote and/or multi-site 
polling using an IP address. 
Participants using Response Device 
Receivers can use vLinks to 
connect to a host computer and 
transmit their responses to the 
presentation over the internet. Find 
more information about vLinks at 
www.turningtechnologies.com.

Turning Technologies’ Web vPad —
a virtual keypad, installed on a 
personal computer or Smart Device, 
allows a user to log into a web site, 
select a session and send their 
responses over the internet. 

Response Device Description
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Recall the five steps to presentation success:

Five Steps to Success

This chapter covers the second step, connecting response devices with TurningPoint’s Plug and 
Play capabilities and managing your settings. 
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Install Devices

Users interact with your TurningPoint presentation using response devices that communicate through 
a response device receiver, or over a network or the internet. 

Response device receivers are connected directly to the computer that will be used to run the 
TurningPoint interactive presenation.This section includes instructions to install the device receivers.

The vPad response device software application allows users to participate with your presentation 
through an internal network. The vPad response software application has two versions: the client 
vPad and Presenter vPad. The client vPad allows participants to respond to your presentation. The 
Presenter vPad enables the presenter to control the presentation from a computer on the same 
network. This section includes instructions to install the vPad software. 

The Web vPad virtual keypad utilizes the internet to allow audience participants to respond to the 
interactive presentation. This section informs presenters what information they need and where to 
obtain it to use Web vPad.

This section describes how to:

• Install RF Response Device Receiver

• Install IR Response Device Receiver

• Install the vPad Response Software

• Obtain the Web vPad Response Device Settings
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Install IR Response Device Receiver

The ResponseCards IR and XL communicate with TurningPoint using infrared technology. The 
receiver accepts the signal produced by the individual response cards and passes the response 
along to TurningPoint.

IR Response Card and Receiver

Before You Begin

The receiver must be installed on the machine that will be used to run the presentation.

Step by Step Instructions To install the IR response card receiver…

1 Connect the receiver to the 
USB port of the presentation 
computer.

Windows detects the receiver and installs the proper drivers. 

2 Place the receiver in an 
unobstructed area at the front 
of the room.

The receiver operates on a “line of sight” and needs to be 
positioned so that it can receive the signal from the response 
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devices. You may want to elevate the receiver so that it can be 
seen by everyone in the room.

Next Steps

Go to Response Device Management on page 171 to manage the settings for the response devices. 

If an audience member’s device is not being accepted, check the device’s ability to communicate.

Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. (Hint: it’s the one 
that looks like a pair of 
eyeglasses.) 

TurningPoint displays the Settings window. 

Note The effective range of an infrared device 
receiver is about 90 feet (27meters). You will 
need to install one receiver for every 80 
participants.
Use more than one receiver during your 
presentation if your room size or participant 
size exceeds these maximum specifications. 
Contact Turning Technologies for suggested 
receiver layout plans.
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2 Select the Polling Test Tab. TurningPoint displays the Polling Test screen. Use this screen 
to verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. You can magnify the responses by placing 
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, an entry for each 
response device, in the order in which they were tested, and the 
key number pressed on each response device.

Polling Test: Response Device Test

5 Select the End Test button. This action ends the Polling test. 

6 Select the Done button. The device communication check is now complete. 
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Install RF Response Device Receiver

The ResponseCards RF and XR communicate with TurningPoint using a radio frequency. The 
receiver accepts the signal produced by the individual response cards and passes the response 
along to TurningPoint.

RF Response Card and Receiver

Before You Begin

The receiver must be installed on the machine that will be used to run the presentation.

Step by Step Instructions To install the RF response card receiver…

1 Connect the receiver to the 
USB port of the presentation 
computer.

Windows detects the receiver and installs the proper drivers. 
Your response devices are now ready to be used. 

Note the effective range of a ResponseCard RF is 
about 200 feet (60 meters) and the 
ResponseCard XR is about 400 feet (120 
meters). A single receiver is sufficient for up to 
1000 keypads, and a direct line of sight 
between the receiver and the keypad is not 
necessary.
Use more than one receiver during your 
presentation if your room size or participant 
size exceeds these maximum specifications. 
Contact Turning Technologies for suggested 
receiver layout plans.
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Next Steps

Go to Response Device Management on page 171 to manage the settings for the response devices. 

If an audience member’s device is not being accepted, check the device’s ability to communicate.

Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. (Hint: it’s the one 
that looks like a pair of 
eyeglasses.) 

TurningPoint displays the Settings window. 

2 Select the Polling Test Tab. TurningPoint displays the Polling Test screen. Use this screen 
to verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test
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3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. You can magnify the responses by placing 
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses

4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, an entry for 
each response device, in the order in which they were tested, 
and the key number pressed on each response device.

Polling Test: Response Device Test

5 Select the End Test button. This action ends the Polling test. 

6 Select the Done button. The device communication check is now complete. 
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Install the vPad Response Software

The vPad group response software acts as a virtual response device. Audience members use the 
software from desktop or laptop computers or PDAs that are connected to the presentation computer 
using a direct or wireless network.

vPads exhibit the same response behavior as ResponseCards. If you are running a vPad and connect 
during a presentation, you can close and reopen the vPad and still have the same response device 
number.

vPad Response Device

Before You Begin

TurningPoint must be installed on computers that use the same 
network.

Step by Step Instructions To install and set up the vPad software on a PC…

1 Insert the vPad installation 
CD into your computer’s CD-
ROM drive.

2 Run the vPad setup program. Follow the instructions in the vPad setup wizard to install vPad 
on your desktop or laptop computer. The installation creates a 
vPad desktop icon and an entry in your computer’s Start > 
Programs menu.



166 Turning Technologies

Chapter 4: TurningPoint Device and Settings Management

3 Double click on the vPad 
desktop icon to start the vPad 
software.

The Turning vPad window opens.

You need to configure vPad to enable it to communicate on 
the network.

4 On the Turning vPad window, 
select File > Select Host 
Computer.

The Select a Host Computer window opens.

vPad: Select A Host Computer

5 Select the Add button. The Turning vPad dialog box opens and displays the friendly 
name setup prompt. 

vPad: Enter Friendly Computer Name
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6 In the Turning vPad window, 
enter the computer’s friendly 
name or IP address and 
select OK.

The Turning vPad dialog box displays the port number setup 
prompt.

vPad: Enter Port Number

7 In the Turning vPad window, 
enter the port number to be 
used for communication 
between the vPad and 
TurningPoint and select OK.

Turning vPad uses port 1001 by default. Enter a different 
number, if defined otherwise on the host computer.

The newly added host computer appears in the Select a Host 
Computer window.

8 In the Select a Host 
Computer window, select 
OK.

Turning vPad displays a dialog box asking to connect to the 
selected host.

9 In the TurningPoint 
connection dialog box, select 
OK.

The Turning vPad window displays a message: Connected to 
mylaptop at 2:30:21 PM. 

Your computer’s friendly name (entered in step 6) and the time 
when you connected (as a result of completing this step) are 
displayed in place of the words above.

10 Repeat steps 1-9 for each 
computer to be used as a 
response device.

Next Steps

Go to Response Device Management on page 171 to manage the settings for the response devices. 
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If an audience member’s device is not being accepted, check the device’s ability to communicate.

Step by Step Instructions To Check Device Communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. (Hint: it’s the one 
that looks like a pair of 
eyeglasses.) 

TurningPoint displays the Settings window. 

2 Select the Polling Test Tab. TurningPoint displays the Polling Test screen. Use this screen 
to verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. You can magnify the responses by placing 
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, an entry for each 
response device, in the order in which they were tested, and the 
key number pressed on each response device.

Polling Test: Response Device Test

5 Select the End Test button. This action ends the Polling test. 

6 Select the Done button. The device communication check is now complete. 
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Obtain the Web vPad Response Device Settings
The Web vPad response device acts as a virtual response device. Audience members use Web 
vPad from desktop or laptop computers or PDAs that access your Web vPad Server URL.

Web vPads exhibit the same response behavior as ResponseCards and vPad. If you are using Web 
vPad and connect during a presentation, you can close and reopen the Web vPad and still have the 
same response device number.

In order to use the Web vPad during for your presentation, you must obtain the following information 
from TurningTechnologies Customer Support:

• Web vPad Server URL

• Web vPad Server Username

• Web vPad Session Name

• Web vPad Access Code

Go to Response Device Management on page 171 to manage the Web vPad settings.
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Response Device Management

Each audience participant uses a device to respond to the questions asked during the presentation. 
TurningPoint supports a variety of response devices including infrared and radio frequency keypads 
as well as networked PDAs, laptops, and desktops and laptops and desktops with internet access.

TurningPoint needs to know what types of response devices will be used before you run the 
presentation. Access the Response Device settings to confirm TurningPoint is configured to your 
needs. 

You may need to confirm your settings when you add new response devices and change the number 
of response devices to be used during a presentation session.

Additionally, you are able to test communication between TurningPoint and the response devices 
using the Polling Test found in settings.

This section describes how to:

• Manage Response Device Settings

• Update the Number of Devices Used

• Add New Device Types

• Check Device Communication

Manage Response Device Settings

Use the Response Device settings to confirm TurningPoint is configured according to your needs. 

Before You Begin

You must have TurningPoint installed on the computer to be used for the presentations, the device 
receivers connected, vPad installed (if using the virtual response device software), Web vPad 
settings, and the response devices available for testing. 
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Step by Step Instructions To manage the response devices…

1 Access the settings window 
from the TurningPoint 
Toolbar, select Tools > 
Settings. (Hint: it’s the one 
that looks like a pair of 
eyeglasses.) 

This displays the Settings window. 

Settings Window

2 Select the Settings Tab. 

3 Select Response Device 
from the Settings Hierarchy.

All response device settings are listed in the right pane of the 
Settings window.



TurningPoint User Guide 173

Response Device Management

4 Enter the number of expected 
response devices. 

Settings Window: Expected Devices

You are only required to enter the number of expected devices 
when using Simulated Data or a Response Counter or 
Response Table.

a Click on the number of 
devices currently entered.

This opens a text box allowing you to enter a numeric 
value.

b Enter the number of 
expected devices.

c Select done.  If you are using only USB devices, skip to step 12. If you 
are using only vPad devices, go to step 5. If you are using 
only Web vPad devices, skip to step 6. 

Note You cannot exceed the number of licensed 
devices. For example, if you enter the number 
of expected devices as 60 in this region, but 
TurningPoint is licensed for 50 devices, only 50 
devices can be used during the presentation.

Note TurningPoint limits the number of response 
devices that will be displayed in a Response 
Counter or on a Response Table based upon 
the number of expected devices entered. 
Find more information on Response Counters 
in Add a Response Counter on page 138 and 
Response Tables in Add a Response Table on 
page 141.
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d HIt the Enter key.  If you are using only USB devices, skip to step 12. If 
you are using only vPad devices, go to step 5. 

5 If you are using the vPad 
software, enable the vPad.

a Select Enable 
vPad/vLinks.

This displays a drop down menu.

b Change the Enable vPad 
setting from False to True.

Settings Window: vPad Settings

c Select done.  If you are using only vPad devices, skip to step 12. If 
you are using only Web vPad devices, go to step 6. 

Note TurningPoint uses False  as the default 
setting for Enable vPad.
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6 If you are using the Web 
vPad, enable the Web vPad. 

Settings Window: Web vPad Settings

a.  Change the Enable Web 
vPad setting from False to 
True. Note TurningPoint uses false as the default setting 

for Enable Web vPad.
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7 Enter the URL of the Web 
vPad Sever.

a Double click in the blank 
space to the right of URL 
and directly below the 
True/False drop-down 
menu.

This opens a text box in which you can type in the URL 
for the Web vPad Server.

Web vPad Settings: URL
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b Type in the URL.

8 Enter the Username.

a Double click in the blank 
space to the right of 
Username and directly 
below where you entered 
the URL. 

This opens a text box in which you can type in the 
Username for the Web vPad Server.

Web vPad Settings: Username
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b Type in the Username.

9 Enter the Password

a Double click in the blank 
space to the right 
Password and directly 
below where you entered 
the Username.

This opens a text box in which you can type in the 
Password for the Web vPad Server.

Web vPad Settings: Password
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b Type in the Password

10 Enter the Session Name

a Double click in the blank 
space to the right of 
Session Name and directly 
below where you entered 
the Password.

This opens a text box in which you can type in the 
Session Name for the Web vPad Server.

Web vPad Settings: Session Name
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b Type in the Session Name.

11 Enter the Access Code

a Double click in the blank 
space to the right of 
Access Code and directly 
below where you entered 
the Session Name.

This opens a text box in which you can type in the 
Access Code for the Web vPad Server.

Web vPad Settings: Access Code

b Type in the Access Code.

12 Select done. Your devices are ready for use with your interactive 
presentation.

Next Steps

If an audience member’s device is not being accepted, go to Polling Test in Check Device 
Communication on page 185. Additionally go to Update the Number of Devices Used on 
page 181 when you need to make changes to the number or Add New Device Types on page 183 
type of devices being used with your presentations.
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Update the Number of Devices Used

Access the Response Device settings whenever you need to change the number of devices being 
used.

Step by Step Instructions To increase or decrease the accepted responses…

1 From the TurningPoint 
toolbar, select Tools > 
Settings (Hint: it’s the one 
that looks like a pair of 
eyeglasses.)

TurningPoint displays the Settings window. 

Settings Window

2 Select Response Device 
from the Settings Hierarchy.

TurningPoint displays all of the Response Device settings in the 
right pane of the settings window. 
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3 Enter the number of expected 
response devices. 

This setting is found under ResponseCard Misc heading. 

Settings Window: Expected Devices

a Click on the number of 
devices currently entered.

This opens a text box allowing you to enter a numeric 
value.

b Enter the number of 
expected devices.

Note You cannot exceed the number of licensed 
devices. For example, if you enter the number 
of expected devices as 60 in this region, but 
TurningPoint is licensed for 50 devices, only 50 
devices can be used during the presentation.

Note TurningPoint limits the number of response 
devices that will be displayed in a Response 
Counter or on a Response Table based upon 
the number of expected devices entered. 
Find more information on Response Counters 
in Add a Response Counter on page 138 and 
Response Tables in Add a Response Table on 
page 141.
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4 Optionally, test your 
response device 
communication by selecting 
the Polling Test tab from the 
Settings window.

TurningPoint displays the Polling Test screen. If desired, you 
can use this screen to test the communication between 
TurningPoint and the response devices. Find more information 
in Check Device Communication on page 185

5 Select the Done button. The response device setup is now complete.

Add New Device Types

Access the Response Device settings whenever you need to change the number of devices being 
used. Plug the additional device into the computer.

Before You Begin

Ensure the device receiver is properly connected.

Note TurningPoint does not require a polling test be 
performed when changing the device ranges. 
Find polling instructions in the Check Device 
Communication section.
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Step by Step Instructions

1 From the TurningPoint 
toolbar, select Tools > 
Settings. (Hint: it’s the one 
that looks like a pair of 
eyeglasses.) 

TurningPoint displays the Settings window.

Settings Window

2 Select the Settings Tab.  

3 Select Response Device 
from the Settings Hierarchy.

All response device settings are listed in the right pane of the 
Settings window.
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4 Follow the instructions in 
step 4 of Manage Response 
Device Settings on page 171 
to set up your devices.

Check Device Communication

You should test the communication between a device and TurningPoint if an audience member’s 
response is not being accepted during a live presentation.

Before You Begin

Ensure the device receiver is properly installed and the device to be tested is available.

Step by Step Instructions To test for device communication…

1 From the TurningPoint 
toolbar, select Tools > 
Settings. (Hint: it’s the one 
that looks like a pair of 
eyeglasses.) 

TurningPoint displays the Settings window. 
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2 Select the Polling Test Tab. TurningPoint displays the Polling Test screen. Use this screen 
to verify that TurningPoint can receive responses from the 
devices.

Settings Window: Polling Test

For USB and vPad response devices, go to step 3. For Web 
vPad response devices, skip to step 6.

3 Select the Start Test button. TurningPoint is now ready to accept responses from the 
response devices. You can magnify the responses by placing 
a check mark in the box next to Magnify Responses.

Polling Test: Magnify Responses
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4 Press a key on each 
response device to be used.

TurningPoint displays the Device ID, Channel, an entry for each 
response device, in the order in which they were tested, and the 
key number pressed on each response device.

Polling Test: Response Device Test

5 Select the End Test button. This action ends the Polling test. If you are using the Web vPad, 
go to step 6. Otherwise, go to step 7.
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6 Select the Test Web vPad 
button.

If the connection was successful, TurningPoint displays Web 
vPad connected Successfully. Go to step 7

Polling Test: Web vPad Test

If connection was not successful, TurningPoint displays an 
error message. You should check your settings. For more 
help on settings see Obtain the Web vPad Response Device 
Settings on page 170

7 Select the Done button. The device communication check is now complete. 

Next Steps

Return to Check Device Communication on page 185 if an audience member’s response is not 
being accepted during a live presentation or Add New Device Types on page 183 if a new 
response device is being used.
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 Settings

TurningPoint Allows you to view and modify various settings from the Settings window. To access the 
Settings window select Tools from the TurningPoint toolbar and settings. (Hint: It’s the one that looks 
like a pair of eyeglasses.)

Tools > Settings
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You can adjust the settings in the Settings window:

Settings Window

The Settings window contains two tabs: Settings and Polling Test. See Check Device 
Communication on page 185 for more information on Polling Test. 

The Settings tab displays a Settings Hierarchy in the left pane of the Settings window which allows 
you to change the settings for a Response Device, Presentation, Slide or an Answer. In the right 
pane of Settings window are the settings themselves. The settings are grouped by type and listed 
alphabetically. The name of each setting is in the left portion of the right pane and its value is on the 
right. Some settings may allow you to type a value, while others will offer a drop-down menu to 
select from several choices.
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At the bottom of the Settings window is a region that displays a detailed description of a setting when 
you select it. You can use these descriptions or the following pages to learn about the settings. 

Settings Window: Bottom Region

The Common Settings and All Settings Buttons allow you to select your level of customization. The 
Common Button displays the most commonly modified settings. The All Settings Button reveals more 
settings allowing for a more personalized presentation.

The Restore default presentation settings button  allows you to return the settings back to the default 
installation state. 

The Defaults button is active for chart colors on a presentation level only. The button allows you to 
return your chart colors back to the default installation state. 

The Apply All button is active for some chart settings on a presentation level. The button applies and 
saves the setting changes that you made to the all existing applicable slides. 

The section describes:

• Response Device Settings

• Presentation Settings

• Slide Settings

• Answer Settings

The following sections contain information about the settings available by selecting the Settings Tab 
and then selecting one of the following items from the Settings Hierarchy: Response Device, 
Presentation, an individual Slide or an answer. Settings listed in italics can be found by selecting the 
All Settings radio button.
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Response Device Settings
Response Device contains settings for the response devices compatible with TurningPoint. The list 
below contains more detailed information for each setting.

Response Device Settings

ResponseCard Channels Allows you to view the Response Receiver settings.

Setting Description

Receiver Displays Receiver ID and receiver 
Channels of the receivers connected 
to computer
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ResponseCard Misc Allows you to view and change various response card settings.

Setting Description

Force Channel 
Change

Determine whether to force the 
Receiver Channel to change. The 
default is set at False and will force 
TurningPoint to accept the channel 
from the receiver. True will set the 
receiver to the first available slot in 
TurningPoint.

Expected Devices Displays the number of Response 
Devices that you expect to be used 
during the presentation. This is only 
required when using Simulated 
Data or Reponse Counter or 
Response Table.

Enforce Participant 
List

Determine whether only members 
of a participant list can respond 
during a presentation or if anyone 
with a response device can 
respond. The default is set at True, 
which only allows members of a 
participant list to respond and 
allows you to gather user 
information. When set to false, 
anyone can respond, but you will 
not be able to gather user 
information.

Overwrite User 
Information

Determine whether participant data 
received from a response device 
will overwrite the matching fields in 
the participant list. The default is set 
to False, which will not overwrite the 
participant list.
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vPad Enables you to view and change various vPad settings.

Web vPad Enables you to view and change various Web vPad settings.

Setting Description

Enable vPad/vLinks Determines whether vPads or 
computers using vLinks can 
participate in the presentation 
remotely. The default is set to False 
and will not allow vPads or 
computers using vLinks to 
participate remotely.

Port Number Manually change the Port number 
that vPads use to participate in the 
presentation.

Setting Description

Enable Web vPad Determines whether a Web vPad 
can participate in the presentation. 
The default is set to False and will 
not allow Web vPads to participate.

URL Assign the URL of the Web vPad 
Server

User Name Assign a user name on the Web 
vPad server. 

Password Assign a password on the Web 
vPad server.

Session Name Assign a session name for 
Participants to connect to the Web 
vPad Server.

Access Code Assign an Access code to be used 
by Participants to connect to the 
Web vPad Server.
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Presentation Settings
Presentation contains settings for the creation of slides, the way they are displayed, and other 
TurningPoint options. If you change a presentation-level setting, the change applies to all slides you 
create in the future and in some cases in the currently opened presentation.

Presentation Settings

Answer Settings Enables you to view and change Answer settings.

Setting Description

Answer Bullet 
Format

Determines type of answer bullets 
TurningPoint will display. The 
available settings include: Alpha 
Lowercase Parenth = a), Alpha 
Lowercase Period = a., Alpha 
Upercase Period = A., Decimal 
Parenth = 1), Decimal Period = 1., 
Roman Lowercase Period = i., 
Roman Uppercase Period I.
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Backup Settings Enables you to view and change the Backup Settings.

Setting Description

Backup 
Maintenance

Sets the number of days a backup 
session will be kept before being 
automatically deleted. You can set a 
range between one and ninety 
days. The default set at seven days.

Backup Sessions Automatically have TurningPoint 
create a backup copy of all your 
completed sessions. The default is 
set at True, which will create a 
backup copy.

Real-time Backup 
Path

Determines the location that your 
real-time backup session will be 
saved. When you determine a 
location, TurningPoint saves an 
XML version of your session while 
you are conducting it. The default is 
set at None. To change the 
location:1.) Double click the current 
setting to open a dialog box. 
2.)Manually enter the location or 
navigate to one by selecting the 
ellipses. 3.) This activates an 
explorer window. 4.) Choose your 
location. 5.) Select OK. 6.) Select 
Apply to set the location. 

To restore to the default location, 
double click the current setting and 
select Turn Real-Time Backup Off.
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Chart Settings This enables you to view and change the chart settings.

Setting Description

Auto Scale Charts Determines whether the vertical 
charts are scaled according to their 
specific percentages or appear 
more realistic. The default is set to 
True, which scales charts according 
to their percentages. 

Chart Colors Determines what chart colors will be 
used during your presentation. The 
available settings are Color 
Scheme, Correct/Incorrect and User 
Defined. Color Scheme - uses the 
selected PowerPoint color scheme. 
To change the color of your charts, 
you must change color setting in 
PowerPoint. See PowerPoint help. 
Correct/Incorrect - uses user 
defined colors for slides that have 
answers selected as correct and 
incorrect. All other slides in the 
presentation will uses the 
PowerPoint color scheme. To 
change the colors for correct and 
incorrect answer see the 
descriptions for Chart Color Correct 
and Chart Color Incorrect settings 
below. User Defined - uses user 
defined colors. To change colors 
see descriptions for Chart Color 1 
through Chart Color 10 settings 
below. 

The default is set at Color Scheme.

Chart Color 1 Determines the first chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 2 Determines the second chart color 
to be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 
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Chart Color 3 Determines the third chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 4 Determines the fourth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 5 Determines the fifth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 6 Determines the sixth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 7 Determines the seventh chart color 
to be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 8 Determines the eighth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 9 Determines the ninth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Setting Description
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Chart Color 10 Determines the tenth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color Correct Determines the color to be used for 
Correct answers for Correct 
Incorrect color setting. To change 
the color: 1.) Select the current 
color to display the Color Select 
window. 2.) Select the new color. 

Chart Color 
Incorrect

Determines the color to be used for 
Incorrect answers for Correct 
Incorrect color setting. To change 
the color: 1.) Select the current 
color to display the Color Select 
window. 2.) Select the new color. 

Chart Labels Determines if Answer Aliases 
(Answer Bullet Format) or Bullet 
Points will be displayed in the chart 
labels and legends. The default is 
set to Aliases.

Chart Value Format Determines whether TurningPoint 
displays the chart values a a whole 
number (Number of people who 
answered a question) or 
Percentage (Percentage of people 
who answer each question.) The 
valid formats are: 0, 0%, 0.0%, and 
0.00%. The default is set at 0%.

Reset Charts Determines whether the chart data 
will be cleared whenever a slide is 
reset. The default is set to True, 
which resets the chart data. 

Setting Description
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Competition Settings Allows you to view and change the settings for competition 
slides.

Review Only Determines whether to a chart 
showing how participants 
responded to a question is 
displayed during a presentation or 
only when a presenter reviews the 
presentation. The default is set to 
False which displays charts during 
the presentation.

Standard Chart Type Determines default chart that is 
used when a slide is inserted during 
a presentation. The default is set to 
Vertical. All chart options are 
available to choose from.

Setting Description

Setting Description

Default Number of 
Teams

Determines how many teams are 
displayed in the Team Assignment 
slides. The acceptable range is 2-20 
teams. The default is set at 5.

Include Non-
Responders

Determines whether non-
responders will be included in team 
scoring. The default is set to False, 
which does not include non-
responders.

Maximum 
Responders

Determines the maximum number 
of responders that are included in 
the fastest responders slide. The 
acceptable range is 1-20 
responders. The default is set at 5.

Participants in 
Leader Board

Determines the number of 
participants to include in the 
participant leader board. The 
acceptable range is 1-20 
participants. The default is set at 5.

Teams In Leader 
Board

Determines the number of teams 
displayed in the leader board. The 
acceptable range is 1-20 Teams. 
The default is set at 5.
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Misc Enables you to view and change various uncategorized 
settings. 

Setting Description

Add-In always 
loaded

Determines if TurningPoint loads 
with PowerPoint. The default is set 
to False, which does not 
automatically load TurningPoint. 

Allow Duplicates Determines whether more than one 
response per response device is 
permitted. The default is set to 
False, which does not allow more 
than one response.

Allow User 
Feedback

Determines if user feedback will be 
accept during the presentation. This 
option is available for vPad and 
Web vPad users only. The defaults 
is set to True, which allows user 
Feedback.

Auto Adjust 
Participant Range

Determines whether TurningPoint 
will auto adjust the device range to 
match the loaded participant range. 
The default is set to True, which 
matches the matches the device 
range with the participant range.

Auto-Update Aliases Determines if Question and Answer 
Aliases will automatically reflect 
changes in text made to the 
Question and Answer placeholders. 
The default is set to True, which 
automatically updates aliases.

Correct Point Value Set the default Point value of a 
correct answer. The acceptable 
range is from negative 10,000 to 
10,000. The default is set to 100.

Default Participant 
Setting

Determines whether the Participant 
List Drop-down menu default is 
Auto or Anonymous. The default is 
set to Anonymous.
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Default Save 
Location 

Determines a custom location for to 
save your sessions. The default 
setting is My Documents. To change 
the location:1.) Double click the 
current setting to open a dialog box. 
2.) Manually enter the location or 
navigate to one by selecting the 
ellipses. 3.) This activates an 
explorer window. 4.) Choose your 
location. 5.) Select OK. 6.) Select 
Apply to set the location. 

To restore to the default location, 
double click the current setting and 
select Restore to default path.

Include Presentation Determines whether to include the 
PowerPoint presentation with your 
saved session. The default is set to 
True, which includes the 
PowerPoint presentation.

Incorrect Point 
Value

Set a default point value for 
incorrect answers. The acceptable 
range is negative 10,000 to 10,000. 
The default is set to zero.

Input Source Set the default input source that 
TurningPoint uses when running a 
presentation. The choices are 
Keyboard Keys, Simulated Data 
and Response Devices. The default 
is set to Response Devices.

Language Change the language format. The 
default is set to the language you 
chose when installing TurningPoint 
2008.

Multiple Response 
Divisor

Determines whether the divisor 
used to calculate the percentages 
on multiple a response question will 
be the total number of responses 
received or the total number of 
devices that participated. The 
default is set to Devices.

Setting Description
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Moment to Moment Settings Enables you to view and change settings for Moment to Moment 
slides

Responses Determines the number of 
responses accepted from a 
response device without overwriting 
the previous response. The 
acceptable range is 1-10 
responses. The default is set to 1.

Use Enterprise 
Manager

Determines whether TurningPoint 
Enterprise Manager is used. If set to 
True, the Enterprise Manager Log-
in Dialog will appear when 
TurningPoint is launched. The 
default is set to False.

Zero Based Polling Number answers from 1-10 or 0-9. 
When set to True, answers will be 
number from 0-9 and will override 
the current answer bullet format. 
The default is set to False.

Setting Description

Setting Description

Polling Cycle Determines the polling interval in 
seconds on a moment to moment 
slide. The default is set at two 
seconds.
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Presenter vPad Settings Enables you to view and change the settings for the 
Presenter’s vPad.

Ranking Settings Enables you to view and change the settings for Ranking 
Chart Slides.

Setting Description

Default Port Number Set the local port number used by 
the Presenter vPad. Some ports 
may not be usable due to system or 
network configurations. The 
acceptable port number ranges 
from 1 - 65535. The default is set to 
1001.

Enable Presenter 
vPad

Determines whether a Presenter 
vPad can be used to control a 
SlideShow. The default is set to 
False, which does not allow the 
Presenter vPad to control a 
slideshow.

Presenter vPad 
Password

Set a password for the Presenter 
vPad. By default, there is not 
password set.

Require Password Require that the vPad presenter 
uses a password. The default is set 
to False, which does not require a 
password.

Setting Description

Bubble Grouping Determines the number of bubbles 
shown while rotating using the TAB 
key on a Ranking Chart slide. The 
acceptable range is 1-10 bubbles. 
The default is set at 3.

Bubble Name 
Visible

Determines whether the bubble 
names are displayed. The default is 
set to True, which displays bubble 
names.
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Response Reminders Settings Enables you to view and set Response Reminders settings.

Bubble Size Value 
Format

Determines the displayed format for 
bubble sizes. The acceptable 
formats are 0, 0.0 and 0.00. The 
default value is set to 0.

Bubble Size Visible Determines if bubble size values 
are visible. The default is set to 
True, which shows the bubble size 
value.

Setting Description

Setting Description

Answer Now Select the default Answer Now 
object that will be automatically 
added to new slides. The default is 
set to None, which does not 
automatically add an Answer Now 
indicator. All Answer Now objects 
are available to choose from.

Answer Now Text Change the Answer Now text that is 
displayed in the Answer Now object. 
The default text is Answer Now.

Auto-Advance Determines whether the SlideShow 
will automatically advance to the 
next animation if polling is closed by 
a Countdown Indicator or Response 
Counter object. The default is set to 
False, which does not automatically 
advance the SlideShow.

Countdown Determines if a Countdown object 
will be automatically added to new 
slides. The default is set to None, 
which does not automatically added 
a Countdown object to new slides. 
All Countdown objects are available 
to choose from.

Countdown 
Seconds

Set the number of seconds a 
Countdown object will display. The 
acceptable range is 1-999. The 
default is set at 10 seconds.
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Response/Non-Response
Grid Settings

Enables you to view and set the Response/Non-Response 
Grid Settings

Response Counter Determines whether a Response 
Counter object is automatically 
added to new slides. The default is 
set at None, which does not 
automatically added a Response 
Counter. All Response Counter 
objects are available to choose 
from.

Response Counter 
Format

Determines the format for new 
Response Counter objects. The 
acceptable formats are Count 
(number of responses), Percent, or 
Both (Count and Percent). The 
default is set to Count.

Response Table Determines whether a Response 
Table object is automatically added 
to new slides. The default is set to 
None, which does not automatically 
add a Response Table object. All 
Response Table objects are 
available to choose from.

Rotation Interval Determines the number of seconds 
that a Rotating Table will pause 
between intervals. The acceptable 
range is 1-10 seconds. The default 
is set to two seconds.

Setting Description

Setting Description

Auto Size Grid Determines whether the 
Response/Non-Response Grid will 
automatically resize to fit the 
screen. The default is set to True, 
which automatically resizes the 
Response/Non-Response Grid.

Custom Cell 
Background Color 1

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell 1st 
background color. To change the 
color: 1.) Select the current color to 
display the Color Select window. 2.) 
Select the new color. 3.) Select OK.
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Custom Cell 
Background Color 2

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell 2nd 
background color. To change the 
color: 1.) Select the current color to 
display the Color Select window. 2.) 
Select the new color. 3.) Select OK. 

Custom Cell 
Background Color 3

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell 3rd 
background color. To change the 
color: 1.) Select the current color to 
display the Color Select window. 2.) 
Select the new color. 3.) Select OK. 

Custom Cell 
Background Color 4

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell 4th 
background color. To change the 
color: 1.) Select the current color to 
display the Color Select window. 2.) 
Select the new color. 3.) Select OK. 

Custom Cell 
Foreground Color

Determines the color that will be 
used for the Response/Non-
Response Grid’s cell foreground 
color. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 3.) Select OK. 

Custom Grid 
Background Color

Determines the color that will be 
used for the Response/Non-
Response Grid background color. 
To change the color: 1.) Select the 
current color to display the Color 
Select window. 2.) Select the new 
color. 3.) Select OK. 

Display Device IDs Determines if Device IDs will be 
displayed on the Response/Non-
Response Grid. The default is set to 
True, which will display Device IDs.

Display Device 
Numbers

Determines if Device Numbers will 
be displayed on the Response/Non-
Response Grid. The default is set to 
True, which will display Device 
Numbers.

Setting Description
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Display Participant 
Names

Determines if Participant names will 
be displayed in the Response/Non-
Response Gird. The default is set to 
True, which will display the 
Participant Names

Gird Opacity Determines how transparent or 
opaque the Response/Non-
Response Grid is displayed. The 
accpetable ranges is 1 (transparent) 
to 100 (opaque). The default is set 
at 90 (almost opaque.)

Grid Position Determines the placement of the 
Response/Non-Response Grid 
when displayed. The acceptable 
positions are: Bottom, Bottom Left, 
Bottom Right, Center, Left, Right, 
Top, Top Left, Top Right. The default 
position is the Bottom of the screen.

Grid Rotation 
Interval

Determines the number of seconds 
a Response/Non-Response Grid 
will pause between intervals. The 
acceptable range is 1 to 10 
seconds. The default is set at 2.

Grid Size Determines the size, in pixels, of the 
Response/Non-Response Grid 
when the Auto Size Grid is set to 
False. The default size is set to 
800,600.

Use Scheme Colors Determines whether the 
Response/Non-Response Grid is 
displayed using Scheme Colors or 
Custom Colors. Scheme Colors are 
set under Chart Colors. Custom 
Colors are set in Custom Cell and 
Grid settings for Response/Non-
Response Grid Settings. The 
default is set to True, which uses 
Scheme Colors.

Setting Description
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Showbar Settings Enables you to view and change Showbar settings

Setting Description

Display Showbar Determines if the Showbar is visible 
during a SlideShow. The default is 
set to True, which displays the 
Showbar.

Expand Showbar Determines if the Showbar is 
displayed in its expanded state. The 
default is set to True, which displays 
the Showbar in its expanded state.

Use Secondary 
Monitor

Determines if the Showbar is 
displayed on secondary monitor if 
available. The default is set to True, 
which displays the Showbar on the 
secondary monitor.
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Slide Settings
Slide settings affect specific slides and answers. The slide settings apply to the slide selected from 
the Settings Hierarchy (and the particular answer, if applicable).

Slide Settings
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Chart Settings This enables you to view and change the chart settings.

Setting Description

Chart Colors Determines what chart colors will be 
used during your presentation. The 
available settings are Color 
Scheme, Correct/Incorrect and User 
Defined. Color Scheme - uses the 
selected PowerPoint color scheme. 
To change the color of your charts, 
you must change color setting in 
PowerPoint. See PowerPoint help. 
Correct/Incorrect - uses user 
defined colors for slides that have 
answers selected as correct and 
incorrect. All other slides in the 
presentation will uses the 
PowerPoint color scheme. To 
change the colors for correct and 
incorrect answer see the 
descriptions for Chart Color Correct 
and Chart Color Incorrect settings 
below. User Defined - uses user 
defined colors. To change colors 
see descriptions for Chart Color 1 
through Chart Color 10 settings 
below. 

The default is set at Color Scheme.

Chart Color 1 Determines the first chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 2 Determines the second chart color 
to be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 3 Determines the third chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 
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Chart Color 4 Determines the fourth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 5 Determines the fifth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 6 Determines the sixth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 7 Determines the seventh chart color 
to be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 8 Determines the eighth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 9 Determines the ninth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Chart Color 10 Determines the tenth chart color to 
be used for User Defined color 
setting. To change the color: 1.) 
Select the current color to display 
the Color Select window. 2.) Select 
the new color. 

Setting Description
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Chart Color Correct Determines the color to be used for 
Correct answers for Correct 
Incorrect color setting. To change 
the color: 1.) Select the current 
color to display the Color Select 
window. 2.) Select the new color. 

Chart Color 
Incorrect

Determines the color to be used for 
Incorrect answers for Correct 
Incorrect color setting. To change 
the color: 1.) Select the current 
color to display the Color Select 
window. 2.) Select the new color. 

Chart Labels Determines if Answer Aliases 
(Answer Bullet Format) or Bullet 
Points will be displayed in the chart 
labels and legends. The default is 
set to Aliases.

Chart Value Format Determines whether TurningPoint 
displays the chart values a a whole 
number (Number of people who 
answered a question) or 
Percentage (Percentage of people 
who answer each question.) The 
valid formats are: 0, 0%, 0.0%, and 
0.00%. The default is set at 0%

Review Only Determines whether to a chart 
showing how participants 
responded to a question is 
displayed during a presentation or 
only when a presenter reviews the 
presentation. The default is set to 
False which displays charts during 
the presentation.

Setting Description
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Misc Enables you to view and change various uncategorized 
settings.

Setting Description

Allow Duplicates Determines whether more than one 
response per response device is 
permitted. The default is set to 
False, which does not allow more 
than one response.

Anonymous Designate slide as anonymous 
when polled. The default is set to 
False, which does not make the 
selected slide Anonymous.

Correct Point Value Set the default Point value of a 
correct answer. The acceptable 
range is from negative 10,000 to 
10,000. The default is set to 100.

Demographic Determines if the question on the 
selected slide is treated as 
demographic question. The default 
is set to False, which does not treat 
the question as demographic.

Incorrect Point 
Value

Set a default point value for 
incorrect answers. The acceptable 
range is negative 10,000 to 10,000. 
The default is set to zero.

Multiple Response 
Divisor

Determines whether the divisor 
used to calculate the percentages 
on multiple a response question will 
be the total number of responses 
received or the total number of 
devices that participated. The 
default is set to Devices.

Question Alias Determines how the question is 
labeled. This applies only to some 
reports. The default is set to how 
the question appears on the slide

Response Data Determines whether a slide 
contains response data. When set 
to True, the slide has polled data 
and will not be polled again. When 
set to False, the slide can be polled 
again. The default is set to True and 
the slide will contain response data 
and cannot be polled again.
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Response Reminders Setting Enables you to view and set Response Reminders settings.

Responses Determines the number of 
responses accepted from a 
response device without overwriting 
the previous response. The 
acceptable range is 1-10 
responses. The default is set to 1.

Speed Scoring Determines whether point values 
will decrease relative to the time 
polling is kept open. The default is 
set to False, which will not decrease 
point values relative to the time 
polling is kept open.

Zero Based Polling Number answers from 1-10 or 0-9. 
When set to True, answers will be 
number from 0-9 and will override 
the current answer bullet format. 
The default is set to False.

Setting Description

Setting Description

Auto-Advance Determines whether the SlideShow 
will automatically advance to the 
next animation if polling is closed by 
a Countdown Indicator or Response 
Counter object. The default is set to 
False, which does not automatically 
advance the SlideShow.
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Countdown 
Seconds

Set the number of seconds a 
Countdown object will display. The 
acceptable range is 1-999. The 
default is set at 10 seconds.

Countdown Sound Use a sound file for a Countdown 
sound.To add a Countdown sound: 
1.) double click the current setting to 
open the folder window. 2.) 
Navigate to the folder containing the 
wav or mp3 file is located. 3.) Select 
the file name. 4.) Select open. 5.) 
Select done.

 The default is set to (None). The 
acceptable file extensions include: 
.aiff, .au, .mid, .midi., .mp3, .wav, 
and .wma.

Setting Description
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Answer Settings
Answer-level settings affect specific answers. The answer settings apply to the answer selected from 
the Settings Hierarchy.

Answer Settings

Chart Settings This enables you to view and change the chart settings.

Setting Description

Answer Alias Determines the Alias (Name) that is 
used for the chart labels and in 
some reports. The default is set to 
the answers entered during slide 
creation. 

Answer Value Determines whether the Answer is 
Correct, Incorrect or has no answer, 
or give the answer a point value of 
negative 10,000 to 10,000.
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Where Do I Go From Here?

If you are setting up your devices for the first time, the next step is to create your Participant List. A 
Participant List allows you to track the responses provided by your audience for each slide you 
present. Find instructions to create a Participant List in Chapter 5: Track Participants and Teams.

If you have installed new response device hardware, and you have already set up your Participant 
List, you can create a new interactive presentation or run an existing presentation using the new 
device. Find instructions to create slides in Chapter 3: Creating and Saving Slides. Find 
instructions to run a presentation in Chapter 7: Run Presentations.
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 Track 
Participants and 
Teams

Participant Lists identify the members of your audience—your students, your trainees, your survey 
respondents—who will use a response device to respond to questions during your presentation. The 
participant name and other required information are stored along with information about their 
assigned device, which is identified by number (for example, 1, 2, 3, and so on) and by Device ID, a 
unique identifier for a response device. The Device ID is printed on the device tag, which is located on 
the back of the device (unless you are using vPad and Web vPad response software).
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Recall the five steps to presentation success. 

Five Steps to Success

This chapter discusses creating and managing a Participant List.
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Create Participant Lists

Create a Participant List using the Participant List Wizard, Enterprise Manager from Turning 
Technologies or Course Management Systems by Web CT and Blackboard.

You may create multiple Participant Lists to be used with the same interactive presentation. One 
Participant List contains information about one audience group. This allows you to capture responses 
from multiple audiences to your slides.

• Create a Participant List using Participant List Wizard

• Create Participant List from Enterprise Manager

• Create a Participant List from a Course Management System

Create a Participant List using Participant List Wizard 

The Participant List Wizard guides you through the creation of a Participant List to be used with your 
interactive presentation. You control the number of responses TurningPoint will accept, which equates 
to the number of audience members. A Participant List captures the audience names, their device 
numbers and serial numbers, and other relevant information. 

Create a Participant List using the Participant List Wizard. You can choose from using standard list 
templates or create one of your own to store as much information about your audience as is desired. 

Before You Begin

If you are using a Response Table, the number of names entered in the Participant List must not 
exceed the number of expected devices that you identified for use in the Settings. The Response 
Table will only display the number of Participants equal to the number of expected devices.
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Step by Step Instructions To create a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Participant List Wizard.

Participants Menu

The TurningPoint Participant List window opens presenting 
the option to use a pre-defined Participant List template or to 
create a custom template. Custom templates created in the 
past will appear in the My Custom Templates region when the 
Custom Template button is selected.

2 Select a template for the new 
Participant List.

Participant List Wizard

Participant List template choices include:

• Education—contains standard student information 
used for K–12 and higher education presentations, 
such as name and student ID.

• Corporate—contains entries for the information most 
often used in corporate feedback meetings including 
name, company name, telephone numbers, etc.
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• Available Fields—contains all information entries defined 
for use with TurningPoint.

• Custom—allows you to create a personalized Participant 
List and to name the template or it allows you to select a 
previously created template from the list.

3 Select the Next button to 
continue.

If you opted to create a new template, TurningPoint asks you to 
name the template. Enter a name and select the OK button.

Custom Template Name

TurningPoint displays the Participant List information entries 
(called fields). All entries that make up the template appear in 
the Selected Fields region on the right. Use this page to add, 
delete, or reorder the entries that make up the template.

Participant List: Add or Remove Fields
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4 Optionally, customize the list 
of Selected Fields. 

Right (>) and left (<) arrow buttons appear.

• To remove an entry from 
the template, select it 
under the Selected Fields 
region and click the left 
arrow button. 

When selecting entries from the fields lists, hold Shift + 
click to select multiple contiguous entries, or Control + 
click to select multiple entries. 

• To add an entry to the 
template, select the 
desired entry from the 
Available Fields region, 
and click the left arrow 
button.

• To change to order of the 
selected Fields click the up 
and down buttons.

5 Select the Next button to 
continue.

TurningPoint displays the Groups entry box. Use this screen 
to add Groups to your Participant List. Groups provide 
categorization for greater reporting opportunities, such as 
demographic reports or team competitions.



TurningPoint User Guide 225

Create Participant Lists

Participant List Wizard: Add Groups

6 Optionally, type in a group 
name and select the Add 
button.

TurningPoint displays all groups in the Included Groups list. 
Repeat this step to add additional groups.

7 Optionally, edit the 
Participant File composition.

The settings you can change include the Participant List file 
name, number of participants, number of fields, and number of 
groups. For file name select the old file name and type a new 
one in the box provided. For Number of Fields or Number of 
Groups, select the link to be returned to the screen and make 
edits.
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8 Select the Finish button to 
create the Participant List 
and save it to a file.

TurningPoint displays the Participant Information window 
where you can type, paste, edit or import data. You can also 
Add/Remove or Rename Fields and Groups from this window.

Participant List Wizard: Participant Information

9 Optionally, save the template 
for future use. 

If you have modified a pre-defined template, TurningPoint 
asks whether to save the settings as a custom template. If you 
select the Yes button to name and save the template, the 
custom template will be available under My Custom 
Templates the next time you create a Participant List.

10 Add names and other 
participant information to the 
new Participant List. 

Participant Information



TurningPoint User Guide 227

Create Participant Lists

11 Optionally, Add a Field. 

a Select a row in the 
Participant Information 
window.

TurningPoint will insert the new group/field to the right of 
the row you have selected. 

b Select Edit from the menu 
bar.

Participant Information: Edit Menu

This displays a menu listing the editing options available. 

c Select Add Field/Group > 
Add Field 

This displays an Add Participant Information window.

Participant Information: Add Participant Information

Tip Alternately, you can right-click to display a 
contextual menu listing the same editing 
options.
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d Type the name of the new 
field in space provided 
under Add a custom field.

e Select Add. The name of the newly created field appears in the 
Selected Fields box.

f Repeat steps d and e to 
add additional fields.

To remove any fields from the Selected Fields box, 
place a checkmark in the box next to the field name and 
select Remove.

g Select Finish. The fields you created will be added to your participant 
list.

12 Optionally, Add a Group.

a Select Edit from the menu 
bar.

Participant Information: Edit Menu

This displays a menu listing the editing options 
available. 

Tip Alternately, you can right-click to display a 
contextual menu listing the same editing 
options.
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b Select Add Field/Group > 
Add Group. 

This displays an Add Groups to your Participant List 
window.

Participant Information: Add Groups

c Type the name of the new 
group in space provided 
under Create a new group.

d Select Add. The name of the newly created group appears in the 
Included Groups box.

e Repeat steps d and e until 
you have added all of your 
additional groups.

To remove any groups from the Included Groups box, 
pace a checkmark in the box next to the group and select 
Remove.

f Select Finish. The groups that you created are added at the end of your 
participant list.
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13 Optionally, Rename a 
Field/Group.

a Select the field or group 
that you want to rename.

b Select Edit from the menu 
bar.

Participant Information: Edit Menu

This displays a menu listing the editing options 
available.

c Select Rename 
Field/Group.

Participant Information: Field/Group Entry

This displays a text entry window.

Tip Alternately, you can right-click to display a 
contextual menu listing the same editing 
options.
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d Enter the new name of the 
field/group.

e Select Ok. The Field/Group has been renamed.

14 Optionally, Remove a 
Field/Group.

a Select the Field/Group that 
you want to remove.

b Select Edit from the menu 
bar.

Participant Information: Edit Menu

This displays a menu listing the editing options available.

c Select Remove 
Field/Group.

The field/group will be deleted.

Tip Alternately, you can right-click to display a 
contextual menu listing the same editing 
options.
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15 Optionally, rearrange the 
column order in your 
Participant List.

a Place a checkmark in the 
box next to Check to 
rearrange column order 
located at the bottom of 
the window.

Participant Information: Rearrange Columns

You will have limited editing abilities while this function 
is active. 

b Select the column you 
want to move.

Click and hold the column would like to move.

c Drag and drop the column 
to its new location.

16 Select File > Save to save the 
data in the Participant List 
before closing the Participant 
Information window.

The new Participant List appears on the TurningPoint toolbar 
in the Select a Participant List drop-down menu (next to the 
Participants menu).
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Create Participant List from Enterprise Manager

You can use Enterprise Manager from Turning Technologies with TurningPoint. Enterprise Manager is 
an essential tool for large organizations that put the TurningPoint 2008 group response system to 
work in a classroom setting. Using a web-based interface, users interact with Enterprise Manager to 
identify classes that use TurningPoint 2008 as part of the curriculum, assign faculty and students to 
those classes, and input Device IDs for the students’ response devices. Enterprise Manager captures 
this information and manages the licenses for response device usage.

Class rosters stored in Enterprise Manager are ready for use with TurningPoint 2008. A faculty 
member using a computer on the organization’s network can open TurningPoint 2008 and use the 
Enterprise Manager Wizard to import a class roster and use it as a Participant List.

On TurningPoint Enterprise Manager, the system is designed to work with KeyPads and does not 
require the special setup of WebCT and Blackboard. 

To access TurningPoint Enterprise Manager, you need the following information from the technical 
support staff at the school:

• server name of the Enterprise Manager server 

• your username

• your password

Before You Begin

Open TurningPoint 2008 on the computer hosting the presentation.
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Step by Step Instructions To load a Participant List into TurningPoint 2008…

1 From the TurningPoint 
toolbar, select Tools. 

A menu opens and displays a list of TurningPoint tools. The 
Enterprise Manager option displays near the bottom of the list.

Enterprise Manager Menu

2 Select Enterprise Manager > 
Enterprise Manager Log-in.

The Enterprise Manager Log-in window opens.

Enterprise Manager Log-In Window
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3 Enter the Server URL, User 
Name, and Password.

The Server URL is the web address where faculty members 
access Enterprise Manager. Faculty members enter the user 
name and password used to log into Enterprise Manager.

4 Select the Next button. The Class Select window opens. The drop-down menu displays 
the list of classes assigned to the faculty member. A checkbox 
displays next to Import Participant List.

Class Select Window

5 Select the class from the 
drop-down menu.

6 Select the Import Participant 
List checkbox.

A checkmark appears in the box when selected.

7 Select the Finish button. Confirmation text displays in orange in the Class Select window 
when the file has been successfully imported. The Class Select 
window closes.

A Save As window opens for saving the Participant List on the 
host computer. In the location field, the file is set to be saved in 
the Participants folder under My Documents > TurningPoint. In 
the File Name field, the class name displays with the date and 
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time of the import. You may edit the name to be more 
meaningful. 

8 In the Save As window, 
select the Save button.

A confirmation message displays.

Confirmation Message

9 Select the OK button. The newly imported Participant List displays in the Participant 
List drop-down menu in the TurningPoint Toolbar. 

Next Steps

Before giving the presentation, select the Participant List from the Participant List drop-down menu.

Create a Participant List from a Course Management System

As a versatile educational tool, TurningPoint is also compatible with course management systems 
by WebCT and Blackboard. If you teach at a school or other educational institution that uses 
WebCT or Blackboard you can use TurningPoint to transfer classroom information between your 
computer and a server. Varying degrees of integration are available for different versions of these 
course management systems.

TurningPoint can work with WebCT and Blackboard to import a Participant List from a server. The 
following steps describe how to connect to WebCT and Blackboard from TurningPoint. Before trying 

Note The Participant List must be saved in the 
Participants folder under My Document > 
TurningPoint on the host computer for 
TurningPoint to find the list.
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to import data into TurningPoint, ensure you are set up properly on the system’s server. Contact the 
technical support at the school if you need assistance with setup.

Before You Begin

On WebCT, the following steps need to occur with WebCT before using the WebCT Wizard:

• The system administrator at the institution adds a column called “KeyPadID” in WebCT. The 
instructions on how to add a column are found in the System Administrator’s Guide: WebCT 
Campus Edition.

• The instructor creates a class list and includes the KeyPad ID field.

• The students log into WebCT and enter their KeyPad ID number twice, the second time to confirm, 
and then enter their contact information. Students receive a message that the add was successful 
and that their currently registered Device ID is xxxy, etc.

• The instructor can then gather all response Device IDs from registered students.

To use the WebCT Wizard, you need to obtain the following information from the technical support 
staff at the school:

• server name of the WebCT server 

• port number of the WebCT server 

• your username

• your password

On Blackboard, the following steps need to occur with Blackboard before using the Blackboard 
Wizard: 

• The instructor creates a class list and identifies an existing column to store the KeyPad ID data. 
(Blackboard does not allow adding a column.)

• The students log into Blackboard and enter their KeyPad ID number in the column specified by the 
instructor. Students must reenter their KeyPad ID when new classes are added.

• Instructors and students can also download information for multiple classes into a zip file and 
choose a location in which to save the file.

To use the Blackboard Wizard, you need to obtain the following information from the technical support 
staff at the school:

• server name of the Blackboard server 

• your username

• your password
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Step by Step Instructions To import a Participant List…

1 From the TurningPoint 
toolbar, select Tools. In the 
menu, select WebCT Wizard 
(CE 4.1 or CE 6.0/Vista 3, 4) 
or Blackboard Wizard 
Manager, depending on your 
system.

Course Management Menu

TurningPoint displays a window to ask you which task you 
would like to perform.
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2 Select Import Participant List. WebCT Wizard: Select Task

3 Select the Next button. TurningPoint provides a window for your login information. 
Contact the technical support at the school to obtain this 
information if you do not have it.

4 Enter your login information. WebCT Wizard: Login

Note The illustrations shown in this section are of the 
WebCT CE 4.1 interface, but the interfaces for 
WebCT CE 6.0/Vista 3, 4 and Blackboard are 
similar. 
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TurningPoint saves the Server Name (IP) and the Port 
Number. You must enter your username and password for 
WebCT. The system prompts you for the Institution’s name 
and then displays all courses associated with your user name 
and password.

5 Select the Next button. The next steps differ slightly depending on the type of system 
you have. In WebCt CE 4.1, you indicate the course pertaining 
to the Participant List you want by following the instructions in 
the window. In WebCT CE 6.0/Vista 3, 4, you select the 
institution you belong to and then the course you wish to 
import from. In Blackboard, you provide the name of the field 
in the Participant List file that holds the KeyPad ID data.
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6 Provide the information 
requested in the window, 
including selecting the course 
containing the data you want 
to import. In Blackboard, 
select the name of the field 
you designated to hold the 
KeyPad ID.

WebCT Wizard: Class Select

Blackboard Wizard: Class Select

7 Select the Finish button. TurningPoint displays a window describing the location where 
the data will be imported to the computer and the file name you 
wish to import. The default location is My 

Note In Blackboard, a class list is limited to the 
existing columns. When you set up a class 
list, you cannot add a column for KeyPad ID 
numbers. You must use a column that 
already exists but is unused, such as 
Company or Work Fax. Inform students of 
the name of the column you designate for 
KeyPad ID numbers so they enter their data 
correctly.
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Documents\TurningPoint\ Participants. TurningPoint adds the 
current date and time to the file name.

8 Select the Save button. TurningPoint displays a confirmation message that your file 
has been imported. Optionally, you may edit the location or 
file name, and then select the Save button.

9 Select the OK button. The file name displays in the Select a Participant List drop-
down menu if it is saved in the My Documents\ 
TurningPoint\Participants folder. 

TurningPoint Toolbar: New Participant List

Note A Participant List must be saved in My 
Documents\TurningPoint\Participants on the 
computer that runs the presentation session. 
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Manage Participant Lists

After you have imported a Participant List or created one with the Participant List Wizard, you can 
make changes to a Participant List or delete it altogether.

This section describes how to:

• Modify a Participant List

• Delete a Participant List

• Add Data to a Participant List from a Course Management System

Modify a Participant List

Follow these steps if you would like to make changes to an existing Participant List. Although the 
presenter’s computer assigns response device numbers to each participant, you can manually assign 
a participant to a specific device number by modifying the list.

Before You Begin

A Participant List should have a.tpl extension (TurningPoint participants format). You must import the 
Participant List or create a list using the Participant List Wizard Assistant before editing it with 
TurningPoint. 

When modifying a Participant List, you may add as many new participants as needed. If you add more 
participants than the number of expected devices range that were designated when you setup your 
devices and you are using a Response Table, you will need to change the number of expected 
devices. The Response Table will only display the number of participants equal to the number 
expected devices. Find more information on expected device range in Response Device Settings on 
page 192 and on Response Tables in Add a Response Table on page 141. 
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Step by Step Instructions To modify a Participant List…

1 From the TurningPoint 
toolbar, select Participants > 
Edit a Participant List.

Participants Menu

TurningPoint displays a window of Participant Lists saved in 
My Documents > TurningPoint > Participants.

2 Select the desired Participant 
List, and then select the 
Open button.

TurningPoint displays the Participant List data in the 
Participant Information window. The grey fields represent 
data that cannot be edited, such as the column titles and row 
numbers.

Participant Information window
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3 Optionally, edit the existing 
data in the white fields by 
selecting the entries and 
typing new information.

4 Optionally, add a new 
participant by right-clicking in 
in the row above the row that 
you want to add a participant 
and selecting Add 
Participant.

Participant Information Window: Add New

5 Optionally, Add a Field. 

a Select a row in the 
Participant Information 
window.

TurningPoint will insert the new group/field to the right of 
the row you have selected. 
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b Select Edit from the menu 
bar.

Participant Information: Edit Menu

This displays a menu listing the editing options 
available. 

c Select Add Field/Group > 
Add Field 

This displays an Add Participant Information window.

Participant Information: Add Participant Information

Tip Alternately, you can right-click to display a 
contextual menu listing the same editing 
options.
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d Type the name of the new 
field in space provided 
under Add a custom field.

e Select Add The name of the newly created field appears in the 
Selected Fields box.

f Repeat steps d and e to 
add additional fields.

To remove any fields from the Selected Fields box, place 
a checkmark in the box next to the field name and select 
Remove.

g Select Finish. The fields you created will be added to your participant 
list.

6 Optionally, Add a Group

a Select Edit from the menu 
bar.

Participant Information: Edit Menu

This displays a menu listing the editing options available. 

Tip Alternately, you can right-click to display a 
contextual menu listing the same editing 
options.
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b Select Add Field/Group > 
Add Group. 

This displays an Add Groups to your Participant List 
window.

Participant Information: Add Groups

c Type the name of the new 
group in space provided 
under Create a new group.

d Select Add. The name of the newly created group appears in the 
Included Groups box.

e Repeat steps d and e until 
you have added all of your 
additional groups.

To remove any groups from the Included Groups box, 
lace a checkmark in the box next to the group and 
select Remove.

f Select Finish. The groups that you created are added at the end of 
your participant list.
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7 Optionally, Rename a 
Field/Group.

a Select the field or group 
that you want to rename.

b Select Edit from the menu 
bar.

Participant Information: Edit Menu

This displays a menu listing the editing options available.

c Select Rename 
Field/Group.

Participant Information: Field/Group Entry

This displays a text entry window.

Tip Alternately, you can right-click to display a 
contextual menu listing the same editing 
options.
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d Enter the new name of the 
field/group.

e Select Ok. The Field/Group has been renamed.

8 Optionally, Remove a 
Field/Group.

a Select the Field/Group that 
you want to remove.

b Select Edit from the menu 
bar.

Participant Information: Edit Menu

This displays a menu listing the editing options 
available.

c Select Remove 
Field/Group.

The field/group will be deleted.

Tip Alternately, you can right-click to display a 
contextual menu listing the same editing 
options.
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9 Optionally, rearrange the 
column order in your 
Participant List.

a Place a checkmark in the 
box next to Check to 
rearrange column order 
located at the bottom of 
the window.

Participant Information: Rearrange Columns

You will have limited editing abilities while this function is 
active. 

b Select the column you 
want to move.

Click and hold the column would like to move.

c Drag and drop the column 
to its new location.

10 Select File > Save. TurningPoint displays a confirmation message telling you that 
your changes have been saved. 
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11 Select the Done button to 
close the Participant 
Information window.

Delete a Participant List

This section describes how to remove a Participant List from TurningPoint.

Before You Begin

Deleting a Participant List sends the file to the computer’s Recycle Bin. Save a backup copy in 
another location if you would like to be able to access the file later.

Step by Step Instructions To delete a Participant List… 

1 From the TurningPoint 
toolbar, select Participants > 
Delete a Participant List.

Participants Menu

TurningPoint displays a window that lists all Participant Lists 
that have been created or imported.
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2 Select the file name of the 
Participant List you wish to 
remove. 

Delete Participant List

3 Click the Delete button. TurningPoint displays a window confirming that you want to 
delete the selected participant list. 

Add Data to a Participant List from a Course Management 
System

With access to WebCT, Blackboard, or TurningPoint Enterprise Manager, you can import data from a 
course management system server and add it to an existing Participant List in TurningPoint. 

Before You Begin

If you have not imported data from a server on a course management system before, find more 
information in Create a Participant List from a Course Management System on page 236 to know 
what you need to do in WebCT, Blackboard, or TurningPoint Enterprise Manager before you begin.

This function allows you to add data to a Participant List as long as the total number of participants 
remains less or equal to the number of response devices. The maximum number of response devices 
was defined when first creating the list, and you may not exceed that number. 
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Step by Step Instructions To add Participant List data…

1 From the TurningPoint 
toolbar, select Participants > 
Edit a Participant List.

TurningPoint displays a window where you can select the file 
you wish to edit.

2 Select the existing 
Participant List to be used 
and then the Open button.

The Participant Information window opens displaying the file 
you have selected.

3 From the toolbar in the 
Participant Information 
window, select Tools > 
Import. Then select 
Blackboard, WebCT or 
Enterprise Manager, 
depending on your system.

TurningPoint connects to the server and displays the 
available files.

4 Type the requested 
information to connect to the 
server.

TurningPoint connects to the server and displays the 
available files.

5 Select the file containing the 
data you wish to import and 
then the Open button.

TurningPoint imports the new data from the file on the server 
into the Participant List.

6 Select File > Save. TurningPoint saves edits to the Participant List.
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Set Up Team Competitions

TurningPoint can enhance group interaction to create a more memorable and educational 
presentation. Team competitions are a fun way to incite this interaction. Set up team competitions 
through the Participant List Wizard. You can create a Participant List that enables you to assign 
participants to teams who will compete for the highest score during your presentation. 

For participants or teams to accumulate scores, you will have to assign point values to correct 
answers. You can even assign points based on how quickly participants respond using speed scoring.

TurningPoint offers several slides to keep track of participant and team point totals and which 
participants responds most quickly. Find more information in Competition Slides on page 61.

This section describes how to:

• Add Teams to a Participant List

Add Teams to a Participant List

Follow these steps to create a Participant List that can enable team competitions.

Before You Begin

These steps create a new Participant List that assigns participants to teams before the presentation. If 
you would like to pick teams on the fly during the presentation, you need to insert a Team Assignment 
slide. Find information about this special slide in Competition Slides on page 61. 

Step by Step Instructions To set up team competitions…

1 Follow step 1 through step 5 
in Create a Participant List 
using Participant List 
Wizard on page 221. 

In the Participant List Wizard window, TurningPoint displays the 
Groups entry box. Use this page to add groups to your 
Participant List. 



256 Turning Technologies

Chapter 5: Track Participants and Teams

2 Type a group name in the 
Create a new group field, and 
select the Add button. Repeat 
for all desired team names.

TurningPoint displays all groups in the Included Groups list. 
These groups can represent any type of grouping you wish to 
assign participants to, such as teams, class level, or any other 
demographic information.

3 Select the groups in the 
column to the right that you 
want to designate as teams 
who will compete against 
each other.

Check marks appear next to the groups designated to 
compete as teams.

Participant List Wizard: Add Groups
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4 Select the Next button to 
continue.

TurningPoint displays the Participant List summary screen.

Participant List: Summary

5 Select the Finish button to 
create the Participant List 
and save it to a file.

Next Steps

Find more information about slides for keeping track of participants’ and teams’ points in Competition 
Slides on page 61.
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Where Do I Go From Here?

This chapter has demonstrated how to create and customize Participant Lists for your presentation.

If you have not set up the hardware devices for participants to respond, Chapter 4: TurningPoint 
Device and Settings Management demonstrates this process. You only need to set up hardware 
devices once on the computer you will use them with, unless you add or change the hardware 
devices.

If you have already set up hardware devices and have a participant list for the audience you will be 
presenting to, you are ready to conduct your presentation! Chapter 7: Run Presentations 
demonstrates this process.
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TurningPoint offers several tools that allow you to use powerful advanced features:

• Create slides to rank items.

• Create and assign standards for evaluating participants

• Create comparative links for comparing the responses from several slides in a single chart in your 
presentation

• Use conditional branching to control the order of slides in your presentation based on responses

• Create slides from imported files.

The Standards tool enables you to use reports to evaluate the performance of participants based on 
standards. You can use the built-in standards, set up a list of standards, associate those standards 
with questions, and then evaluate the performance of the audience as a whole, by groups, or by 
individuals on each standard. Find more information in Standards on page 269. 

The Comparative Links and Conditional Branching tools allow you to add advanced functionality to 
your presentation. 

The Comparative Links tool is used to compare the results from several slides in a single chart in your 
presentation. For example, you might ask several similar questions in succession, and then wish to 
compare the responses from each question on a single slide. By creating comparative links between 
the slides, a single slide’s chart can show the results from up to three additional questions. Find more 
information in Comparative Links on page 284. 

The Conditional Branching tool allows you to control the order of slides based on the responses to a 
question. For example, you could have the audience vote on which topics to cover in your 
presentation, or you could continue with a different topic when the audience demonstrates a sufficient 
understanding of the current one by answering a question correctly. Find more information in 
Conditional Branching on page 289.

The Ranking Wizard allows you to create slides to rank items on several criteria. Find more 
information in Ranking Wizard on page 261.
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The TurningPoint Parser allows you to automatically create presentations from XML or Word 
documents. Find more information in Import Slides with the TurningPoint Parser on page 307.

The Import from TestingPoint tool allows you to automatically create presentations from 
TestingPoint documents. Find more information in Import Slides from TestingPoint on page 311
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Ranking Wizard

You can quickly and easily create slides that support decision-making, prioritization, or other kinds of 
ranking using TurningPoint’s Ranking Wizard. The Ranking Wizard automatically creates slides for 
comparisons of items on one to three criteria, then summarizes the results of the comparisons in a 
chart.

For example, suppose you wanted to prioritize several projects you are considering. You might 
compare them on the basis of cost, impact, and urgency to rank them.

You can choose to rank each item on a numerical scale for each criterion. For example, one slide 
would ask you to rank Project A on urgency from least (1) to most (10). You can use a scale beginning 
with 1 and ending with any number up to 10.

Alternatively, you can choose to compare items on the criteria by pairs. For example, one slide would 
ask you whether Project A or Project B is more urgent.

You can include as many items as you wish, and you can compare them on up to three criteria. The 
results are displayed in a chart which ranks the items. The chart looks similar to this:

Ranking Wizard chart

In this example, Project D looks like a clear winner, since it has the lowest cost, most urgency, and a 
relatively high impact.

*
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The Ranking Wizard gathers information from you about the items, the criteria, and how you would 
like to make the comparisons. Then it automatically constructs a series of slides with the questions 
and answers necessary to construct a final comparison chart.

This section describes how to:

• Create Slides with the Ranking Wizard

Create Slides with the Ranking Wizard

The Ranking Wizard is located in the Tools menu on the TurningPoint toolbar. It guides you through 
the process of creating a ranking.

Step by Step Instructions To create slides with the Ranking Wizard…

1 Navigate to the slide you 
would like the ranking slides 
to be inserted after.

When you complete the Ranking Wizard, the ranking slides 
will be added to the presentation after the currently visible 
slide.
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2 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select Ranking Wizard



264 Turning Technologies

Chapter 6: Tools

3 Select Ranking Wizard. The Ranking Wizard window opens.

Ranking Wizard: Add Items

4 Type a name for an item to be 
ranked in the box provided 
and select the Add button.

The item will be added to the list. You must add at least two 
items.

Repeat this step until you have added all the items you would 
like to rank.

Note You can save a list of items if you will reuse 
them with the Ranking Wizard. Lists are 
stored as simple text (.txt) files. 
Use the Save button (shaped like a disk) to 
save a text file with the list of items. Use the 
Load button (shaped like a folder) to load a 
text file with a list of items.
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5 When you have added all the 
items to rank, select the Next 
button.

The next set of options allows you to specify the criteria that is 
displayed in the Ranking Wizard.

Ranking Wizard: Enter Criteria

6 Enter a name for the X 
criterion and, optionally, the Y 
criterion, in the boxes 
provided.

You must enter at least one criterion (X) for the ranking. If you 
are comparing only a single criterion, leave the Y criterion blank.

The X and Y criteria appear on the horizontal and vertical axes 
of the chart, respectively.

7 If you wish to include a third 
criterion in the ranking, check 
the box for the Z criterion and 
enter a name for the Z 
criterion in the box provided.

The Z criterion, if used, is represented in the chart by the size of 
the “bubble” for each item.

8 Choose a method for ranking 
the items:

• Select Standard X/XY/XYZ 
to rank the items on a 
numerical scale for the 
criteria.

You will specify the numerical scale to use later in the 
Ranking wizard if you choose a standard comparison.
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• Select Paired Comparison 
to compare the items by 
pairs on the criteria.

If you choose paired comparisons, you may allow a 
response of No Preference by checking the box for that 
option.

9 If you chose a standard 
comparison, select whether 
you would like the slides to be 
grouped by criterion or by list 
item.

Grouping slides by criterion will present the slides for each 
item about criterion X, then slides for each item about criterion 
Y, and so on.

Grouping slides by item will present the slides for each 
criterion about item A, then the slides for each criterion about 
item B, and so on.

10 Check the box if you would 
like to Auto-Advance the 
slides created by the Ranking 
Wizard.

Using Auto-Advance automatically advances the slide after all 
participants have responded to a question.

11 Check the box if you would 
like to display the charts for 
the slides created by the 
Ranking Wizard.

Commonly, you are not interested in seeing the results for 
individual slides in the ranking questions. You can remove the 
check mark and use it in combination with Auto-Advance to 
make your way quickly through the ranking questions to 
display the ranking chart.

12 If you are using a Z criterion, 
check the boxes if you would 
like to use the following 
options:

• Show Bubble Names 
shows the name of each 
item on the bubble that 
represents it in the ranking 
chart.

The chart also includes a key that color-codes the 
bubbles with the items.
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• Show Bubble Sizes shows 
the numerical size of each 
item’s bubble on the 
ranking chart.

13 When you have specified all 
the options you would like to 
use, select the Next button.

If you chose a standard comparison, the next set of options 
allowing you to specify the ranking scale is displayed in the 
Ranking Wizard window. (If you chose a paired comparison, a 
summary is displayed and you can skip to step 17.)

Ranking Wizard: Customize Scale

14 Uncheck the boxes next to 
the numbers if you wish to 
limit the scale to less than 1–
10.

Unchecking a number also unchecks all the larger numbers.

For example, if you would like to use a scale of 1–4, uncheck 
the box next to 5.

15 If you would like to add labels 
to the numbers, select a 
number and type the label 
text.

You might like to add labels to the lowest and highest numbers 
of the scale (such as “Worst” and “Best”).
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16 When you are finished 
modifying the ranking scale, 
select the Next button.

A summary of all the options you chose is displayed in the 
Ranking Wizard window:

Ranking Wizard: Review Selections

17 Review the information in the 
summary to ensure that it is 
correct.

If any of the information is incorrect, you can select the 
incorrect information to be taken to the set of options in the 
Ranking Wizard where you specified the information. Change 
the information to be correct and then continue with the 
remaining steps. (Alternatively, use the Back button to go 
back to the incorrectly set option.)

18 Select Finish to create the 
ranking slides.

TurningPoint inserts the ranking questions and the ranking 
chart in your presentation. (This may take some time if you 
have a large number of items.)

Next Steps

When you run the presentation containing the ranking slides, the results will be compiled to 
generate the ranking chart, which is displayed in a slide following the ranking questions.

Because the Ranking Wizard uses the results from the created slides to construct the final chart, 
you should not alter the slides created by the Ranking Wizard.
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Standards

TurningPoint’s standards tools allow you to use built-in standards per state, subject and grade level or 
create your own lists of standards on which participants can be evaluated. For training, teaching, or 
testing, standards help you organize the material in your presentation into subject areas, 
competencies, or other standards which the participants should meet. You can then view participants’ 
results by standards using TurningPoint reports. Find more information in Reports on page 341.

Before you can assign standards to slides in a presentation, you need to select from the Built-in 
Standards or create a list of the standards you will be using.

This section describes how to:

• Create a Built-in Standards List

• Create a Custom Standards List

• Assign Standards to Slides

Create a Built-in Standards List

TurningPoint 2008 comes loaded with built-in standards per state, subject and grade level. Create a 
list of standards using any of these criteria.
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Step by Step Instructions To create a Built-in Standards List…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Standards
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2 Select Standards from the 
Tools menu.

The Standards window opens.

Standards Window

3 Select the Built-in Standards 
Lists tab.

This displays a window with four drop down menus: 
state/country, topic, subject, and grade.

Standards Window
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4 Select a state or country from 
the Select a state or country 
drop down menu.

This populates the Select a topic drop down menu with topics 
for the selected state.

Built-in Standards: Select a State

5 Select a topic from the Select 
a topic drop down menu.

This populates the Select a subject drop down menu with 
topics for the selected topic.

Built-in Standards: Select a Topic
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6 Select a subject from the 
Select a subject drop down 
menu.

This populates the Select a grade drop down menu with grade 
levels for the selected topic.

Built-in Standards: Select a Subject

7 Select a grade level from the 
Select a grade drop down 
menu.

All of the Standards for the selected state/country, topic, 
subject, and grade are displayed in the left pane of the 
Standards window.

Built-in Standards: Select a Grade
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8 Select a standard from the 
list.

You can add the standard to the presentation or slide.

9 Select the right arrow button 
(>) to assign the standard to a 
presentation or specific slide.

The standard is displayed in the list of standards in the right-
hand pane of the Standards window.

Standards Window: Standards for Presentation

You can remove a standard using the left arrow button (<).

10 Repeat these steps 
beginning with step 11 to add 
standards to additional 
slides.

You can assign multiple standards to each slide. You can also 
use multiple Standards Lists.

If you would like to start over, you can select the Clear All 
button to clear all standards from all slides in the presentation.
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11 When you are finished 
assigning standards to your 
slides, select the Done 
button.

Create a Custom Standards List

TurningPoint allows you to create a list of standards to suit your specific needs. 

Step by Step Instructions To create a Standards List…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Standards
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2 Select Standards from the 
Tools menu.

The Standards window opens.

Standards Window

3 Select the Custom Standards 
Lists tab.

The Current Standards List drop-down menu displays the 
selected Standards list. The drop-down menu allows you to 
choose from the Standards Lists in your Standards folder.The 
Load button allows you to import a Standards List to your 
Standards folder from elsewhere. The Delete button allows 
you to delete a Standards List from your Standards folder.
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4 Select the New button. TurningPoint prompts you to enter a new name for the 
Standards List.

Custom Standards Window

5 Enter a name in the box 
provided and select the OK 
button.

TurningPoint creates the Standards List in your Standards 
folder, displays it in the Current Standards List drop-down 
menu, and displays the new Standards List in the left-hand pane 
of the Standards window.

Custom Standards Window: New Standards List

The new Standards List has a top-level category with the same 
name as the list.
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6 To add a category or a 
standard, complete the 
following steps.

a Select the parent category 
in which to include the 
category or standard you 
wish you add.

Categories arrange standards into a hierarchy.

Custom Standards: Select Parent Category

b Select the Add Category or 
Add Standard button.

TurningPoint prompts you to enter a title for the 
category or standard.

Custom Standards Window: Add Category

c Enter a title in the box 
provided and select the 
OK button.

TurningPoint adds the category or standard to the 
parent category you selected.

d Repeat steps a–c until you 
have added all the 
categories and standards 
you need.

You can delete a category or standard from the list 
using the Remove button. You can change the title of a 
category or standard using the Edit Field button.
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7 When you are finished 
creating your Standards List, 
select the Done button.

TurningPoint indicates that you have made changes to the 
Standards List and asks if you would like to save your changes.

8 Select the Yes button. The changes are saved to your Standards List file and the 
Standards window closes.

Next Steps

To associate standards with slides, follow the instructions in the next section, Assign Standards to 
Slides.

Assign Standards to Slides

Assigning standards to slides allows you to use TurningPoint reports to assess participants’ 
performance on slides relating to the standards.

Before You Begin

You should create or obtain Standards Lists to be assigned to the slides. Find more information in 
Create a Built-in Standards List on page 269 or Create a Custom Standards List on page 275.
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Step by Step Instructions To assign standards to slides…

9 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Standards
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10 Select Standards from the 
Tools menu.

The Standards window opens displaying two tabs: Built-in 
Standards Lists and Custom Standards Lists.

Standards Window

11 Select either Built-in 
Standards Lists or Custom 
Standards List.

The remaining steps are the same for both applying a Built-in 
Standards or Custom Standards list.

12 Select to assign a standard to 
the presentation or slide 
using the Current Selection 
drop-down menu.

Standards Window: Assign Standards
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13 Select a Standards List in 
one of the following ways:

a Select a Standards List 
from the Standards folder 
using the Current 
Standards List drop-down 
menu.

The categories and standards are displayed in the left-
hand pane of the Standards window.

b Select a Standards List 
from elsewhere using the 
Load button.

The Standards List file is copied to your Standards 
folder and the standards and categories are displayed 
in the left-hand pane of the Standards window.

14 Select a standard from the 
list.

You can add the standard to the presentation or slide.

15 Select the right arrow button 
(>) to assign the standard to a 
presentation or specific slide.

The standard is displayed in the list of standards in the right-
hand pane of the Standards window.

Standards Window: Standards for Presentation

You can remove a standard using the left arrow button (<).
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16 Repeat these steps 
beginning with step 11 to add 
standards to additional 
slides.

You can assign multiple standards to each slide. You can also 
use multiple Standards Lists.

If you would like to start over, you can select the Clear All button 
to clear all standards from all slides in the presentation.

17 When you are finished 
assigning standards to your 
slides, select the Done 
button.

Next Steps

Several reports allow you to assess participants’ performance on the standards you assigned. Find 
more information in Reports on page 341.
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Comparative Links

You can use comparative links to compare the responses from several slides on a single slide’s 
chart.

This is a sample chart comparing the responses from three slides.

Chart with Comparative Links

The bars are grouped by answer. Each answer’s bars include the results for the current slide at the 
left (or top, depending on the chart type), then the results for each linked slide in the order that the 
links are assigned.

A slide can contain up to three comparative links, so you can compare up to four questions. 
Generally, each question you compare should have the same number of answers, since the first 
answer in the answer region is compared to the first answers on the linked slides, the second 
answer to the second answers on the linked slides, and so on.

This section describes how to:

• Set Up Comparative Links
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Set Up Comparative Links

Set up comparative links using the Comparative Links window, available from the Tools menu in the 
TurningPoint toolbar.

Before You Begin

Before you set up a comparative link, first create the slides you would like to be compared. A slide can 
contain one to three comparative links, so you can compare up to four questions.

Generally, the slides being compared should each have the same number of answers. 

For the slide on which the comparison will be displayed, use a vertical, horizontal, offset, or donut 
chart. Comparisons cannot be displayed using 3D pie or distributed pie charts. 

The slide on which the comparison will be displayed should come after the slides it is being compared 
to, so that the results of those slides are available for display.
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Step by Step Instructions To create a comparative link…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Comparative Links
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2 Select Comparative Links 
from the Tools menu.

The Comparative Links window opens.

Comparative Links Window

3 Select the slide to include the 
comparison in the Selected 
Slide drop-down menu.

Comparative Links Window: Select Slide
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4 Select a slide to compare 
with in the Link to Slide drop-
down menu.

Comparative Links Window: Link to Slide

5 Select the Create Link button 
to create the comparative 
link.

The link is displayed in the list of comparative links.

6 Select the Done button. The Comparative Links window closes. TurningPoint adds the 
comparative link to the slide. (The comparison will not be 
visible until you run the presentation session and collect data.)

Next Steps

When you run your presentation session, the charts in slides containing comparative links will 
automatically show comparisons of the data for the linked slides.

You can add additional comparative links by repeating these steps. You can add up to three links to 
a slide.

You can delete comparative links by selecting the link in the Comparative Links window and 
selecting the Break Link(s) button.
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Conditional Branching

Conditional branching allows you to control the order of slides in your presentation based on the 
responses received from the audience. 

For example, at the beginning of your presentation you might ask the participants to vote whether 
you’ll cover topic A or topic B. Depending on the results of the vote, the presentation will skip ahead to 
the slides for topic A or topic B. 

Or, you might ask a question covering a specific subject area to assess whether the participants 
understand the subject. If most of the participants respond correctly, you can skip ahead to the next 
section of material.

This section describes how to:

• Set Up Conditional Branching

Set Up Conditional Branching

You set up conditional branching by defining a condition, which, if satisfied, advances to the slide you 
specify. Each condition consists of a comparison. The number or percentage of responses for a 
particular answer (or all correct answers) is compared with a specific value, or with the majority of 
responses for that slide.

Set up conditional branching using the Conditional Branching window, available from the Tools menu 
in the TurningPoint toolbar.

Before You Begin

Before setting up conditional branching, you should create the slides for the branches of your 
presentation and plan their order.
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Step by Step Instructions To set up conditional branching…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Conditional Branching
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2 Select Conditional Branching 
from the Tools menu.

The Conditional Branching window opens.

Conditional Branching Window

3  Select the slide where the 
branch will begin in the 
Selected Slide drop-down 
menu.

You will specify where to branch (which slide to show next) 
based on the outcome of the selected slide’s polling.

Conditional Branching Window: Select Slide
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4 Select Add to add a 
condition.

The condition appears in the Conditional Rules box with a 
default name of New Rule. 

Conditional Branching Window: New Rule

5 Optionally, rename the 
condition by selecting 
Rename.

A box will appear for you to enter the new name of the rule. 
Select OK. The name has been changed.

Conditional Branching Window: Rename Condition
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6 Optionally, create multiple 
conditions for a slide by 
selecting AND Condition or 
OR Condition as Logical 
Operators.

Select AND Condition to link a conditional branching item to the 
previous item to specify that both conditions should be met. 
Select OR Condition to link a conditional branching item to the 
previous item to specify that either condition can be met.

Conditional Branching Window: And/Or Condition

Note You can link more than two conditional 
branching items for one slide. 
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7 Define all conditions in the 
Conditional Branching Rule 
Description by selecting the 
appropriate link. 

Find some examples of conditions in the examples following 
these instructions on page 296.

a Condition - choose from 
the number or percentage 
of responders that must 
choose the same 
response to satisfy the 
condition. 

Choose from Percentage of Response, Number of 
Responders, or Majority Rules. 

Conditional Branching Window: Choose Condition

This displays the Compound Rule Condition Box with 
up to three Conditional Rules that must be met: 
Comparison Operator, Value, and Selected Answer.

Conditional Branching Window: Compound Rule
Condition

• Comparison Operator - Determines if the condition 
for the branch item has been met. You can choose 
from: 

• greater than (>)

• less than (<)

• equal to (=)
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• not equal to (<>)

• greater than or equal to (>=)

• less than or equal to (<=)

• Value - Determines the value or percentage to be 
compared to in the next step. For Number of 
Responders, enter a number of responses (from 0 to 
the total number of participants). If you choose 
percentage, enter a percentage of responses (from 1 to 
100)

• Selected Answer - Determines what answer must be 
selected to make the condition true.The number or 
percentage of responses for the selected answer will 
be used in the comparison. You can choose any of the 
answers on the slide., The condition uses the number 
of responses for that selected answer choice.

b  Slide Selection - choose 
the slide you want to be 
displayed when the 
condition is fulfilled. 

Conditional Branching Window: Slide Selection

c Select Next Slide to 
choose the slide you wish 
to go to if the condition is 
not met. 

You can branch to any slide in your presentation.
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8 Repeat steps 4 and 5 to add 
additional independent 
conditions to same slide. 

 See examples of how to add multiple conditions to a slide on 
page 296.

9 Select the OK button in the 
Conditional Branching 
window when you are 
finished adding all conditions 
to the slide.

For Example

The examples below show you how to add a variety of multiple conditions, both linked and 
independent, to a slide.

Example 1 illustrates multiple conditions linked together. All three conditions must be met for 
TurningPoint to branch to the designated slide listed in the third condition.

Example 1

During the presentation, if one participant selects Cincinnati AND if one participant selects 
Cleveland AND if less than half select Youngstown, then the presentation continues with slide 4.
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Examples 2.1 and 2.2 illustrate two independent conditions added to the same slide.

Example 2.1

Example 2.2

During the presentation, if all participants answer correctly, the presentation continues with slide 5. 
Alternatively, if the majority of participants select Cleveland, the presentation continues with slide 6.
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Examples 3.1 through 3.3 illustrate both linked and independent conditions added to a single slide.

Example 3.1

Example 3.2
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Example 3.3

During the presentation, if all participants answer correctly, the presentation continues with slide 5. 
Alternatively, if the majority of participants select Cleveland, the presentation continues with slide 6. 
Alternatively, if one participant selects Cincinnati AND if one participant selects Cleveland AND if less 
than half select Youngstown, then the presentation continues with slide 4.

Next Steps

When you run your presentation session, the slides set up for conditional branching advance to the 
slide you specified if the condition is met.

You can remove a condition by selecting it in the list in the Conditional Branching window and 
selecting the Remove button.
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Parser Documents

The TurningPoint Parser can import two kinds of documents:

• an XML document

• a Microsoft Word document (.doc)

To be imported by the TurningPoint Parser, these documents must be formatted in the proper way. 
The following sections describe the proper formats for documents imported by the Parser.

This section describes how to:

• Format XML Documents

• Format Word Documents
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Format XML Documents
The following is a basic shell of the XML document type accepted by the TurningPoint Parser:

<slides count=”” id=””>
<slide id=”” type=”” multiresponse=””>
<question alias=”” filename=””

imageposition=”” />
<topic id=”” />
<answers>
<answer alias=”” value=”” filename=”” />

</answers>
</slide>

</slides>

Each element is described below, along with an example and an explanation of the attributes.

slides The slides element is the top-level element in the XML 
document and contains all the information TurningPoint 
requires to create the interactive presentation. The slides 
element contains a number of slide elements.

<slides count=”1” id=”86FF9DB9”>

slide Each slide element contains the question and answer 
information for a single slide.

Note Remember that the following characters are 
reserved in XML: < > & ‘ “
Use the XML entities for these characters 
(&lt; &gt; &amp; &apos; &quot; 
respectively).

Attribute Description

count The total number of slide elements in 
the presentation.

id An optional attribute that contains a 
unique identifier for the group of 
slides.
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<slide id=”E15F45B” type=”D” multiresponse=”1”>

question The question element contains the question information (as 
attributes) and the question text (as content).

<question alias=”Gender?” filename=”” 
imageposition=””>

What is your gender?
</question>

Attribute Description

id An optional attribute that contains a 
unique identifier for the slide.

type Defines what type of slide to create 
using a single-letter code. The 
following types are accepted:

• Q = standard question slide
• P = picture slide
• D = demographic slide
• S = speed scoring slide
• F = fill in the blank slide (vPad and 

Web vPad only)
• E = essay slide (vPad and Web 

vPad only)
• M = moment to moment slide 

multiresponse An optional attribute that contains the 
number of responses allowed per 
keypad for the slide. Accepted values 
are 1–10.

Attribute Description

alias An optional attribute that contains an 
alias for the question.
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topic The topic element contains the question topic.

<topic id=””></topic>

answers The answers element contains a number of answer elements.

<answers>

answer Each answer element contains answer information (as 
attributes) and the answer text (as content) for a single answer.

<answer alias=”” value=”” filename=””>
Female

</answer>

filename An optional attribute that contains a 
filename for a picture that can be 
included with the question.

imageposition An optional attribute that sets the 
question picture position. The 
following are acceptable values:

• L = Left
• R = Right
• F = Full

Attribute Description

Attribute Description

id An optional attribute that contains a 
unique identifier for the topic.

Attribute Description

alias An optional attribute that contains an 
alias for the question.
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value An optional attribute that contains a 
value for the answer. Valid answer 
values are “Correct”, “Incorrect”, or a 
point value negative 10,000–10,000. 

filename An optional attribute that contains a 
filename for a picture that can be 
used in place of the answer text on 
the slide. This attribute is used only if 
the slide type attribute is set to “P”.

Attribute Description
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Format Word Documents
To create a Word document to be imported by the TurningPoint Parser, you must create an outline 
using the heading styles built into Word. You can apply the heading styles using the drop-down menu 
in the Formatting toolbar, or in the Styles and Formatting pane available through the Format menu.

Each question must use the “Heading 1” style. The question is followed by several answers on 
separate lines using the “Heading 2” style.

In addition to the question and answer text, you can use optional TurningPoint tags to control other 
settings. Each TurningPoint tag must use the “Heading 3” style. Tags occur at the start of the outline 
(for tags that apply to the entire presentation) or on the lines immediately following a question or 
answer (for tags that apply only to a specific question or answer). A tag is formatted in the following 
way:

<tag>value

All tags are optional. If omitted, the slide will default to a standard question slide.

The tags are described in the following table.

Tag Location Description and Allowed Values

<c> Start of 
outline.

The number of slides in the 
presentation.

<d> Start of 
outline or 
following a 
question.

Contains the Session ID (if at the 
start of the outline) or topic ID (if 
following a question).

<a> Following a 
question or 
an answer.

Contains an alias for a question or 
answer.
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<t> Following a 
question.

Defines what type of slide to create 
using a single-letter code. The 
following types are accepted:

• Q = standard question slide
• P = picture slide
• D = demographic slide
• S = speed scoring slide
• F = fill in the blank slide (vPad 

and Web vPad only)
• E = essay slide (vPad and Web 

vPad only)
• M = moment to moment slide 

<f> Following a 
question or 
an answer.

The filename of a picture file. If the 
tag follows a question, the picture 
will be added next to the question 
text on the slide. If the slide type is 
“P” and the tag follows an answer, 
the picture will replace the answer 
text on the slide.

<n> Following a 
question.

Contains the question picture 
position. The following are 
acceptable values:

• L = Left
• R = Right
• F = Full

<m> Following a 
question.

Contains the number of responses 
allowed per keypad for the slide. 
Accepted values are 1–10.

<p> Following a 
question.

Contains the question topic. 

<v> Following 
an answer.

Contains a value for the answer. 
Valid answer values are “Correct”, 
“Incorrect”, or a point value 
negative 10,000–10,000. 

Tag Location Description and Allowed Values
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Import Slides

TurningPoint can automatically create TurningPoint slides from Microsoft Word files, XML files or 
TestingPoint.

Using this feature of TurningPoint provides a quick way to create a number of slides, and it is also 
beneficial if you already have question and answer data in another form that you would like to 
transform into TurningPoint slides.

A simple slide presentation can be created by importing a an XML document or Microsoft Word 
document using the TurningPoint Parser. Alternatively, you can import question and answer data from 
TestingPoint.

This section describes how to:

• Import Slides with the TurningPoint Parser

• Import Slides from TestingPoint

Import Slides with the TurningPoint Parser

The TurningPoint Parser is located in the Tools menu and allows you to automatically create slides 
from Microsoft Word or XML files. 
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Step by Step Instructions To import slides with the TurningPoint Parser…

1 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select Update Parser Template

2 (Optional) Select Update 
Parser Template.

The slides you import will be created with default 
characteristics that may not match your settings. You can use 
the Update Parser Slides command to update the imported 
slides to match your settings.



TurningPoint User Guide 309

Import Slides

3 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select TurningPoint Parser
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4 Select TurningPoint Parser. An open file window appears asking you to select the file to 
import.

Open File Window

5 Navigate to the file you would 
like to import (.doc or .xml) 
and select it.

6 Select the Open button to 
continue.

A dialog appears asking whether you would like to add the 
slides to the end of the current presentation or create a new 
presentation.

7 Select the Yes button to add 
the slides to the current 
presentation, or select the No 
button to create a new 
presentation.

TurningPoint builds the slides from the file. If there are many 
slides, this may take some time.

Next Steps

The slides imported by the TurningPoint Parser are normal TurningPoint slides, so you can take 
advantage of any the TurningPoint customizations you would like to make on them.
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Import Slides from TestingPoint

TurningPoint can insert files from TestingPoint and create slides based on them. TurningPoint retains 
the features used in the TestingPoint files.

Step by Step Instructions To import slides from TestingPoint…

1 Select Tools from the 
TurningPoint toolbar.

The Tools menu opens.

Select TestingPoint
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2 Select Import from 
TestingPoint.

An ‘Import a TestingPoint Document’ window opens allowing 
you to select the file to import.

Import a TestingPoint Document Window

3 Navigate to the file you would 
like to import and select it.

4 Select the Open button to 
continue.

A dialog box opens allowing you to choose to add the slides 
to the end of the current presentation or create a new 
presentation.

Import Dialog Box

5 Select the Yes button to add 
the slides to the current 
presentation, or select the No 
button to create a new 
presentation.

TurningPoint builds the slides from the file. If the file contains 
many slides, this may take some time.
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Where Do I Go From Here?

This chapter has demonstrated how to use tools with TurningPoint. After you present a session, you 
are ready to run a presentation. 

Chapter 7: Run Presentations describes the process of running a presentation. 
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After you have created the slides and objects discussed in Chapter 3: Creating and Saving Slides, 
you are ready to run an interactive presentation. The process of running a presentation requires a few 
preliminary steps and offers some options and tools that this chapter demonstrates for you.

Each time you run a presentation, TurningPoint creates a unique session. A session is made up of 
data pertaining to the response devices, the participants in the audience, and the responses of the 
participants. This data typically saves to the computer that is running the presentation. 

To run a presentation:

• Establish the settings for gathering and storing responses on the computer that runs the 
presentation. The settings are made up of the results data, which may need to be reset, the 
response devices, and the Participant List. Optionally, the settings could include preferences for 
the Response Grid, especially if infrared keypads are used.

• Run a session. A presentation session feels similar to running a typical PowerPoint slide show, but 
as you present, the Showbar is initially available at the top of the screen during interactive slides. 
The Showbar can be moved to any location on the screen by selecting the appropriate icon. The 
Showbar allows you to open and close polling, view polling status, and view the response data in 
a variety of ways. 

• Save a session. You can save the results of your interactive presentation and generate reports 
through TurningPoint to evaluate the audience’s responses. You will want to save the responses 
provided by your audience for each presentation session. 

You can perform test runs or present the completed presentation to your audience. Behind the 
scenes, TurningPoint gathers, tallies, and stores the responses from your audience. You can choose 
to share the results of the session with the audience or keep them confidential.
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Recall the five steps to presentation success. As depicted in the following diagram, running a 
presentation session is the fourth step when using TurningPoint.

Five Steps to Success

This chapter describes the following activities to help your presentation run smoothly:

• Run an interactive presentation using the Slide Show functionality. Find instructions for running 
a presentation in Run a Presentation on page 317.

• Control the presentation using the Showbar. Find instructions for using the Showbar in Run the 
Slide Show on page 324 and View Polling Status on page 328.

• Monitor the audience participation. Find instructions for monitoring in View Polling Status on 
page 328 and Use the Participant Monitor on page 330.
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Run a Presentation

You run an interactive presentation session using PowerPoint’s Slide Show functionality. 

You control the presentation session by opening and closing polling. Polling is the mechanism by 
which TurningPoint accepts and tallies the responses provided by the audience using response 
devices.

This section describes how to:

• Establish the Presentation Settings

• Run the Slide Show

• View Polling Status

• Use the Participant Monitor

• Add Slides During a Presentation Session

• Data Slicing (View Results by Question)

Establish the Presentation Settings

The presentation settings consist of the results data and Participant List to be used, which are 
important items to check before running the presentation.

Prior to starting a presentation session, you must perform the following steps: 

• Clear any previous session results.

• Identify the Participant List to be used.

This section explains how to perform these steps. It also demonstrates how to create the settings for 
the Response Grid, an option especially helpful to sessions with infrared keypads that gives 
participants confirmation that their responses were received.

Before You Begin

Chapter 4 discusses the response devices you set up before you begin. Find information on getting 
the response devices ready in Chapter 4: TurningPoint Device and Settings Management.
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If you are using Response Card devices the vPad or the Web vPad response device software, you 
can use the Polling Test feature to test TurningPoint’s ability to successfully receive the response. 
Find information on Polling Test in Chapter 4: TurningPoint Device and Settings Management. 

If you want to track responses, you must have also created a Participant List using the Participant 
List Wizard. Without a Participant List, the session collects anonymous responses. Find information 
on participant lists in Chapter 5: Track Participants and Teams.

Step by Step Instructions To create the settings for the presentation session…

1 From the PowerPoint menu, 
select File > Open.

A window opens and displays the available files.

2 Select the TurningPoint 
presentation to be used, and 
select the Open button.

The file’s contents are visible in the PowerPoint window. You 
can use the TurningPoint toolbar to clear any previous results 
data and identify the use of response devices and a 
Participant List.

3 From the TurningPoint 
toolbar, select Reset > 
Session.

Reset Sessions

Prior to starting the presentation session, you must clear all 
prior audience responses that are stored in memory. 

If you select Reset > All Slides, new data is appended to the 
end of the session without resetting the entire session. If you 
select Reset > Current Slide, you remove values for the 
current slide without removing the data from the session.

TurningPoint displays a window instructing you to wait until all 
responses have been cleared before continuing with your 
slide show.
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4 Optionally, from the 
TurningPoint toolbar, select 
the Response Device menu 
and select an option for 
testing the presentation.

Response Device Selection

Response Devices is the default setting. TurningPoint allows 
you to select how responses will be provided during the 
presentation. Your choices are:

• Response Devices—a response device will be used 
during the presentation. The response devices must have 
been set up as outlined in Chapter 4: TurningPoint 
Device and Settings Management.

• Keyboard Keys 0–9—you will provide input to the 
presentation using the keyboard, keypad, or number 
keys.

• Simulated Data—TurningPoint provides random 
responses to the presentation. TurningPoint determines 
the number of responses to provide based on the number 
of expected devices designated in settings. i.e. If you 
enter expected devices as 100, TurningPoint will provide 
up to 100 responses to each question in your 
presentation. Find more information on expected devices 
in Manage Response Device Settings on page 171.

5 From the TurningPoint 
toolbar, select the Participant 
List Button and choose the 
Participant List to be used 

A task pane appears to the right listing the available Participant 
Lists. The default Participant List is shown as Anonymous. 
TurningPoint shows all Participant Lists available in the 

Note Always use the Response Devices default 
setting for an actual presentation. Select 
Keyboard Keys 0-9 or Simulated Data when 
testing a presentation.
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Participants folder. Participant lists located on the desktop or 
in other folders are not displayed.

Participant List Selection

The default setting is Anonymous or Auto. If Auto is selected, 
response Device IDs and participants’ choices are collected 
without a participant list. If Anonymous is selected, only 
participants’ choices are collected. 

Note You can change the default participant list 
setting to Auto or Anonymous using the 
Default Participant setting, a presentation-
level setting. Find more information on 
modifying settings in TurningPoint Device 
and Settings Management on page 153.
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6 Select Use Selected List 
button.

TurningPoint will use this list when you run your interactive 
presentation.

Participant List Selection: Use Selected List
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7 From the TurningPoint 
toolbar, select Tools > 
Settings (Hint: it looks like a 
pair of eyeglasses). In the 
window, select the 
Presentation from the 
Settings Hierarchy.

The TurningPoint Settings window opens.

Settings Window

Use these settings to establish the settings for the entire 
presentation. You can establish the settings for a specific 
slide or answer by selecting the Slide or Answer, respectively, 
from Settings Hierarchy.(Find more information about 
modifying settings in TurningPoint Device and Settings 
Management on page 153.) 

If infrared keypads are used, it is recommended that you use 
a Response Grid, which gives participants confirmation that 
their responses are received. The Response Grid is 
unnecessary with radio frequency, vPad and Web Pad 
devices because confirmation displays right on the device. 
The following settings affect the presentation and style of the 
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Response Grid that can be shown during an interactive slide 
show. 

Response Grid

These settings affect what is displayed in each box of the 
Response Grid. 

• Display Device IDs—select True to include the deviceID 
field in the Response Grid.

• Display Participant Names—select True to display the 
participant’s name in the Response Grid.

• Display Device Numbers—select True to display the 
response ID number.

These settings affect how the Response Grid is displayed.

• Grid Opacity—enter a percentage to identify how opaque 
the Response Grid should be when opened.

• Grid Position—choose a selection from the menu to 
identify where the Response Grid should be positioned on 
the screen. The selections include Top, Bottom, Left, 
Right, Center, TopLeft, TopRight, BottomLeft, and 
BottomRight.

Note A Response Grid is specifically 
recommended to use with infrared keypads 
to give participants confirmation that their 
responses are received. Other options for 
tracking responses, such as a Response 
Counter or Response Table, are located in 
the Insert Objects menu. Find information on 
these objects in Add Objects on page 128.
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• Grid Rotation Interval—enter the number of seconds 
per interval the Response Grid takes to rotate through 
responses, for when there are too many participants to 
fit in one grid.

• Grid Size—identifies how wide and tall the Response 
Grid should be when displayed on the Response Grid. 
The height and width are measured in pixels. The 
default setting is 800 x 600 (or full screen).

• Use Scheme Colors—Determines if Scheme Colors, as 
established in Chart Settings, or Custom Colors will be 
displayed on the Response Grid.

Next Steps

After establishing the settings, you are now ready to run the presentation.

Run the Slide Show

Use PowerPoint’s Slide Show functionality to run your interactive presentation. TurningPoint 
accepts responses provided by your audience, presents the results of the responses, and stores the 
responses in memory. You either save the responses to a file or clear the memory.

Before You Begin

To run the slide show, you must first perform the steps listed under Establish Presentation Settings 
to create the settings for your presentation session.

Step by Step Instructions To run the interactive presentation…

8 From the PowerPoint ribbon, 
select the Slide Show tab.

This displays a menu of slide show options. 
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9 In the Start Slide Show 
section, select From the 
Beginning.

The first slide of the presentation is shown. TurningPoint 
displays the Showbar in the top right corner of the screen. The 
Showbar is a toolbar that provides activation buttons for polling, 
monitoring, and viewing responses during the slide show.

Showbar

Right-click on the Showbar and move your cursor across the 
Showbar to display each command’s name. To activate the 
command, you can select the Showbar icon or use the 
respective Fn key on your keyboard. Use the commands on the 
Showbar as follows:

F9-Show/Hide 
Showbar 

Closes the Showbar for the 
duration of the current 
presentation session.

F2-Toggle 
Results

Changes the values displayed on 
each chart. The values can be 
represented as either numbers or 
percents.

F3-Data Slicing Shows the responses on the chart 
for the portion of the audience who 
chose a certain response on 
another question.

F6-Show the 
Original Chart

Use this command after using the 
Toggle Results or Data Slicing 
commands to return the chart to its 
appearance when it was first 
created.

F4-Repoll 
Question

Clears the responses and accepts 
new responses from the audience 
for the currently displayed 
question. Both the original 
responses and the new responses 
are stored in the session file.
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F7-Show the 
Response Grid

Opens a Response Grid on the 
screen allowing you to see which 
participants have responded to the 
question.

The size, location, visual display 
and contents of the grid are 
controlled using the controls in the 
Presentation Settings. Find more 
information about settings in 
Establish the Presentation 
Settings on page 317.

F8-Show Non-
Response Grid

Opens a Response Grid on the 
screen. As each participant 
responds, their response box is 
removed from the grid.

F10-Go to Next 
Slide

Advances the slide show to the 
next slide.

F12-Display 
Participant 
Monitor

Opens the Participant Monitor. 
Find more information in the Using 
the Participant Monitor section.

F5-Insert Slide Opens a drop-down menu allowing 
you to select the slide type to be 
inserted into the presentation.

Display 
interactive 
results

Expands the Showbar to display 
the responses, user responses, 
and polling status. 

Press for 
moveable 
Showbar

Allows the Showbar to moved 
anywhere on the Screen.
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10 Click the mouse to control the 
progress of the slide show. 

The control of each slide will vary slightly depending on the 
objects you choose to insert when you create the slides. Find 
information on slide objects and their behavior in Add Objects 
on page 128.

Optionally, you can press the Spacebar, Enter, or Right-Click 
and select next on the shortcut menu to control progress.

a Open polling. Polling will 
automatically open when 
you display a slide.

TurningPoint receives responses when polling is open.

Polling Open

b Click a second time to 
close polling and display 
the results.

No responses are accepted when polling is closed.

Polling Closed

c Click again to advance to 
the next slide.

11 Click at the end of the slides 
to exit from the Slide Show 
(or optionally, press the Esc 
key).

If you exit the program, TurningPoint prompts you to name and 
save the session results to a file. The default location is My 
Documents > TurningPoint > Sessions. TurningPoint adds the 
date and time to the file name.

For every session, TurningPoint automatically creates a backup 
copy and stores it at My Documents > TurningPoint > Sessions 
> Backup.

You can set TurningPoint to automatically delete old backup 
sessions using the Backup Maintenance setting, a presentation-
level setting. In the Backup Maintenance field, enter the number 
of days you want to keep files. TurningPoint will eliminate 
backup sessions created before that time. Find more 

Note To advance slides, you may use any method 
PowerPoint allows, such as clicking the mouse 
or pressing the space bar, arrow keys, or Enter 
key.
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information on modifying settings in TurningPoint Device 
and Settings Management on page 153

View Polling Status

TurningPoint provides three mechanisms to see how many participants have responded to the 
question when polling is open. You can expand the Showbar to see how many responses are 
received. You can display a Response Grid. Or, you can open the Participant Monitor to see the full 
details of the audience response.

This section describes using the expanded Showbar and the Response Grid to view participant 
results. Find more information about the Participant Monitor in Use the Participant Monitor on 
page 330.

Step by Step Instructions To view the polling results…

1 On the Showbar, select 
Display Interactive Results. 

The Showbar expands to display three additional regions that 
show the polling status. After everyone submits a response, 
the number in the Responses column equals the total number 
of participants.

Showbar Expansion

Tip Store your session file in the Sessions folder 
suggested by TurningPoint to allow the session 
file to be used again by TurningPoint to restart 
sessions or generate reports. Find information 
about reports in Reports on page 341.

i-Display 
interactive 
results

Expands the Showbar to display the 
responses, user questions, and polling 
regions. The Showbar also becomes fully 
visible on the slide.
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This step may meet all your needs for viewing polling status. 
You also have the option to use the Response Grid explained in 
step 2, especially if you use infrared keypads.

2 Optionally, display a 
Response Grid during the 
session. From the Showbar, 
select the Show Response 
Grid button.

The Response Grid is a grid that is overlaid on a slide during the 
presentation and indicates which individuals enter responses. 
Similarly, the Non-Response Grid indicates which participants 
have yet to respond. Specifically helpful to participants using 
infrared devices, these grids give the participants confirmation 

Responses Identifies the number of responses received 
from the audience. This area is not visible 
when the slide show starts.

User 
Feedback

With vPad devices, shows the typed 
questions. With ResponseCards, shows the 
presses of the question mark key.

Polling Identifies whether polling is open or closed. 
The background of this region is green 
when polling is open and red when closed. 
This area is not visible when the slide show 
starts.

Note A Response Counter or Response Table are 
two other options for viewing polling status that 
can be added when you create the slides, 
before you run the presentation.
The Response Counter shows how many 
participants have responded, while the 
Response Table, which can be fixed or rotating, 
shows who has responded. A fixed table 
displays all the participants, ideal for groups 
with 40 or fewer participants. The rotating table 
is best for very large groups and displays 
participants in sets of 40.
Find information about inserting objects in 
slides in Add Objects on page 128.
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that their responses were received. Radio frequency, vPad 
and Web vPad devices display confirmation right on the 
device.

Response Grid

The Response Grid can be shown or hidden at will by 
selecting the Show Response Grid button. An interactive slide 
displays a Response Grid when the question is first presented 
and automatically removes the grid from the slide that shows 
the tabulated results. 

3 After polling closes, click the 
mouse to advance to the next 
slide.

Viewing the polling status becomes disabled in the Showbar 
until you activate another poll. If you want to always display 
the Showbar expansion, set the Expand Showbar setting to 
True. Expand Showbar is a presentation-level setting. Find 
more information about modifying settings in TurningPoint 
Device and Settings Management on page 153.

Use the Participant Monitor

The Participant Monitor shows which participants have responded to a question and displays details 
about the responses, such as the percentage of correct responses, how long participants took to 
respond, and which answers they picked. Use of the Participant Monitor is optional, but it is helpful 
if you would like to keep track of how people are responding during your presentation.
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You can access the Participant Monitor from either the Showbar, while the slide show is running, or 
from the TurningPoint toolbar under the Participants drop-down menu, after you end the slide show. 

Step by Step Instructions To monitor participants…

1 While running the slide show, 
from the Showbar select the 
Display Participant Monitor 
button.

Alternatively, you can display the Participant monitor after 
running a slide show by selecting Participants > Display 
Participant Monitor from the TurningPoint toolbar.

Showbar Expansion: Display Participant Monitor

TurningPoint opens the Participant Monitor window. 

Participant Monitor Window

Note If you want to limit the Participant Monitor to 
your eyes only, then you can set up a second 
monitor for displaying it. Find information about 
setting up a second monitor in Windows Help 
Chapter 4: TurningPoint Device and Settings 
Management. 
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The window displays Question, Participant and Individual 
details about each participant’s response and the percentage 
of correct answers.

Participant Monitor Window: Question Region

Lists the specific responses chosen by the participant 
selected in the Participant region

Participant Monitor Window: Participant Region
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Gives details about the response results for each participant for 
the question selected in the Question region.

Participant Monitor Window: Individual Region

Lists each question and totals the correct responses and point 
values per question. Select a question to view details pertaining 
to it in the Individual region.

2 You can hide one or more of 
the three regions by selecting 
the close button (X) in the 
upper right corner. To view a 
region you have hidden, 
select it from the View menu 
in the Participant Monitor 
window. 

When viewing the Participant Monitor while running the slide 
show, advancing to the next slide will hide the Participant 
Monitor window. To view the window again, press the F12 key. 
(Alternatively, you can also press the Alt + Tab keys, or simply 
end the slide show.)

3 You can expand or reduce 
the size of the three regions 
by selecting the borders and 
dragging them up or down. 

When viewing the Participant Monitor while running the slide 
show, advancing to the next slide will hide the Participant 
Monitor window. To view the window again, select the View 
Participant Monitor icon.
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Add Slides During a Presentation Session

TurningPoint gives you the flexibility of adding a template or custom slide while running the 
presentation. Inserting a new slide is an option available at your fingertips through the Showbar. 

Step by Step Instructions To add a new slide…

1 Insert a new slide in one of 
the following ways:

• Template Slide - select the 
arrow next to the Insert 
Slide button on the 
Showbar and select the 
type of slide and skip to 
step 3.

A drop-down menu opens from the Showbar allowing 
you to select the slide type to be inserted into the 
presentation.

Showbar Expansion: Insert a Template Slide

• Custom Slide - select the 
Insert Slide button on the 
Showbar and go to step 2.

 Showbar Expansion: Insert a Custom Slide
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The Custom Question window opens to display the fields 
for typing the question and answer choices to be used on 
the interactive slide.

 Insert Slide: Custom Question

2 If you chose to create a 
custom slide, type the 
question in the top region of 
the window. Type the answer 
choices in the lower region, 
separating each answer with 
a line break.

 Insert Slide: Custom Question
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3 Select the Insert Add button. A new interactive slide appears, after the slide you had been 
viewing, displaying the new question. 

Data Slicing (View Results by Question)

After receiving response data, TurningPoint can cross-reference the responses of one question to 
another set of responses. This function, called data slicing, is particularly useful for analyzing 
demographic information. For example, you can find out whether a certain age group in the 
audience prefers a certain type of music. By asking participants to identify their age group in one 
question, and later asking them to pick their favorite type of music, you use data slicing to find out 
how many young adults in the crowd prefer jazz, how many seniors prefer classical music, and so 
on.

Before You Begin

To measure demographic information, insert a question slide early in the presentation that asks the 
audience to identify themselves in a demographic category, such as an age group or gender.

Note If you would like to reuse the presentation with 
the newly added slide, save the file. From the 
PowerPoint menu, select File > Save As. If you 
forget, TurningPoint asks you before closing.

Note To use demographic information in reports, 
identify a slide with a demographic question in 
the TurningPoint settings at the slide level. Set 
the Demographic setting to True. Find more 
information in TurningPoint Device and 
Settings Management on page 153 and 
Reports on page 341.
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Step by Step Instructions To use data slicing…

4 Run the presentation. (From 
the PowerPoint ribbon, select 
the Slide Show tab. In the 
Start Slide Show section, 
select From the Beginning.)

5 Use the arrow keys to go to 
the primary question slide 
whose data you want to slice.

For the example, to find out whether a certain age group in the 
audience prefers a certain type of music, you would go to the 
question slide that asks participants to select a favorite type of 
music. 

6 From the Showbar, select the 
Data Slicing button.

The Data Slicing window opens and displays a list of all 
questions from the interactive slides followed by their answers. 

Showbar Expansion: Data Slicing
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7 Select the answer whose 
data you wish to reference in 
the primary question slide. 

The default selection is the first answer in the first question 
slide. For the example, to find out how many young adults 
prefer each type of music, you would select the 18–35 age 
range.

Data Slicing

8 Select the Select button. TurningPoint retabulates the data to show the new 
distribution. Instead of viewing the results for the entire 
audience, you see the distribution for only the participants in 
the audience who submitted the selected answer. 

After you have displayed a data slice, you can select a 
number on the keyboard corresponding to an answer to see 
the slice associated with that answer. You can also cycle 
through groups that have responded by pressing the G key. 
When finished viewing the data slices, press the F6 key to 
return to the original chart.

9 To return the chart to its 
original data, press the F6 
key.
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Where Do I Go From Here?

This chapter has demonstrated how to run and manage presentations.

You are now ready to begin reviewing reports and understanding presentation data. You can find 
information in Chapter 8: Reports.
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Turning Reports allows you to view, export, and print a wide variety of reports based on the responses 
you received during your TurningPoint and TurningPoint Anywhere sessions. The reports are Word or 
Excel files with information about the questions and answers, participants, and responses gathered in 
your presentation. The Report Wizard Turning Reports displays a hierarchical menu of reports 
organized by category, such as Results by Question Reports and Demographic Reports. If you 
double-click on one of these categories, the Report Wizard Turning Reports screen displays 
subheadings of specific report titles, including Graphical Results by Question and Demographic 
Comparison, and also shows samples of each selected report.
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View a Report

You can create reports using Turning Reports available in the Tools menu in the TurningPoint 
toolbar.

This section describes how to:

• View a Report

View a Report

Use Turning Reports to generate reports.

Before You Begin

Create a session file by running a presentation session and saving the file. Find more information in 
Chapter 7: Run Presentations.
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Step by Step Instructions To view a report…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Turning Reports

2 Select Turning Reports from 
the Tools menu.

The Turning Reports window opens, displaying two tabs: 
Sessions and Reports.
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3 Select the Sessions tab. The Turning Reports window displays a list of the session files 
in your Sessions folder.

Turning Reports: Select Session

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 385.

You can also import a session using the Import Session 
button (shaped like a folder) above the list of files. This allows 
you to use a TurningPoint or TurningPoint Anywhere session 
file you have copied from elsewhere.

4 Choose a session file. You may choose a session file in one of the following ways:

• Select the Current Session (in red text) to use the 
session currently open in PowerPoint

This option is available only if you have a TurningPoint 
presentation open and response data has been 
collected.

• Select a session file from the list of files in your 
Sessions folder.
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To display the session files from your Sessions folder in 
the list of files, select My Session Files. Press F5 to 
refresh the sessions list

• Select a session file from your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files. Press F5 to refresh the 
sessions list.

• Import a session file from another location.

Use the Import Session button to open a file dialog to 
locate and select the session file.

5 Select the Reports tab once 
you have selected a session 
file.

The Turning Reports window displays a list of the categories of 
reports you can generate from your session file.

Turning Reports: Generate Reports

Each category of report is listed by name. You can double-click 
the category or click on the plus sign beside the category to view 
a list of reports in each category. The icon beside the report 
name indicates whether it generates an Excel file or a Word file. 
Some reports are available in both forms.
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When you select a report, you can see a sample preview of 
the report on the right-hand side of the Turning Reports 
window.

6 Select the type of report(s) 
you would like to generate by 
selecting the check box next 
to the report name.

Find more information in Reports on page 341.

You can select multiple reports by selecting multiple check 
boxes. You can also select an entire category of reports by 
selecting the check box for the category.

You can select to change numeric responses to alphabetic 
responses by checking the Change numeric responses to 
alphabetic responses check box.

Click Change Numeric Responses...
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Depending on the type of report you select, the Include Page 
Breaks check box may be displayed below the report preview.

Include Page Breaks

7 Specify whether to include 
page breaks in the report by 
checking the Include Page 
Breaks check box (if 
available).

If you check the box, TurningPoint will create page breaks at 
convenient places in the report for ease of printing.

8 Select the Generate Report 
button.

TurningPoint creates the report and opens it in Microsoft Excel 
or Word.

This may take some time, especially if there are a large number 
of questions or participants in the session.

You can generate as many reports as you like. When one report 
is finished being created, select another type of report from the 
list and select the Generate Report button again.
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9 When you are finished 
creating reports, the Exit 
button to close the Turning 
Reports window. 

Next Steps

You can use Excel or Word to edit, save, or print the reports.
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Types of Reports

This section describes:

• Results by Question Reports (2 Reports)

• Demographic Reports (2 Reports)

• Participant Results Reports (4 Reports)

• Results by Participant Reports (4 Reports)

• Participant List Reports (2 Reports)

• Standards Reports (3 Reports)

• Comparative Scoring Reports (2 Reports) 

• Team Scoring Reports (2 Reports) 

• Percentile Reports (2 Reports) 

• Other Reports (8 Reports)

• Attendance Report

• Moment to Moment Report

• Outline Report

• Participant Questions and Comments Report

• Ranking Summary Report

• Response Data Export Report

• Results by Group Report

• Statistics Report
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Results by Question Reports
The Results by Question and Graphical Results by Question Reports show a summary of 
responses for each question. Each of these reports creates an Excel file.

Results by Question Report This report includes the following information for each 
question:

• the answers

• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

Results by Question Report

Graphical Results by
Question Report

This report includes the following information for each 
question:

• the answers
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• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

• Pie chart with a percentage of the responses per answer

Graphical Results by Question Report
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Demographic Reports
The Demographic Comparison and Graphical Comparison Reports show a summary of responses 
for each question broken down by demographics. Each of these reports creates an Excel file.

Demographic Comparison
Chart

The Demographic Comparison includes the following 
information for each question:

• the answers 

• indication of the correct answers

• the number of responses for each answer from each 
group

• the total number of responses from each group

• demographically categorized response data on a per 
question basis

• number of people who answered each question 
correctly

Demographic Comparison Chart
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Graphical Comparison Chart The Graphical Comparison includes the following information 
for each question:

• the answers

• an indication of the correct answer(s)

• the percentage of responses for each answer from each 
group

• a vertical bar chart of the responses for each answer from 
each group

When generating the Graphical Comparison Report, you have 
the option of creating page breaks between each question.

Graphical Comparison Chart



354 Turning Technologies

Chapter 8: Reports

Participant Results Reports
The Participant Results, Graded Participant Results (correct/incorrect), Graded Participant Results 
(point values), Graded Participant Results (ratio) Reports show a summary of responses for each 
question. When generating the you have the option of displaying the entire question or excluding 
the question text. Each of these reports creates an Excel file.

Participant Results Report The report includes the following information for each 
participant: 

• device number 

• fields defined in the participant list

• the numerical value of the participant’s response to 
each question

Participant Results Report

Graded Participant Results
(correct/incorrect) Report

The report includes the following information for each 
participant: 



TurningPoint User Guide 355

Types of Reports

• device number 

• fields defined in the participant list 

• the numerical value of the participant’s response to each 
question

• an indication of whether the response is correct or 
incorrect

• total percent correct 

Graded Participant Results (correct/incorrect) Report

Graded Participant Results
(point values) Report

The report includes the following information for each 
participant: 

• device number 

• first and last name (if specified in the Participant List) 

• the numerical value of the participant’s response to each 
question
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• an indication of whether the response is correct or 
incorrect

• the total number of points 

Graded Participant Results (point values) Report

Graded Participant Results
(ratio) Report

The report includes the following information for each 
participant: 

• device number 

• first and last name (if specified in the Participant List) 

• the numerical value of the participant’s response to 
each question

• an indication of whether the response is correct or 
incorrect
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• the ratio or correct to incorrect answers for each question 

Graded Participant Results (ratio) Report
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Results by Participant Reports
The Results by Participant Report shows a summary of responses for each question for each 
individual participant. This report creates an Excel file.

When generating these reports, you have the option of creating page breaks between each 
participant’s section.

Results by Participant Report The report includes the following information for each 
participant for each question:

• the question

• the numerical value of the participant’s response

• an indication of whether the response is correct or 
incorrect

• the correct answer

Results by Participant Report
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Results by Participant
(Answer Detail) Report

The Answer Detail Report includes a complete list of answers 
for each question. This list enables you to match the numerical 
value of the participant’s response (number 1 or 2, etc.) to the 
actual answer (e.g. yes or no) and highlights the correct answer 
in green. This report also shows whether responses are correct 
or incorrect by marking them with a ‘c’ or an ‘i.’

Results by Participant (Answer Detail) Report

Results by Participant
(Response Detail) Report

The Response Detail Report includes the question along with 
the participant’s response. This report displays correct answers 
in green and incorrect answers in red and calculates the 
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percentage of correct answers and the total points 
accumulated by each participant.

Results by Participant (Response Detail) Report



TurningPoint User Guide 361

Types of Reports

Results by Participant (Score
Detail) Report

The Score Detail Report calculates the percentage of correct 
answers and total points accumulated by each participant. 

Results by Participant (Score Detail) Report
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Participant List Reports
The Participant List Reports show the participant data from the Participant List in either a Word file 
or an Excel file. 

Participant List (Word)
Report

The report shows device number and any of the fields defined 
in the Participant List (name, contact information, 
demographic groups or teams, etc.).

Participant List (Word) Report
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Participant List (Excel)
Report

The report shows device number and any of the fields defined 
in the Participant List (name, contact information, demographic 
groups or teams, etc.).

Participant List (Excel) Report
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Standards Reports
The Overall Standards, Individual Standards, and Group Standards Reports show response 
information based on standards identified for each question. These reports create Excel files.

Overall Standards Report The Overall Standards Report is very similar to the Results by 
Question Report but includes additional information relating to 
standards. It includes the following information for each 
standard:

• the percentage of overall comprehension for all 
questions that are associated with the standard

• the questions associated with the standard

• the answers for each question

• an indication of the correct answer(s)

• the number of responses for each answer

• the percentage of responses for each answer

Overall Standards Report
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Individual Standards Report The Individual Standards Report includes the following 
information for each individual participant for each standard:

• the participant’s percentage of comprehensive for all 
questions that are associated with the standard

• the questions associated with the standard

• the answers for each question

• an indication of the correct answer(s)

• an indication of the participant’s response and whether it 
was correct

Individual Standards Report

When generating the Individual Standards Report, you have the 
option of creating page breaks between each participant’s 
section.
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Group Standards Report The Group Standards Report displays the percentage of 
correct responses from each group for each standard.

Group Standards Report
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Comparative Scoring Reports
The Individual Scoring and Scoring Distribution Reports show a summary of scoring information 
based on participant responses in comparison to other participants. Each of these reports creates an 
Excel file.

Individual Scoring Report The Individual Scoring Report includes the following information 
for each participant:

• numeric response labeled correct or incorrect 

• percent scores

• whether the participant’s score puts him/her above or 
below the class average 

Individual Scoring Report

Scoring Distribution Report The Scoring Distribution Report includes the following 
information: 
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• the total number of participants

• the score ratios for assessment (number of correct 
answers to question)

• the number of participants achieving each score ratio

• the answer value (correct, incorrect, no value)

• acceptable answer choices

• number of responses each answer received

Scoring Distribution Report
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Team Scoring Reports
The Team Scoring (Percentage) and the Team Scoring (Points) Reports show overall team results, 
the correct answer for each questions, the number of responses per answer for each question, results 
for each question and the correct answer highlighted in green. While generating these report, you 
have the option to exclude response detail. Each of these reports creates an Excel file.

Team Scoring (Percentage)
Report

The Team Scoring Percentage Report includes the following 
additional information:

• the answers

• the overall percentage of questions each team answered 
correctly

• the percentage of team members that answered each 
question correctly

Team Scoring (Percentage) Report
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Team Scoring (Points) Report The Team Scoring Points Report includes the following 
additional information:

• the answers

• the total points accumulated by each team 

• the points each team received for every question

Team Scoring (Points) Report
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Percentile Reports
The Percentile (correct/incorrect percentage) and Percentile (points) Reports show how participants’ 
responses compared to other participants’ responses, Device ID, first and last name, and the 
percentile ranking for each participant against other participants. You can change the percentiles 
shown by recording the new percentiles separated by a semicolon in the appropriate box. Each of 
these reports creates an Excel file.

Percentile (correct/incorrect
percentage) Reports

The Percentile (correct/incorrect percentage) Report includes 
the following additional information:

• the total percentage of questions each participant 
answered correctly 

Percentile (correct/incorrect percentage) Reports

Percentile (points) Report The Percentile Points Report includes the following additional 
information:
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• the total accumulated by each participant

Percentile (points) Report
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Other Reports
TurningPoint offers eight unclassified reports: Attendance, Moment to Moment, Outline, Participants 
Questions and Comments, Response Data Export, Ranking Summary, Results by Group, and 
Statistics Reports. 

Attendance Report The Attendance Report provides basic participant information, 
including name and Device ID, and shows has attended the 
presentation.

Attendance Report
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Moment to Moment Report Moment to Moment Report shows a chart of the moment to 
moment rating results. This report creates an Excel file.

Moment to Moment Report

Outline Report The Outline Report gives an outline of slide questions and 
answers in a Word file. The outline include an indication of the 
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correct answer(s). This report is found under the Other Reports 
category.

Outline Report
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Participant Questions and
Comments Report

The Participant Questions and Comments Report shows any 
comments or questions sent by vPad participants during the 
presentation. This report creates an Excel file.

Participant Questions and Comments Report

Ranking Summary Report The Ranking Summary Report shows a summary of Ranking 
Slides. The report creates an Excel file. 

The Ranking Report includes the following information:

• a list of the ranking criteria

• a list of the ranked items and the rank assigned for each 
criterion
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• the chart showing the ranking

Ranking Summary Report
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Response Data Export Report The Response Data Export Report gives the raw response 
data in an Excel file. It creates a table of values in Excel giving 
the numerical response values for each device number.

Response Data Export Report

Results by Group Report The Results by Group Report shows a summary of correct 
responses for each question by demographic groups. This 
report creates an Excel file.

The report includes the following information for each 
question:

• the answers

• an indication of the correct answer(s)
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• the percentage of correct responses from each 
demographic group

Results by Group Report
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Statistics Report The Statistics Report shows the overall correct percentage 
per participant versus mean, median and mode. This report 
creates and Excel file.

Statistics Report
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Where Do I Go From Here?

This chapter has introduced the various report types, and has demonstrated how to view these 
reports.

You are now ready to begin managing sessions. You can find information in Chapter 9: Sessions.
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TurningPoint creates session files whenever your run a TurningPoint presentation. When you save a 
session, a default TurningPoint setting automatically includes the PowerPoint presentation with your 
TurningPoint file. You have the option to exclude the PowerPoint presentation from the TurningPoint 
session file. This function allows you to save only the TurningPoint results data without the 
presentation slides. If you do NOT wish to include the PowerPoint presentation in your TurningPoint 
session file, navigate to the Settings menu and, under the Misc heading, change ‘Include 
Presentation’ from True to False. 

The session results are stored temporarily during a session. You can save the session results to a file 
to access them later. This chapter provides instructions to access and manage your TurningPoint 
sessions through Turning Reports. In addition to Turning Point sessions, Turning Reports allows you 
to access and manage TurningPoint Anywhere sessions.
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Recall the five steps to presentation success:

Five Steps to Success

This chapter discusses how to save and manage sessions. 
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Manage and Edit Sessions

With TurningPoint, you can stop and save a session, and pick up where you left off at a later time. You 
can also use a TurningPoint setting to create back-up files of your session. Knowing how to save, 
resume, and delete a session gives you greater flexibility during your presentation.

This section describes how to: 

• Save Results from a Session

• Changing the Default Save Location

• Continue a Previously Saved Session

• Edit Session Data

• Delete Results from a Session

Save Results from a Session

TurningPoint can quickly save a session so it is available for retrieving the results or resuming the 
session later.

Before You Begin

Identify a reliable location on the computer or on a data storage device where you would like to save 
the presentation. 

Step by Step Instructions To save a session…

1 From the Slide Show view, 
right-click the screen. Select 
End Show.

TurningPoint concludes the presentation.

Save Session
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2 From the TurningPoint 
toolbar, select the Save 
Session button. (Hint: the 
icon is a disk.)

TurningPoint displays the Save Session window that shows 
the file name, file type, and where the file will be saved. The 
default location is My Documents > TurningPoint > Sessions. 
TurningPoint adds the date and time to the file name. 

Customize the Save in and the File Name fields to edit the 
location and file name, if you wish to change the default 
settings. To permanently change the default location, go to 
Changing Default Location on page 260.

3 Select the Save button. TurningPoint saves the file in the designated location.

Changing the Default Save Location

Change the default save location for your TurningPoint folder. This includes your session files, 
participant lists, and standards.

Before You Begin

Identify a reliable location on the computer where you would like to save your TurningPoint 
documents.

Note TurningPoint can save an automatic backup file 
of your session. To enable Real-time Backup, 
navigate to the Settings menu, select the 
Settings tab, select Presentation from the 
Settings Hierarchy, and select all settings. 
Then, under Backup Settings, select Real-time 
Backup Path and designate a location where 
the backup file should be stored. After you 
designate the location, it will be listed in the 
Settings menu beside Real-time Backup Path. 
Find more about change the default Real-time 
Backup Path, go to Chapter 4: TurningPoint 
Device and Settings Management
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Step by Step Instructions To change the default save location…

1 In the TurningPoint Toolbar 
select Tools > Settings (Hint: 
It’s the one that looks like a 
pair of eyeglasses).

This displays the Settings window.

Settings Window

2 Select the Settings Tab form 
the Settings window.

3 Select Presentation from the 
Settings Hierarchy

File Location is the first setting listed under the Application 
Settings Heading
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4 Select the All Settings at the 
bottom of the Settings 
window.

Find the Misc Heading

Settings Window: Misc Settings

5 Under the Misc heading, 
Default Save Location, click 
on the file path.

A Default TurningPoint Save Path window appears. 

Default Save Location Window

6 Change the Save location. You can manually enter the location or click on the box to the 
right of the file path (box with ellipses) to display a Browse for 
Folder window. From the browser window, you can specify 
and existing folder location or create a new folder location.

Note You can restore your save location to the 
default settings by selecting Reset to default 
path from the Default TurningPoint Save 
Path window.
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7 Select Done. Your TurningPoint folder location has been changed.

Continue a Previously Saved Session

Resume your presentation using a saved session file. TurningPoint appends new session information 
to the opened session file, allowing you to save the polling results for the presentation in one file.

Before You Begin

If the session file is saved on an external storage device, insert the device into the computer. 

Locate the session you wish to open. On the computer that is running the presentation, the default 
location for saved sessions is My Documents\TurningPoint\ Sessions. 

Step by Step Instructions To continue a previously saved session…

1 From the TurningPoint 
toolbar, select the Continue 
Prior Session button. (Hint: 
the icon is an open folder.)

Continue Prior Session

TurningPoint displays the Continue Prior Session window that 
shows the file name, file type, and where the file is located. The 
default location is My Documents\TurningPoint\Sessions.

Note If you did not manually save your last session, 
TurningPoint automatically creates a backup 
copy and stores it at My Documents\ 
TurningPoint\Sessions\Backup.
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2 Navigate to the file you wish 
to open and select the Open 
button. 

TurningPoint opens the previously saved file.

Next Steps

From the PowerPoint menu, select Slide Show > View TurningPoint select. Use the arrow keys to 
find the slide you want to be your starting point. Continue presenting the session.

Edit Session Data

You can edit TurningPoint or TurningPoint Anywhere session data after the session is saved. You 
can choose to exclude a question, make a question demographic, or change answer values.

Step by Step Instructions To edit session data…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Session Management: Edit Session
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2 Select Session Management 
> Edit Session.

The Edit Session window opens, displaying a list of session files 
in your sessions folder. 

Edit Session Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 385.

You can also import a session using the Import Session button 
(shaped like a folder) above the list of files. This allows you to 
use a TurningPoint or TurningPoint Anywhere session file you 
have copied from elsewhere.

3 Choose a session file in one 
of the following ways:

• Select a session file from 
the list of files in your 
Sessions folder.

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog to 
locate and select the session file.
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4 Select the Next button to 
continue.

The Edit Session window displays options for editing the 
session file.

Edit Session Window: Edit Session

The window shows a list of all questions in the session. Below 
the list of question is a list of answers, which shows the 
answers for the question selected in the list above.

5 Uncheck the box next to any 
question in the list that you 
would like to exclude from the 
session.

Excluding a question will omit all data about that question 
from the session file.
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6 If you would like to change 
the question type or value, 
right-click on the question 
and select the desired option 
from the contextual menu 
that appears.

You can change the default Correct and Incorrect point values, 
or designate a question as demographic.

Edit Session Window: Change Question Value

Demographic questions can be used in reports. Find more 
information in Reports on page 341.

7 If you would like to change an 
answer value, right-click on 
the answer in the answer list 
and select an option from the 
contextual menu that 
appears.

You can mark the answer Correct or Incorrect, assign a point 
value, or clear the answer value (set to No Value).

Edit Session Window: Change Answer Value
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8 When you are finished 
making changes to the 
session data, select the Save 
Session button below the list 
of answers.

A dialog opens for you to specify a location and filename for 
the session file.

9 Specify a name and location 
for the exported file. 

10 Select the Save button. The file is saved and the dialog closes.

11 Select the Finish button to 
exit the Edit Session window.

Delete Results from a Session

You can use the same presentation to create a new set of responses. The Reset menu on the 
TurningPoint toolbar gives you the option of deleting the results in order to redo a session or 
present a new session. You also have the option to redo only one question slide in a session. You 
cannot undo the Reset function, so be certain that you wish to delete the results.

Before You Begin

If you want to view the results at a later time, save the presentation before proceeding with the 
following steps. 

Note You should use the file extension.tpz for 
session files.
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Step by Step Instructions To delete the results from a session or a single slide…

1 Open the presentation. To 
delete the results of one 
question only, the slide with 
this question should be in 
view.

2 From the TurningPoint 
toolbar, select the Reset 
menu.

The Reset menu opens offering the options to reset either the 
entire session, all the slides or simply the current slide. 

Reset Session

3 When you are ready to delete 
the results, select either 
Session, All Slides or Current 
Slide. 

Selecting Session resets the entire session. Selecting All Slides 
resets all of the slides. Selecting Current Slide resets the 
currently viewed slide only.

TurningPoint clears the results and sets the values to zero.

Note Be certain that you wish to delete the results! 
You cannot undo the Reset function for either 
the Session, All Slides or Current Slide options. 
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Where Do I Go From Here?

This chapter has demonstrated how to save, edit and manage sessions.

You are now ready to begin exporting information. You can find information in Chapter 10: Export.
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When you complete a session, you save the data in a TurningPoint session file (extension .tpz). Find 
more information on how to save a session in Save Results from a Session on page 385.

The session file contains all the information about your presentation, including the questions and 
answers, the response data, and the Participant List. This information is used to generate reports 
(find more information in Reports on page 341). 

Session files and can be merged with other session files and Participant Lists with other Participants 
Lists to show aggregated results from your presentations. TurningPoint also allows you to share and 
extract the information in your TurningPoint and TurningPoint Anywhere session files by exporting the 
data into several formats.

This section describes how to:

• Export Session Data 

• Export Results Data to a WebCT Server (Campus Edition 6.0 or Vista 3, 4)

• Export Results Data to a WebCT Server (Campus Edition 4.1)

• Merge Participant List

• Merge Session Files

• Extract Participant List

• Extract PowerPoint Presentation

• Extract Session Data as XML

• Email Session
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Export Session Data

You can export the data from a TurningPoint or TurningPoint Anywhere session file into a text file. 
You can use the text file to import the data into a variety of other applications.

You can choose to export the data from the session file in one of two ways:

• Export some or all of the session data to a text file where you determine the contents and format.

• Export the session data using a predefined scheme for certain gradebook applications.

Step by Step Instructions To export session data into a text file…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Session Management > Export Session Data

2 Select Session Management 
> Export Session Data. 

The Export Session window opens, displaying a list of session 
files in your Session Folder. 
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3 Select Export Session Data 
from the list of options.

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 385.

You can also import a session using the Import Session button 
(shaped like a folder) above the list of files. This allows you to 
use a TurningPoint or TurningPoint Anywhere session file you 
have copied from elsewhere.

4 Choose a session file in one 
of the following ways:

Export Session Data Window

• Select a session file from 
the list of files in your 
Sessions folder.

To display the session files from your Sessions folder in 
the list of files, select My Session Files. The Current 
Session will be displayed if you have a TurningPoint 
presentation open and response data has been collected.

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files.

• Import a TurningPoint or 
TurningPoint Anywhere 
session file from another 
location.

Use the Import Session button to open a file dialog to 
locate and select the session file.
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5 Select the Next button once 
you have selected a session 
file.

The Export Session window displays lists of the data and 
formats you can use to export the session file.

Export Session Data: Select Export Scheme or Data
Groups

6 Choose one of these two 
ways to export the data:

• Check some or all of the 
boxes in the Data Group 
list to manually specify the 
contents and format of the 
exported text file.

The following data is available for export:

• The text of questions and answers.

• Participant information, such as names and groups, 
defined in the Participant List.

• Participant’s responses to the questions.

• Participant’s scores.

• Check the Use Export 
Schemes box to select a 
pre-defined export scheme 
for a gradebook 
application from the Export 
Schemes list.

Export schemes for several gradebook applications are 
available, including Angel, Easy Grade Pro, Gradebook 
for Windows, Gradekeeper for Windows, MicroGrade, 
Moodle for use with Moodle Participant list and 
Teacher’s Marksheet.

Export schemes are saved as .tpx files in the Export 
Schemes folder, which is located in your TurningPoint 
folder. You can use an export scheme you have copied 
from elsewhere by selecting the Load an Export 
Scheme button (shaped like a folder).
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Using an export scheme automatically specifies the 
settings available to you in the next steps to match the 
format required by the application you are exporting to. 
You may still choose to modify some settings, to specify 
a grading scale, for example.

7 Select the Next button to 
continue.

The Export Sessions window displays a tabbed view for you to 
specify the data to be used.

Export Session Data: Include or Exclude Data—
Questions & Answers tab

There are four tabs, one for each of the main groups of data you 
specified whether to include in the exported file. In each area 
you chose to include, you should review and modify the settings 
on the corresponding tab. The next few steps explain the 
settings on each tab.

8 If you chose to include the 
question and answer data, 
specify which particular 
questions to include by 
checking the boxes on the 
Questions & Answers tab.

By default, all questions are checked and will be included.
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9 Select the Participant Info 
tab.

The Export Data window displays the Participant Info tab.

 Export Session Data: Include or Exclude Data—
Participant Info tab

10 If you chose to include the 
participant information, 
choose which fields from the 
Participant List to include by 
checking the boxes on the 
Participant Info tab.

To view the information from the Participant List, press the F5 
key or right-click in the window and select Refresh Participant 
List Data. This allows you to see the Participant List to help 
you decide which fields you would like to include in the 
exported data.

You can include the following participant information: 

• Device #

• Last and first names

• Device ID

• Student ID
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11 Select the Responses tab. The Export Data window displays the Responses tab.

Export Session Data: Include or Exclude Data—
Responses tab

12 If you chose to include the 
responses, choose whether 
to group responses by 
question or by participant by 
selecting Show Responses 
Horizontally or Show 
Responses Vertically on the 
Responses tab.

Show Responses Horizontally will group the response data by 
question in the exported file. Show Responses Vertically will 
group the response data by participant in the exported file.
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13 Select the Scores tab. The Export Data window displays the Scores tab.

Export Session Data: Include or Exclude Data—
Scores tab

14 If you chose to include the 
scores, specify the following 
settings:

• Select whether to calculate 
scores based on 
Correct/Incorrect values or 
based on point values.

If you base scores on Correct/Incorrect values, the 
percentage score is calculated by dividing the 
participant’s number of correct answers by the number 
of total answers. If you base scores on point values, the 
percentage score is calculated by dividing the 
participant’s number of correct answers by the point 
value you specify in the box provided.

• Select to show scores as 
percentages, as letter 
grades, as point values, or 
any combination by 
checking the boxes.

You may include any or all of these ways of 
representing the scores in the exported file.

• Specify the grading scale 
by selecting ranges for the 
letter grades from the 
drop-down menus.

The default ranges show a typical grading scale. You 
can alter the grading scale by selecting a new range. To 
change values upward (grade on a stricter scale), start 
from A and work your way down the list to specify the 
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ranges. To change values downward (grade on an easier 
scale), start from D and work your way up the list.

• Designate questions as 
bonus questions (not to be 
included in the score 
totals) by checking the 
boxes.

Questions you designate as bonus questions are not 
included in the total number of questions for calculating 
scores, but are included in a participant’s number correct.

15 When you have finished 
modifying the settings on the 
applicable tabs, select the 
Next button.

The Export Data window displays a set of settings for specifying 
the format of the exported file.

 Export Session Data: Select Format

There is an example entry at the bottom of the window showing 
a sample based on the settings specified. Observe this example 
as you change the format settings in the next few steps to 
ensure it matches your expectations.

16 Specify the order of the fields 
in the exported file by moving 
the fields up and down the list 
by selecting the Move Up and 
Move Down buttons.

Additionally, you can join two fields together or include blank 
fields in the exported file. Use the Insert A Blank Field and Insert 
a Join Field buttons below the list of fields to insert a join field or 
a blank field. You can move join fields and blank fields up and 
down the list just like the other fields.

A join field joins the previous field and the following field into a 
single field. You might wish to do this with the First Name and 
Last Name fields, for example.
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A blank field simply puts a blank separator between fields. 
Depending on how you will use the exported file, you may 
need to separate some data with blank fields.

17 Specify whether to create a 
delimited or fixed-width file.

A delimited file includes a “delimiter” between each of the 
fields. You can select a comma, semicolon, tab, space, or 
other delimiter.

A fixed-width file uses fields of a specified width (number of 
characters). You can choose a width for the fields.

The format you choose depends on how you will use the 
exported file.

18 Specify whether to use 
double quotes, single quotes, 
or no quotes to enclose the 
text in fields.

19 When you have finished 
modifying the settings for the 
format of the file, select the 
Next button.

The Export Data window displays the data in the format to be 
exported.

Export Session Data: Verification

Note You should use either double or single 
quotes for the text qualifier if you are 
exporting a fixed-width file or using spaces 
as delimiters in a delimited file. Without 
quotes, the field boundaries in the exported 
file will be impossible to interpret correctly.
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Below the data are two buttons. The first, shaped like a 
document and a disk, saves the export file. The second, shaped 
like a disk, saves the format as an export scheme you can reuse 
for other session files.

20 To save your export data, 
select the Save button 
(shaped like a document with 
a disk).

A dialog opens for you to specify a location and filename for the 
exported file.

21 Specify a name and location 
for the exported file.

22 Select the Save button. The file is saved and the dialog closes.

Optionally, you can also select the Save Export Scheme button 
(shaped like a disk) to create an export scheme you can reuse 
to save the data from other session files in the same format. 
Specify a location and filename for the export scheme in the 
same way.

23 Select the Finish button to 
exit the Export Data window.

If you forgot to save before selecting Finish, a message window 
opens containing ‘Are you sure you want to exit without saving 
an export?’ Select Yes to exit without saving the session file; 
select No to save before exiting.
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Export Results Data to a WebCT Server (Campus Edition 6.0 or 
Vista 3, 4)

If you are using WebCT CE 6.0/Vista 3, 4, follow the steps below to export results data. Instructors 
can perform the same functions; they can export results data from participants to an available 
WebCT server and send grade reports to their students via WebCT email. 

However, with WebCT CE 6.0/Vista 3, 4, instructors may select specific TurningPoint or 
TurningPoint Anywhere sessions to upload and then enter the name of the assignment and the 
maximum point value for responses.

Before You Begin

A gradebook, or similar file, should reside on the WebCT Server. TurningPoint exports and saves 
the results data to this file.
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Step by Step Instructions To export data to a WebCT 6.0/Vista 3, 4 Server…

1 From the TurningPoint 
toolbar, select Tools > 
WebCT Wizard > Campus 
Edition 6.0/Vista 3, 4. 

TurningPoint displays a window asking which task you would 
like to perform with the WebCT Wizard.

WebCT Wizard > Campus Edition 6.0/Vista 3,4

2 Select the button next to 
Export Student Data to the 
WebCT Gradebook/Email 
Student Reports.

WebCT Wizard: Select Task
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3 Select the Next button. TurningPoint displays the WebCT Log-In window.

4 Enter your login information. WebCT Wizard: Login

TurningPoint saves the Server Name (IP) and the Port 
Number. You must enter your username and password. The 
system prompts you for the Institution’s name and then 
displays all courses associated with your user name and 
password.

5 Select the Next button. TurningPoint displays a window asking you to select the 
institution you belong to.

6 Select your institution. WebCT Wizard: Select Institution
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7 Select the Next button. TurningPoint displays a window asking you to select the course 
to export data to.

8 Select the course you wish to 
export data to.

WebCT Wizard: Select Course

9 Select the Next button. TurningPoint displays a window asking you to select the session 
you wish to upload. 

10 Select the Session you wish 
to upload.

You can also import a session using the Import Session button 
(shaped like a folder) above the list of files. This allows you to 
use a TurningPoint or TurningPoint Anywhere session file you 
have copied from elsewhere.

WebCT Wizard: Select Session
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11 Select the Next button. TurningPoint displays an Export Preview/Options window 
asking you to enter the name of the assignment for the 
session and a maximum point value. 

12 Enter the name of the 
assignment and a maximum 
point value for responses.

WebCT Wizard: Export Preview/Options

You can also select the checkbox to email individualized 
reports to students through WebCT.

13 Select the Finish button. TurningPoint displays a confirmation message that the export 
was successfully completed.

14 Select the OK button. WebCT Wizard: Export Complete

You can now login to WebCT and view the results data in your 
Gradebook.
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Export Results Data to a WebCT Server (Campus Edition 4.1)

TurningPoint allows class instructors to quickly export results data from participants to an available 
WebCT server. With this function, instructors who test students through TurningPoint can easily save 
participants’ test scores for grading purposes. 

TurningPoint also lets instructors send grade reports to their students via WebCT email. Instructors 
enter their WebCT IDs and select the checkbox to email reports to students. Instructors can then view 
the sent mail and the new results that have been posted to the gradebook.

Before You Begin

A gradebook, or similar file, should reside on the WebCT Server. TurningPoint exports and saves the 
results data to this file. You must know the Column Name in this gradebook where the results data 
should be saved. The Column Name may have any title, but you must know the exact title and provide 
it to the WebCT Wizard.
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Step by Step Instructions To export results data to a WebCT 4.1 Server…

1 From the TurningPoint 
toolbar, select Tools > 
WebCT Wizard > Campus 
Edition 4.1. 

TurningPoint displays a window asking which task you would 
like to perform with the WebCT Wizard.

WebCT Wizard > Campus Edition 4.1

2 Select the button next to 
Export Grade Data.

WebCT Wizard: Select Task

3 Select the Next button. TurningPoint displays the WebCT Log-In window.
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4 Enter your login information. WebCT Wizard: Login

TurningPoint saves the Server Name (IP) and the Port Number. 
You must enter your username and password. The system 
prompts you for the Institution’s name and then displays all 
courses associated with your user name and password. 

5 Select the Next button. TurningPoint displays a window asking you to select the class 
for which you have new data.

6 Select the class to which you 
want to export data. The 
class should match the 
Participant List you used.

WebCT Wizard: Select Class

7 Enter the Column Name. The Column Name is the title of the column in the class 
gradebook to be used to store the scores for this particular 
activity or test. 
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8 Enter the Maximum Value for 
Column.

The Maximum Value for Column is the total possible score a 
participant could achieve for this particular activity or test or 
simply the maximum number of characters accepted. 

9 Select the Finish button. TurningPoint displays a confirmation message and then 
closes the WebCT Wizard window. The results data should 
now appear in the column you designated in the file on the 
WebCT server.
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Merge Participant List

Participant Merge allows you to combine multiple participant lists with multiple sessions of 
TurningPoint presentations to generate a report based on a common field (Student ID, Device ID, 
etc.). The report shows the the total scores of the sessions in an Excel file. 

Step by Step Instructions To merge Participant List…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Session Management > Participant Merge
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2 Select Session Management 
> Participant Merge (Excel).

This displays the Participant Merge window. 

Participant Merge Window

Initially, the left pane is empty. This is where your new column 
and sessions to be merged will be displayed. Above the left 
pane is the Available Fields for Merge drop-down box. Below 
the left pane is the Add Column text box and button.

The right pane displays all of the sessions available to be 
merged. Above the right pane are the Percentage Correct and 
Points radio buttons. 

3 Add a Column. TurningPoint displays the percentage correct or points in the 
added column when the sessions are merged. 

Participant Merge Window: Add Column
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4 Select the sessions you want 
to merge from the list of 
sessions.

Highlight the sessions and use the left (<) button to add the 
sessions to your column. Use the right (>) to remove sessions 
from your columns. 

Participant Merge Window: Select Sessions

Repeat steps 3 and 4 until you have created all of the columns 
you want added to the Participant Merge Report. 
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5 Alternately, remove all of the 
columns by selecting the 
button that looks like a trash 
can.

6 Select the Field you want to 
merge the Participants Lists 
under from the Available 
Fields for Merge.

The sessions will be merged based on the selected value. 
Only fields that are common between the participant lists will 
be available from the drop-down menu.

Participant Merge Window: Select Merge Field

7 Select whether the report 
should display Percentage 
Correct or Points.
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8 Select Merge. TurningPoint generates a report in an excel file. 

Participant Merge Report
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Merge Session Files

You can merge multiple TurningPoint or TurningPoint Anywhere session files together to create a 
single session file, from which you can generate reports and extract data.

This is especially useful if you have session files from multiple presentations given to the same 
participants. You can aggregate the data from all the presentations into a single file with all the 
responses from each participant.

Conversely, if you gave the same presentation to several groups of participants, you could 
aggregate the responses from all participants into a single session file.

Before You Begin

All the session files you wish to merge must be in a single location (usually your Sessions folder). If 
the session files are in different locations, move them all to your Sessions folder before you begin.

Step by Step Instructions To merge session files…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Session Management > Merge Session Files
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2 Select Session Management 
> Merge Session File.

The Merge Session Files window opens, displaying a list of 
session files in your Sessions folder. 

Merge Session Files Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 385.

You can also import a session using the Import Session button 
(shaped like a folder) above the list of files. This allows you to 
use a TurningPoint or TurningPoint Anywhere session file you 
have copied from elsewhere.

3 Select one of the session files 
to be merged in the list.

Merge Session Files Window: Select Files
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4 Select additional files to be 
merged in the list by holding 
down the Control key and 
clicking on the files.

Repeat this step until all the files you would like to merge are 
selected.

5 Optionally, check the box to 
include the PowerPoint 
presentations in the merged 
session file.

If you include the presentations in the merged session file, the 
slides from the presentations of each of the merged files are 
put together into a single presentation saved in the merged 
session file. This may greatly increase the size of the merged 
session file.

6 Select the Merge button 
below the list of files.

A dialog opens for you to specify a location and filename for 
the merged session file.

Merge Turning Session Dialog Box

7 Specify a name and location 
for the exported file.

Note You should use the file extension .tpz for 
session files.



TurningPoint User Guide 425

Merge Session Files

8 Select the Save button. The file is saved and the dialog closes.

You can access TurningPoint Reports by selecting Open 
TurningPoint Reports located next to the Finish button.

9 Select the Finish button to 
exit the Merge Session Files 
window.

Next Steps

You can now generate reports or extract other data from the merged session file, just as if it were an 
original session file.
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Extract Participant List

You can extract the Participant List from a TurningPoint or TurningPoint Anywhere session file. This 
is especially useful if you have a session file but have lost the Participant List file or if you set up the 
list on a different computer.

Step by Step Instructions To extract a Participant List…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Session Management > Extract Participant List
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2 Select Session Management 
> Extract Participant List.

The Extract Participant List window opens to display the session 
files in your Sessions folder. 

Extract Participant List Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 385.

You can also import a session using the Import Session button 
(shaped like a folder) above the list of files. This allows you to 
use a TurningPoint or TurningPoint Anywhere session file you 
have copied from elsewhere.

3 Choose a session file in one 
of the following ways:

• Select a session file from 
the list of files in your 
Sessions folder.

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog to 
locate and select the session file.
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4 Select the Extract Participant 
List button below the list of 
files.

A dialog opens for you to specify a location and filename for 
the Participant List file.

Extract Participant List Dialog Box

5 Specify a name and location 
for the exported file. 

6 Select the Save button. The file is saved and the dialog closes.

7 Select the Finish button to 
exit the Extract Participant 
List window.

Next Steps

You can now edit the Participant List or use it in a presentation. Find more information in Chapter 5: 
Track Participants and Teams.

Note You should use the file extension .tpl for 
Participant List files.
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Extract PowerPoint Presentation

Extract PowerPoint Presentation

You can extract the PowerPoint presentation from a session file. This is especially useful if you have 
a session file but have lost the corresponding PowerPoint presentation or if you created the 
presentation on a different computer.

Step by Step Instructions To extract a PowerPoint presentation…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Session Management > Extract PowerPoint
Presentations
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2 Select Session Management 
> Extract PowerPoint 
Presentations.

The Extract PowerPoint Presentations window opens, 
displaying a list of the session files in your Sessions folder.

Extract PowerPoint Presentations Window

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 385.

You can also import a session using the Import Session 
button above the list of files (shaped like a folder). This allows 
you to use a session file you have copied from elsewhere.

3 Choose a session file in one 
of the following ways:

• Select a session file from 
the list of files in your 
Sessions folder.

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog to 
locate and select the session file.
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Extract PowerPoint Presentation

4 Select the Extract 
PowerPoint Presentation 
button below the list of files.

A dialog opens for you to specify a location and filename for the 
PowerPoint presentation.

Extract PowerPoint Presentations Window: Export Dialog
Box

5 Specify a name and location 
for the exported file. 

6 Select the Save button. The file is saved and the dialog closes.

7 Select the Finish button to 
exit the Extract PowerPoint 
Presentations window.

Note You should use the file extension .ppt for 
PowerPoint presentations.
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Extract Session Data as XML

You can extract your TurningPoint or TurningPoint Anywhere session data into an XML file. The 
XML file is a text markup format that you can use to exchange and manipulate the data.

Step by Step Instructions To extract the session data XML file…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Session Management > Extract Session XML File
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Extract Session Data as XML

2 Select Session Management 
> Extract Session XML File.

The Extract Session XML File window opens, displaying a list of 
session files in your Sessions folder.

Extract Session XML File Window

You can also import a session using the Import Session button 
(shaped like a folder) above the list of files. This allows you to 
use a TurningPoint or TurningPoint Anywhere session file you 
have copied from elsewhere.

You can toggle which files are displayed in the list by selecting 
My Session Files or My Backup Session Files. Find more 
information about where your session files are stored in Save 
Results from a Session on page 385.

3 Choose a session file in one 
of the following ways:

• Select a session file from 
the list of files in your 
Sessions folder.

• Select a session file from 
your backup session files.

To display the backup session files in the list of files, 
select My Backup Session Files.

• Import a session file from 
another location.

Use the Import Session button to open a file dialog to 
locate and select the session file.
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4 Select the Extract Session 
XML File button below the list 
of files.

A dialog opens for you to specify a location and filename for 
the XML file.

Extract Session XML File Dialog Box

5 Specify a name and location 
for the exported file. 

6 Select the Save button. The file is saved and the dialog closes.

7 Select the Finish button to 
exit the Extract Session XML 
File.
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Email Session

Email Session

You can use Session Management to quickly and easily send one or more TurningPoint or 
TurningPoint Anywhere session files by email.

Before You Begin

To use this feature, you must have access to the internet on the computer that has TurningPoint 
installed.

Step by Step Instructions To email a session file using Outlook…

1 Select Tools in the 
TurningPoint toolbar.

The Tools menu opens.

Select Session Management > Send Session
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2 Select Session Management 
> Send Sessions.

The Send Sessions window opens, displaying a blank email 
form.

Send Sessions Window

3 Enter the email address you 
want to send the session 
file(s) to in the To box.

You may enter more than one email address. Separate 
multiple email addresses by semicolons.

4 Enter your email address in 
the From box.

5 Enter a subject for the email 
in the Subject line.

6 Optionally, add a message to 
the email in the space 
provided. 

If you choose not to add a message, the body of the email will 
be left blank.

7 Select File > Attach 
Session(s). 

This opens a window displaying a list of sessions files from 
your Sessions folder.



TurningPoint User Guide 437

Email Session

From this window, you can also navigate to any other location 
where TurningPoint or TurningPoint Anywhere session files are 
located. 

Send Sessions: Select a Session

8 Choose a session file. You may select multiple files by holding down the Control key 
and clicking on the file.

9 When you have selected all 
the files you would like to 
send, select the Open button 
to continue.

The session(s) has been attached to the email and is displayed 
in the lower portion of the Send Sessions window.

Send Sessions: Session Attached
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10 Optionally, change the SMTP 
Server.

a Select Tools > Change 
SMTP Server.

This displays and SMTP Server window.

Send Sessions: SMTP Server Window

b Enter the SMTP server. You may need to check with your IT Department for this 
information.

c Select OK. Your SMTP server has been changed.

11 Select the Send button. A dialog is displayed indicating that the email was 
successfully sent.
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Where Do I Go From Here?

Where Do I Go From Here?

This user manual has introduced you to the process of creating interactive presentations with 
TurningPoint. You have learned how to successfully build, deliver, and save the results of an 
interactive presentation in five easy steps.

You have customized the slides and include animation, feedback mechanisms, and excitement in 
your presentation. You have also created reports to view the results of your presentation session.

If you have further questions about the TurningPoint system, please feel free to contact Customer 
Support at Turning Technologies. See “Customer Support” on page 15..
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Glossary
Answer

An answer is one of a list of choices on a turningpoint slide. 
The answers are enumerated and participants’ responses 
correspond to the number of the answer.

Answer Now Indicator
An answer now indicator is an object on a turningpoint slide 
that gives the audience a visual indication that polling is open 
and they should respond to the question.

Answer Region
The answer region is the area on a turningpoint slide that 
contains the list of answers.

Answer Value
For purposes of scoring and competition, you can assign 
answer values to answers on a turningpoint slide. The possible 
values are “correct”, “incorrect”, a point value negative 10,000–
10,000 , or “no value.”

Chart
A chart is a visual representation of the results of polling on a 
turningpoint slide.

Comparative Link
A comparative link is used to link a slide to the results from 1–3 
additional slides to show all the results on a single chart.

Conditional Branching
Conditional branching determines the order of slides based on 
participant responses.

Correct Answer Indicator
A Correct Answer indicator is an object on a TurningPoint slide 
that gives a visual indication of the correct answer(s) after 
polling has closed.
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Countdown Indicator
A Countdown indicator is an object on a TurningPoint slide 
that gives the audience a visual indication that polling is 
about to close and that they should respond soon.

Countdown Sound
A Countdown Sound is .sound file used with a Countdown 
Indicator that gives the audience an audible indication that 
polling is about to close and that they should respond soon. 
The acceptable file extensions include: .aiff, .au, .mid, .midi., 
.mp3, .wav, and .wma.

Criteria
In a ranking, the criteria are the qualities on which the items 
to be ranked are compared. There are 1–3 criteria for the 
ranking, corresponding to the X, Y, and Z axes of the ranking 
chart.

Data Slicing
Data slicing is data analysis that entails cross-referencing the 
results from question to the results of a another question.

Device ID
The Device ID is a number that uniquely identifies a 
response device For hardware devices, it may be printed on 
the tag on the back of the device.

Dongle
A dongle is a piece of hardware that attaches to a port on 
your computer that confirms that the TurningPoint software is 
appropriately licensed.

Essay Slide
An Essay slide asks an open-ended question. The 
participants respond with text. Only vPad participants are 
able to respond to an Essay slide.

Fill in the Blank Slide
A Fill in the Blank slide asks a question or makes a statement 
with a missing word. Types of responses are determined by 
the type of device a participant is using. For instance, vPad 
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users can respond with a word or phrase, but ResponseCard 
users can respond only with numeric values. 

Infrared (IR)
Infrared light is invisible to the human eye and can be used to 
transmit information. Some of the response devices that work 
with TurningPoint use infrared technology. IR devices require a 
direct line of sight to the receiver. The IR response devices 
allow only one-way communications.

Interactive Results
Interactive results are the data from the audience’s responses 
that are displayed in real-time while polling is open. 

Moment to Moment Slide
A Moment to Moment slide is a special TurningPoint slide for 
getting feedback from the participants on a continual basis. The 
participants respond on a scale from -2 to +2 at regular 
intervals and the responses are displayed in a a chart.

Participant List
A Participant List is the file used in a session to track 
responses by individuals in the audience. Users can customize 
the type of data fields to include in the list but every list will 
include fields for the number and ID of the response devices.

Parser
A parser examines a file and breaks it into logical units to use 
and recombine. The TurningPoint Parser can take several 
kinds of files and create TurningPoint presentations from them.

Participants
The people in the audience of a presentation who use the 
response devices to respond to questions.

Participant List Wizard
The Participant List Wizard is a tool that guides you through the 
creation of a Participant List to be used with your presentation 
session.
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Participant Monitor
The Participant Monitor displays the status and information 
pertaining to the participants’ responses to all of the 
questions, including the total percentage of correct 
responses, how long each participants took to respond, and 
which answers they picked. 

Picture Slide
A picture slide is a TurningPoint slide in which the answer 
text is replaced with pictures.

Polling
Polling is the mechanism by which Turning Point accepts and 
tallies the responses provided by the audience using 
Response Devices.

Presentation Session
See Session.

Radio Frequency (RF)
Radio frequency devices use radio waves to transmit 
information. Some of the response devices that work with 
TurningPoint use radio frequency technology. RF devices do 
not require a direct line of sight. The RF response devices 
use two-way communications, so the response device can 
confirm that a response was received by the receiver.

Ranking
A ranking is an exercise in which items are compared on 1–3 
criteria and ranked. You can set up a ranking in TurningPoint 
using the Ranking Wizard.

Receiver
A receiver is a device that attaches to your computer to 
receive IR or RF signals from response devices.

Reset
To return the response tallies from the audience to zero.
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Report
Reports present and analyze the data from a session in a 
variety of useful ways. You can create reports from a session 
using the Report Wizard.

Response
A response is the signal received from a participant during 
polling. The response usually corresponds with one of a list of 
answers on the slide.

ResponseCard
A ResponseCard is a type of hardware response device that 
use infrared (IR) or radio frequency (RF) signals to 
communicate a participant’s response.

Response Counter
A Response Counter is an object on a TurningPoint slide that 
gives a visual indication of how many of the participants have 
responded to the question.

Response Grid
A Response Grid is available from the Showbar and is used to 
show which participants have responded to a question.

Response Table
A Response Table is an object on a TurningPoint slide that 
shows which participants have responded to a question.

Showbar
The Showbar is a toolbar that provides activation buttons for 
polling, monitoring, and viewing responses during the slide 
show.

Session
A session is a run-through of an interactive presentation where 
an audience has submitted responses to some or all of the 
questions.
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Session File
A session file is created to store the results and other data 
when you run a session. Session files are usually stored in 
My Documents\TurningPoint\Sessions and have extension 
.tpz.

Slide Show
A slide show is a presentation created in PowerPoint, which 
may or may not include TurningPoint slides.

Speed Scoring
Speed scoring scales the number of points a participant 
receives for responding to a question correctly by how 
quickly the participant responded.

Standard
A standard is any framework for evaluation of participants. 
You can assign standards to slides in a TurningPoint 
presentation to compare participants’ performance to a 
standard.

Statistic Indicator
A Statistic indicator is an object on a TurningPoint slide that 
shows the mean (average), median, standard deviation, or 
variance of responses after polling has closed.

Text Messaging
Text Messaging is a feature for sending messages to 
participants using vPad during a presentation.

TurningPoint slide
TurningPoint slides are slides in a PowerPoint presentation 
with the ability to dynamically display information based on 
the responses of an audience.

TurningPoint toolbar
A series of menus and buttons displayed below to the 
PowerPoint toolbars that contains the tools for using the 
TurningPoint software.
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vPad
A vPad is a software version of a response device that is set up 
for use in Settings. It can be installed on a networked desktop 
or laptop computer or Smart Device.

Web vPad
A Web vPad is an internet version of a response device that is 
set up for use in Settings. I

WebCT
WebCT is a software product that is popularly used by 
educational institutions to facilitate e- systems.

WebCT Wizard
The WebCT Wizard is a tool that guides you through the 
process of connecting to an institution’s WebCT server.

XML
XML is a markup language for text files, similar to HTML, that is 
used by TurningPoint for storing session data and as an import 
format for the TurningPoint parser.
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Frequently 
Asked Questions

This appendix offers you a quick reference to common questions that customers have about using the 
TurningPoint software. If you do not find an answer to your question here, visit the Turning 
Technologies Web site at http://www.turningtechnologies.com or call a Turning Representative toll-
free at 1-866-746-3015.

Why can’t I install TurningPoint?
You must be the local administrator to install TurningPoint for 
the first time. Login to the computer with the administrative 
username and password. 

If you have a dongle, it should not be plugged in during 
installation or activation. Remove it while installing and 
activating TurningPoint. Find information about installing 
TurningPoint in Chapter 1: About TurningPoint.

Where is my product serial number (activation 
code)?

The product serial number, also called the activation code, is 
located on a label inside the ResponseCard Kit. 
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What does the dongle look like?
The dongle has an end that plugs into a USB port as 
depicted in the image below. 

USB Dongle

Which response devices are compatible with 
TurningPoint?

Turning Technologies partners with Responsive Innovations 
to provide audience response devices that are specifically 
designed to support the functionality of TurningPoint. The 
ResponseCard IR, ResponseCard XL, ResponseCard RF, 
and ResponseCard XR from Responsive Innovations are 
products that are optimally suited for use with TurningPoint. 
Users also have the option of using TurningPoint’s vPad and 
Web vPad, two applications for using a virtual keypad. 

How do I set up the response devices?
All of the response device settings can be found in the 
Settings windows. From the TurningPoint toolbar, select the 
Tools > Settings, which looks like a pair of eyeglasses. Find 
information about Installing Response Devices in Chapter 4: 
TurningPoint Device and Settings Management.

Where should I put the receiver?
Because the IR device uses infrared technology and line-of-
sight communication, place it in a central location in the front 
of the room where it is high enough for everyone to see. The 
effective range of an IR device receiver is about 75 feet (25 
meters). You will need to install one receiver for every 80 
participants. The effective range of an RF device receiver is 
about 200 feet (60 meters). A single receiver is sufficient for 
up to 1000 keypads, and a direct line of sight between the 
receiver and the keypad is not necessary. When the receiver 
is connected, the participant has to simply press the number 
or letter on the keypad to send a response. Find information 
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about setting up the receiver in Chapter 4: TurningPoint 
Device and Settings Management.

Why is a keypad not working?
The correct keypads may not be matched with the receiver. 
Check your response device settings. Find information about 
the response device settings in Chapter 4: TurningPoint 
Device and Settings Management.

The keypad’s batteries may be too low or dead. Press a button 
on the keypad. The light on the keypad blinks or does not light 
up if the batteries need to be replaced. 

The keypad may not be correctly programmed. Refer to the 
Programming ResponseCards insert in the TurningPoint kit.

How do I track responses from participants?
Create a Participant List in TurningPoint and then use the 
Participant Monitor to view the responses from each 
participant. You can either create a Participant List using the 
Participant List Wizard or by importing an existing file. Find 
information about participant lists in Chapter 5: Track 
Participants and Teams. Find information about the 
Participant Monitor in Chapter 7: Run Presentations.

When running the presentation, why don’t the 
graphs appear unless I advance to the next slide 
and then go back?

The animations in the charts vary between Office 2003 and 
Office 2007. It is likely that Microsoft Office has been upgraded 
since TurningPoint was installed. Uninstall TurningPoint, and 
then reinstall it. 

How do I clear data from a session or a slide?
From the TurningPoint toolbar, select the Reset menu, and 
then select Session or Current Slide from menu. Find 
information about working with sessions in Chapter 9: 
Sessions.

How do I save a session?
From the TurningPoint toolbar, select the Save Session button, 
which looks like a disk. A window opens allowing you to select 
a file name and location. Save the file in the Sessions folder, 
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located at My Documents > TurningPoint > Sessions. Find 
information about saving a session in Chapter 9: Sessions.

How do I make a report with the data from my 
session?

TurningPoint enables you to create several types of reports. 
Find information about your options and instructions for 
creating reports in Chapter 8: Reports.
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